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About This Book

A WARNING! Text set off in this manner indicates that failure to follow directions could result in bodily
harm or loss of life.

/\ CAUTION: Text set off in this manner indicates that failure to follow directions could result in
damage to equipment or loss of information.

B NOTE: Text set off in this manner provides important supplemental information.
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1 Installing and Customizing the
Software

If your computer was not shipped with a Microsoft operating system, some portions of this
documentation do not apply. Additional information is available in online help after you install the
operating system.

Br NOTE: If the computer was shipped with Windows Vista or Windows 7 loaded, you will be prompted
to register the computer with HP Total Care before installing the operating system. You will see a
brief movie followed by an online registration form. Fill out the form, click the Begin button, and follow
the instructions on the screen.

/A CAUTION: Do not add optional hardware or third-party devices to the computer until the operating
system is successfully installed. Doing so may cause errors and prevent the operating system from
installing properly.

Br NOTE: Be sure there is a 10.2-cm (4-inch) clearance at the back of the unit and above the monitor
to permit the required airflow.

Installing the Windows Operating System

The first time you turn on the computer, the operating system is installed automatically. This process
takes about 5 to 10 minutes, depending on which operating system is being installed. Carefully read
and follow the instructions on the screen to complete the installation.

/A CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE COMPUTER
UNTIL THE PROCESS IS COMPLETE. Turning off the computer during the installation process may
damage the software that runs the computer or prevent its proper installation.

B NOTE: If the computer shipped with more than one operating system language on the hard drive,
the installation process could take up to 60 minutes.

If your computer was not shipped with a Microsoft operating system, some portions of this
documentation do not apply. Additional information is available in online help after you install the
operating system.

Downloading Microsoft Windows Updates

1.

To set up your Internet connection, click Start > Internet Explorer and follow the instructions on
the screen.

Once an Internet connection has been established, click the Start button.

Select the All Programs menu.

Installing the Windows Operating System
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4. Click on the Windows Update link.

In Windows Vista and Windows 7, the Windows Update screen appears. Click view available
updates and make sure all critical updates are selected. Click the Install button and follow the
instructions on the screen.

In Windows XP, you will be directed to the Microsoft Windows Update Web site. If you see
one or more pop-up windows that ask you to install a program from http://www.microsoft.com,
click Yes to install the program. Follow the instructions on the Microsoft Web site to scan for
updates and install critical updates and service packs.

It is recommended that you install all of the critical updates and service packs.

5. After the updates have been installed, Windows will prompt you to reboot the machine. Be sure
to save any files or documents that you may have open before rebooting. Then select Yes to
reboot the machine.

Installing or Upgrading Device Drivers (Windows
systems)

When installing optional hardware devices after the operating system installation is complete, you
must also install the drivers for each of the devices.

If prompted for the i386 directory, replace the path specification with C:\1386, or use the Browse
button in the dialog box to locate the i386 folder. This action points the operating system to the
appropriate drivers.

Obtain the latest support software, including support software for the operating system from
http://www.hp.com/support. Select your country and language, select Download drivers and
software (and firmware), enter the model number of the computer, and press Enter.

Customizing the Monitor Display (Windows systems)

If you wish, you can select or change the monitor model, refresh rates, screen resolution, color
settings, font sizes, and power management settings. To do so, right-click on the Windows Desktop,
then click Personalize in Windows Vista and Windows 7 or Properties in Windows XP to change
display settings. For more information, refer to the online documentation provided with the graphics
controller utility or the documentation that came with your monitor.

Launching Windows XP from Windows 7

Windows XP Mode for Windows 7 allows you to install and launch Windows XP applications from the
Windows 7 taskbar. This feature is available on some computer models only.

To set up from a pre-installed Windows 7 desktop, click Start > Windows Virtual PC > Virtual
Windows XP and follow the instructions on the screen.

Accessing Disk Image (ISO) Files

There are disk image files (ISO files) included on your PC that contain the installation software for
additional software. These CD image files are located in the folder C:\SWSetup\ISOs. Each .iso file
can be burned to CD media to create an installation CD. It is recommended that these disks be

Chapter 1 Installing and Customizing the Software
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created and the software installed in order to get the most from your PC. The software and image file
names are:

e Corel WinDVD SD and BD - installation software for WinDVD — used to play DVD movies

e HP Insight Diagnostics OR Vision Diagnostics — software to perform diagnostic activities on your
PC

Accessing Disk Image (ISO) Files 3
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2 Computer Setup (F10) Utility

Computer Setup (F10) Utilities

Use Computer Setup (F10) Utility to do the following:

Change factory default settings.
Set the system date and time.

Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

Modify the boot order of bootable devices such as hard drives, diskette drives, optical drives, or
USB flash media devices.

Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run
during a Full Boot. You can set the system to:

Q always Quick Boot (default);
Q periodically Full Boot (from every 1 to 30 days); or
Q always Full Boot.

Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test
(POST) messages. Post Messages Disabled suppresses most POST messages, such as
memory count, product name, and other non-error text messages. If a POST error occurs, the
error is displayed regardless of the mode selected. To manually switch to Post Messages
Enabled during POST, press any key (except F1 through F12).

Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

Enter the Asset Tag or property identification number assigned by the company to this computer.

Enable the power-on password prompt during system restarts (warm boots) as well as during
power-on.

Establish a setup password that controls access to the Computer Setup (F10) Utility and the
settings described in this section.

Secure integrated 1/O functionality, including the serial, USB, or parallel ports, audio, or
embedded NIC, so that they cannot be used until they are unsecured.

Enable or disable removable media boot ability.

Enable or disable legacy diskette write ability (when supported by hardware).
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e  Solve system configuration errors detected but not automatically fixed during the Power-On Self-
Test (POST).

e Replicate the system setup by saving system configuration information on diskette and restoring
it on one or more computers.

e Execute self-tests on a specified ATA hard drive (when supported by drive).

e Enable or disable DriveLock security (when supported by drive).

Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system.
To access the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer. If you are in Microsoft Windows, click Start > Shut Down >
Restart.

2. As soon as the computer is turned on, press F10 when the monitor light turns green to enter
Computer Setup. Press Enter to bypass the title screen, if necessary.

Bf NOTE: If you do not press F10 at the appropriate time, you must restart the computer and
again press F10 when the monitor light turns green to access the utility.

3. Select your language from the list and press Enter.

4. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security,
Power, and Advanced.

5. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and
down) keys to select the option you want, then press Enter. To return to the Computer Setup
Utilities menu, press Esc.

6. To apply and save changes, select File > Save Changes and Exit.
e If you have made changes that you do not want applied, select Ignore Changes and Exit.

e To reset to factory settings or previously saved default settings (some models), select
Apply Defaults and Exit. This option will restore the original factory system defaults.

/A CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup
(F10) changes because the CMOS could become corrupted. It is safe to turn off the computer only
after exiting the F10 Setup screen.

Table 2-1 Computer Setup (F10) Utility

Heading Table

File Computer Setup—File on page 6
Storage Computer Setup—Storage on page 7
Security Computer Setup—Security on page 9
Power Computer Setup—Power on page 14
Advanced Computer Setup—Advanced on page 15

Computer Setup (F10) Utilities
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Computer Setup—File

configuration.

Ef NOTE: Support for specific Computer Setup options may vary depending on the hardware

Table 2-2 Computer Setup—File

Option

Description

System Information

Lists:

e  Product name

e  SKU number (some models)

e  Processor type/speed/stepping

e  Cache size (L1/L2) (dual core processors have this listed twice)

e Installed memory size/speed, number of channels (single or dual) (if applicable)
e Integrated MAC address for embedded, enabled NIC (if applicable)
e  System BIOS (includes family name and version)

e  Chassis serial number

e  Asset tracking number

e  ME firmware version

e  Management mode

About

Displays copyright notice.

Set Time and Date

Allows you to set system time and date.

Flash System ROM

Allows you to update the system ROM with a BIOS image file located on a USB flash media
device or CD-ROM.

Replicated Setup

Save to Removable Media

Saves system configuration, including CMOS, to a formatted 1.44-MB diskette, a USB flash media
device, or a diskette-like device (a storage device set to emulate a diskette drive).

Restore from Removable Media

Restores system configuration from a diskette, a USB flash media device, or a diskette-like
device.

Default Setup

Save Current Settings as Default
Saves the current system configuration settings as the default.
Restore Factory Settings as Default

Restores the factory system configuration settings as the default.

Apply Defaults and
Exit

Applies the currently selected default settings and clears any established passwords.

Ignore Changes
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and
Exit

Saves changes to system configuration or default settings and exits Computer Setup.
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Computer Setup—Storage

Br NOTE: Support for specific Computer Setup options may vary depending on the hardware

configuration.

Table 2-3 Computer Setup—Storage

Option

Description

Device Configuration

Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options
may be presented:

CD-ROM: No emulation options available.

Hard Disk: Size, model, serial number, connector color, SMART, emulation type.
e None (prevents BIOS data accesses and disables it as a boot device)

e  Hard Disk (treated as a hard disk)

Translation Mode (ATA disks only)

Lets you select the translation mode to be used for the device. This enables the BIOS to access
disks partitioned and formatted on other systems and may be necessary for users of older
versions of UNIX (e.g., SCO UNIX version 3.2). Options are Automatic, Bit-Shift, LBA Assisted,
User, and Off.

CAUTION: Ordinarily, the translation mode selected automatically by the BIOS should not be
changed. If the selected translation mode is not compatible with the translation mode that was
active when the disk was partitioned and formatted, the data on the disk will be inaccessible.

Default Values (ATA disks only)
NOTE: This feature appears only when User translation mode is selected.

Allows you to specify the parameters (logical cylinders, heads, and sectors per track) used by the
BIOS to translate disk I/O requests (from the operating system or an application) into terms the
hard drive can accept. Logical cylinders may not exceed 1024. The number of heads may not
exceed 256. The number of sectors per track may not exceed 63. These fields are only visible
and changeable when the drive translation mode is set to User.

SATA Defaults
Translation Mode (ATA disks only)

Lets you select the translation mode to be used for the device. This enables the BIOS to access
disks partitioned and formatted on other systems and may be necessary for users of older
versions of UNIX (e.g., SCO UNIX version 3.2). Options are Automatic, Bit-Shift, LBA Assisted,
User, and Off.

CAUTION: Ordinarily, the translation mode selected automatically by the BIOS should not be
changed. If the selected translation mode is not compatible with the translation mode that was
active when the disk was partitioned and formatted, the data on the disk will be inaccessible.

Computer Setup (F10) Utilities
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Table 2-3 Computer Setup—Storage (continued)

Storage Options

Removable Media Boot

Enables/disables ability to boot the system from removable media.

eSATA Port

Allows you to set a SATA port as an eSATA port for use with an external drive.
Max eSATA Speed

Allows you to choose 1.5 Gbps or 3.0 Gpbs as the maximum eSATA speed. By default, the speed
is limited to 1.5 Gbps for maximum reliability.

CAUTION: Consult your eSATA drive and cable manufacturer before enabling 3.0 Gpbs speed.
Some drive and cable combinations may not run reliably at 3.0 Gpbs.

NOTE: eSATA is not available on USDT systems.
SATA Emulation

Allows you to choose how the SATA controller and devices are accessed by the operating
system. There are three supported options: IDE, RAID, and AHCI.

IDE - This is the most backwards-compatible setting of the three options. Operating systems
usually do not require additional driver support in IDE mode.

RAID - Allows DOS and boot access to RAID volumes. Use this mode with the RAID device driver
loaded in the operating system to take advantage of RAID features.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take
advantage of more advanced features of the SATA controller.

NOTE: The RAID/AHCI device driver must be installed prior to attempting to boot from a RAID/
AHCI volume. If you attempt to boot from a RAID/AHCI volume without the required device driver
installed, the system will crash (blue screen). RAID volumes may become corrupted if they are
booted to after disabling RAID. Refer to the Advanced Host Controller Interface (AHCI) and
Redundant Array of Independent Disks (RAID) on HP Compaq dc7900 Business PCs white paper
at http://www.hp.com for more information.

NOTE: RAID is not available on USDT systems.

DPS Self-Test

Allows you to execute self-tests on ATA hard drives capable of performing the Drive Protection
System (DPS) self-tests.

NOTE: This selection will only appear when at least one drive capable of performing the DPS
self-tests is attached to the system.

Boot Order

Allows you to:

e  Specify the order in which attached devices (such as a USB flash media device, hard drive,
optical drive, or network interface card) are checked for a bootable operating system image.
Each device on the list may be individually excluded from or included for consideration as a
bootable operating system source.

e  Specify the order of attached hard drives. The first hard drive in the order will have priority in
the boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating
system has started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press F9 when the monitor light turns green. After POST is completed, a list of
bootable devices is displayed. Use the arrow keys to select the preferred bootable device and
press Enter. The computer then boots from the selected non-default device for this one time.
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Computer Setup—Security

Br NOTE: Support for specific Computer Setup options may vary depending on the hardware

configuration.

Table 2-4 Computer Setup—Security

Option

Description

Setup Password

Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

See the Desktop Management Guide for more information.

Power-On Password

Allows you to set and enable a power-on password. The power-on password prompt appears
after a power cycle. If the user does not enter the correct power-on password, the unit will not
boot.

NOTE: This password does not appear on warm boots , such as Ctrl+Alt+Delete or Restart
from Windows, unless enabled in Password Options (see below).

See the Desktop Management Guide for more information.

Password Options

(This selection appears
only if a power-on
password or setup
password is set.)

Allows you to enable/disable:

e Lock Legacy Resources (appears if a setup password is set)

e  Network Server Mode (appears if a power-on password is set)

e  Password Prompt on Warm Boot (Ctrl+Alt+Delete) (appears if a power-on password is set)

e  Setup Browse Mode (appears if a setup password is set) (allows viewing, but not changing,
the F10 Setup Options without entering setup password)

e  Stringent Password (appears if a power-on password is set), which when enabled bypasses
the onboard password jumper to disable the power-on password.

e  Password prompt on F9, F11, & F12 (allows access to menus without entering setup
password)

See the Desktop Management Guide for more information.

Smart Cover (some
models)

Allows you to:

e  Lock/unlock the Cover Lock.

e  Set the Cover Removal Sensor to Disable/Notify User/Setup Password.

NOTE: Notify User alerts the user that the sensor has detected that the cover has been
removed. Setup Password requires that the setup password be entered to boot the computer if

the sensor detects that the cover has been removed.

This feature is supported on some models only. See the Desktop Management Guide for more
information.
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Table 2-4 Computer Setup—Security (continued)

Device Security Allows you to set Device Available/Device Hidden for:
e  Serial ports
° Parallel port
e  System audio
e  Network controllers (some models)
e Embedded security device (some models)
e SATAO
e  SATA1 (some models)
e  SATAZ2 (some models)
e  SATA3 (some models)

e eSATA (some models)

USB Security Allows you to set Device Available/Device Hidden for:

° Front USB Ports

° USB Port 3
° USB Port 4
° USB Port 5
° USB Port 6

° Rear USB Ports

° USB Port 7
° USB Port 8
° USB Port 9

° USB Port 10
° USB Port 11
° USB Port 12

e  Accessory USB Ports

° USB Port 1
° USB Port 2
Slot Security Allows you to disable any PCI or PCI Express slot

Network Service Boot Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCI
expansion card or embedded on the system board.)
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Table 2-4 Computer Setup—Security (continued)

System IDs

Allows you to set:

e  Asset tag (18-byte identifier), a property identification number assigned by the company to
the computer.

e  Ownership tag (80-byte identifier) displayed during POST.
e  Chassis serial number or Universal Unique Identifier (UUID) number. The UUID can only be
updated if the current chassis serial number is invalid. (These ID numbers are normally set in

the factory and are used to uniquely identify the system.)

e  Keyboard locale setting (for example, English or German) for System ID entry.

DriveLock Security

Allows you to assign or modify a master or user password for hard drives. When this feature is
enabled, the user is prompted to provide one of the DriveLock passwords during POST. If neither
is successfully entered, the hard drive will remain inaccessible until one of the passwords is
successfully provided during a subsequent cold-boot sequence.

NOTE: This selection will only appear when at least one drive that supports the DriveLock
feature is attached to the system.

See the Desktop Management Guide for more information.

Computer Setup (F10) Utilities
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Table 2-4 Computer Setup—Security (continued)

System Security Data Execution Prevention (some models) (enable/disable) - Helps prevent operating system
(some models: these security breaches.

options are hardware

dependent) PAVP (Models with Blu-ray drives) (disabled/min/max) - PAVP enables the Protected Audio Video

Path in the Chipset. This may allow viewing of some protected high definition content that would
otherwise be prohibited from playback. Selecting Max will assign 96 Megabytes of system
memory exclusively to PAVP.

Virtualization Technology (some models) (enable/disable) - Controls the virtualization features of
the processor. Changing this setting requires turning the computer off and then back on.

Virtualization Technology Directed 1/0O (some models) (enable/disable) - Controls virtualization
DMA remapping features of the chipset. Changing this setting requires turning the computer off
and then back on.

Trusted Execution Technology (some models) (enable/disable) - Controls the underlying
processor and chipset features needed to support a virtual appliance. Changing this setting
requires turning the computer off and then back on. To enable this feature you must enable the
following features:

e Embedded Security Device Support
e  Virtualization Technology
e  Virtualization Technology Directed I/O

Embedded Security Device Support (some models) (enable/disable) - Permits activation and
deactivation of the Embedded Security Device. Changing this setting requires turning the
computer off and then back on.

NOTE: To configure the Embedded Security Device, a Setup password must be set.

e Reset to Factory Settings (some models) (Do not reset/Reset) - Resetting to factory defaults
will erase all security keys. Changing this setting requires turning the computer off and then
back on.

CAUTION: The embedded security device is a critical component of many security
schemes. Erasing the security keys will prevent access to data protected by the Embedded
Security Device. Choosing Reset to Factory Settings may result in significant data loss.

OS management of Embedded Security Device (some models) (enable/disable) - This option
allows the user to limit operating system control of the Embedded Security Device. Changing this
setting requires turning the computer off and then back on. This option allows the user to limit OS
control of the Embedded Security Device.

e Reset of Embedded Security Device through OS (some models) (enable/disable) - This
option allows the user to limit the operating system ability to request a Reset to Factory
Settings of the Embedded Security Device. Changing this setting requires turning the
computer off and then back on.

NOTE: To enable this option, a Setup password must be set.
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Table 2-4 Computer Setup—Security (continued)

Master Boot Record
Security

Protects the master boot record from viruses or other corruption. Saves of copy of the current
master boot record.

Setup Security Level

Provides a method to allow end-users limited access to change specified setup options, without
having to know the Setup Password.

This feature allows the administrator the flexibility to protect changes to essential setup options,
while allowing the user to view system settings and configure nonessential options. The
administrator specifies access rights to individual setup options on a case-by-case basis via the
Setup Security Level menu. By default, all setup options are assigned Setup Password, indicating
the user must enter the correct Setup Password during POST to make changes to any of the
options. The administrator may set individual items to None, indicating the user can make
changes to the specified options when setup has been accessed with invalid passwords. The
choice, None, is replaced by Power-On Password if a Power-On Password is enabled.

NOTE: Setup Browse Mode must be set to Enable in order for the user to enter Setup without
knowing the setup password.

Computer Setup (F10) Utilities
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Computer Setup—Power

Ef NOTE: Support for specific Computer Setup options may vary depending on the hardware

configuration.

Table 2-5 Computer Setup—Power

Option Description

OS Power e  Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce

Management processor voltage and frequency when the current software load does not require the full
capabilities of the processor.

e |dle Power Savings—Extended/Normal. Allows certain operating systems to decrease the
processors power consumption when the processor is idle.

e  ACPI S3 Hard Disk Reset—Enabling this causes the BIOS to ensure hard disks are ready to
accept commands after resuming from S3 before returning control to the operating system.

e ACPI S3 PS2 Mouse Wakeup—Enables or disables waking from S3 due to any PS2 mouse
activity or a button click only.

e  USB Wake on Device Insertion (some models)—Allows system to wake from Standby on
USB device insertion.

e Unique Sleep State Blink Rates—Enable/Disable. This feature is designed to provide a
visual indication of what sleep state the system is in. Each sleep state has a unique blink
pattern.

° SO = Solid green LED.
° S3 = 3 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds (green LED) —
repeated cycles of 3 blinks and a pause.
° S4 = 4 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds (green LED) —
repeated cycles of 4 blinks and a pause.
° S5 = LED is off.
NOTE: If this feature is disabled, S4 and S5 both have the LED off. S1 (no longer
supported) and S3 use 1 blink per second.
Hardware Power SATA Power Management enables or disables SATA bus and/or device power management.
Management

S5 Maximum Power Savings—Turns off power to all nonessential hardware when system is off to

meet EUP Lot 6 requirement of less than 1 Watt power usage.

Thermal Fan idle mode—This bar graph controls the minimum permitted fan speed.

NOTE: This setting only changes the minimum fan speed. The fans are still automatically
controlled.
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Computer Setup—Advanced

Br NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 2-6 Computer Setup—Advanced (for advanced users)

Option Heading

Power-On Options Allows you to set:
e POST mode (QuickBoot, Clear Memory, FullBoot, or FullBoot Every x Days).
° QuickBoot = Do not clear memory or perform a memory test.

° FullBoot = Memory test (count) on cold boot. Clears memory on all boots.
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Table 2-6 Computer Setup—Advanced (for advanced users) (continued)

° Clear Memory = No memory count on cold boot. Clears memory on all boots.

° FullBoot Every x Days = Memory count on 1st cold boot on or after the xth day. No
more memory counts until 1st cold boot on or after x days. Clears memory on all boots.

e  POST messages (enable/disable).

e  F9 prompt (hidden/displayed). Enabling this feature will display the text F9 = Boot Menu
during POST. Disabling this feature prevents the text from being displayed. However,
pressing F9 will still access the Shortcut Boot [Order] Menu screen. See Storage > Boot
Order for more information.

e  F10 prompt (hidden/displayed). Enabling this feature will display the text F10 = Setup during
POST. Disabling this feature prevents the text from being displayed. However, pressing F10
will still access the Setup screen.

e F11 prompt (hidden/displayed). Setting this feature to displayed will display the text F11 =
Recovery during POST. Hiding the feature prevents the text from being displayed. However,
pressing F11 will still attempt to boot to the HP Backup and Recovery partition. See Factory
Recovery Boot Support for more information.

e  F12 prompt (hidden/displayed). Enabling this feature will display the text F12 = Network
during POST. Disabling this feature prevents the text from being displayed. However,
pressing F12 will still force the system to attempt booting from the network.

e  Factory Recovery Boot Support (enable/disable). Enabling this feature will cause an
additional prompt, F11 = Recovery, to be displayed during POST on systems with
HP Backup and Recovery software installed and configured with a recovery partition on the
boot hard drive. Pressing F11 causes the system to boot to the recovery partition and launch
HP Backup and Recovery. The F11 = Recovery prompt can be hidden with the F11 prompt
(hidden/displayed) option (see above).

e  Option ROM Prompt (enable/disable). Enabling this feature will cause the system to display
a message before loading option ROMs. (This feature is supported on some models only.)

e Remote Wakeup Boot Source (remote server/local hard drive).
e  After Power Loss (off/on/previous state): Setting this option to:
° Off—causes the computer to remain powered off when power is restored.
° On—causes the computer to power on automatically as soon as power is restored.

° Previous state—causes the computer to power on automatically as soon as power is
restored, if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be
able to use the suspend/sleep feature or the Remote Management features.

e POST Delay (None, 5, 10 15, or 20 seconds). Enabling this feature will add a user-specified
delay to the POST process. This delay is sometimes needed for hard disks on some PCI
cards that spin up very slowly, so slowly that they are not ready to boot by the time POST is
finished. The POST delay also gives you more time to select F10 to enter Computer (F10)
Setup.

e  Bypass F1 Prompt on Configuration Changes (Enable/Disable). Allows you to set the
computer not to confirm when changes were made.

Execute Memory Test  Restarts the computer and executes the POST memory test/logging.
(some models)

BIOS Power-On Allows you to set the computer to turn on automatically at a time you specify.

Onboard Devices Allows you to set resources for or disable onboard system devices (diskette controller, serial port,
or parallel port).
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Table 2-6 Computer Setup—Advanced (for advanced users) (continued)

PCI Devices e Lists currently installed PCI devices and their IRQ settings.
e Allows you to reconfigure IRQ settings for these devices or to disable them entirely. These
settings have no effect under an ACPI-based operating system.
PCI VGA Displayed only if there are multiple PCI video adapters in the system. Allows you to specify which

Configuration

VGA controller will be the “boot” or primary VGA controller.

NOTE: In order to see this entry, you must enable Integrated Video (Advanced > Device
Options) and Save Changes and Exit.

Bus Options

On some models, allows you to enable or disable:
° PCI SERR# Generation.

e PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration
space; only needed when more than one graphics controller is installed.

Device Options

Allows you to set:

e  Printer mode (Bi-Directional, EPP + ECP, Output Only).
e  Num Lock State at Power-On (off/on).

e S5 Wake on LAN (enable/disable).

° To disable Wake on LAN during the off state (S5), use the arrow (left and right) keys to
select the Advanced > Device Options menu and set the S5 Wake on LAN feature to
Disable. This obtains the lowest power consumption available on the computer during
S5. It does not affect the ability of the computer to Wake on LAN from suspend or
hibernation, but will prevent it from waking from S5 via the network. It does not affect
operation of the network connection while the computer is on.

° If a network connection is not required, completely disable the network controller (NIC)
by using the arrow (left and right) keys to select the Security > Device Security menu.
Set the Network Controller option to Device Hidden. This prevents the network
controller from being used by the operating system and reduces the power used by the
computer in S5.

e  Multi-Processor (enable/disable). This option may be used to disable multi-processor support
under the OS.

e Internal Speaker (some models) (does not affect external speakers).

e NIC PXE Option ROM Download (enable/disable). The BIOS contains an embedded NIC
option ROM to allow the unit to boot through the network to a PXE server. This is typically
used to download a corporate image to a hard drive. The NIC option ROM takes up memory
space below 1MB commonly referred to as DOS Compatibility Hole (DCH) space. This
space is limited. This F10 option will allow users to disable the downloading of this
embedded NIC option ROM thus giving more DCH space for additional PCI cards which may
need option ROM space. The default will be to have the NIC option-ROM-enabled.

Computer Setup (F10) Utilities
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Table 2-6 Computer Setup—Advanced (for advanced users) (continued)

Management Devices = The Management Devices menu will only be displayed in the Advanced menu when the BIOS
detects multiple management options.

This option is for installed NIC cards that support ASF or DASH. Use the Management Devices
menu to select if the BIOS management operations will be through the embedded solution or one
of the installed NIC cards.

Management Allows you to set:
Operations
e  MEBXx Setup Prompt (enable/disable). Enabling this feature displays the CTRL+P prompt
during POST. Disabling this feature prevents the prompt from being displayed. However,
pressing Ctrl+P still accesses the utility used to configure manageability settings.

The CTRL+P function activates the MEBx Setup menu. If the Setup Password is configured,
the user will be prompted to correctly enter it before being allowed to enter the MEBx Setup.
It the password is entered incorrectly three times, the MEBx Setup will not be activated.

e Intel Remote PC Assist Prompt (Hidden/Displayed). Displaying this feature displays the
CTRL+ALT+F1 prompt during POST. Hiding this feature prevents the prompt from being
displayed. However, pressing Ctrl+Alt+F 1 still accesses the utility used to attempt to connect
to remote help server or services.

° Intel PC Assist Timeout (5, 10, 15, 20, 30, 40, 50, 60, 120, 180, 240 seconds). Allows the
user/administrator is set a time limit for Remote Help to establish contact with a remote
server when initiated.

e  SOL Terminal Emulation Mode. Selects between VT100 and ANSI SOL terminal emulation.
SOL terminal emulation mode is only activated during remote AMT redirection operations.
The emulation options allow administrators to select which mode works best with their
console.

e  SOL Local Keyboard (enable/disable). Disable or enable client keyboard during SOL
sessions. Some remote remediation may involve having the local client boot a remote image
provided by an administrator. This option determines if the BIOS will keep the local keyboard
enabled or disabled for possible local client interaction. If the local keyboard is disabled, all
keyboard input is only accepted from the remote source.

e  Unprovision AMT on next boot. Allows reset of AMT settings.

Recovering the Configuration Settings

This method of recovery requires that you first perform the Save to Removable Media command
with the Computer Setup (F10) Utility before Restore is needed. (See Save to Removable Media
on page 6 in the Computer Setup—File table.)

& NOTE: Itis recommended that you save any modified computer configuration settings to a diskette,
a USB flash media device, or a diskette-like device (a storage device set to emulate a diskette drive)
and save the diskette or device for possible future use.

To restore the configuration, insert the diskette, USB flash media device, or other storage media
emulating a diskette with the saved configuration and perform the Restore from Removable Media
command with the Computer Setup (F10) Utility. (See Restore from Removable Media on page 6 in
the Computer Setup—File table.)
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3 Serial ATA (SATA) Drive Guidelines

and Features

B NOTE: HP only supports the use of SATA hard drives on these models of computer. No Parallel

ATA (PATA) drives are supported.

SATA Hard Drives

Serial ATA Hard Drive Characteristics

Number of pins/conductors in data cable

717

Number of pins in power cable

15

Maximum data cable length

39.37 in (100 cm)

Data interface voltage differential 400-700 mV
Drive voltages 33V,5V,12V
Jumpers for configuring drive N/A

Data transfer rate 3.0 Gb/s

SATA Hard Drive Cables

SATA Data Cable

Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the SATA

1.5 Gb/s drives.

Current HP desktop products ship with SATA 3.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and

never bend it tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive.

SATA Hard Drives
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SMART ATA Drives

The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal
Computers have built-in drive failure prediction that warns the user or network administrator of an
impending failure or crash of the hard drive. The SMART drive tracks fault prediction and failure
indication parameters such as reallocated sector count, spin retry count, and calibration retry count. If
the drive determines that a failure is imminent, it generates a fault alert.

Hard Drive Capacities

The combination of the file system and the operating system used in the computer determines the
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that may
be properly accessed by the operating system. A single hard drive may therefore be subdivided into a
number of unique drive partitions in order to make use of all of its space.

Because of the differences in the way that drive sizes are calculated, the size reported by the
operating system may differ from that marked on the hard drive or listed in the computer specification.
Drive size calculations by drive manufacturers are bytes to the base 10 while calculations by
Microsoft are bytes to the base 2.

Drive/Partition Capacity Limits

Maximum Size

File System Controller Type Operating System Partition Drive
FAT 32 ATA Windows XP/Windows Vista/Windows 7 32GB 27TB
NTFS ATA Windows XP/Windows Vista/Windows 7 27TB 27TB
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4 Identifying the Chassis, Routine Care,
and Disassembly Preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

/A CAUTION: When the computer is plugged into an AC power source, voltage is always applied to
the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.

Chassis Designations

Front bezel appearance varies by model.

Convertible Minitower (CMT)

8000 Models
Figure 4-1 Convertible Minitower — 8000 Models
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8080 Models
Figure 4-2 Convertible Minitower — 8080 Models
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Small Form Factor (SFF)

Figure 4-3 Small Form Factor chassis
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Ultra-Slim Desktop (USDT)
Figure 4-4 Ultra-Slim Desktop chassis
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Electrostatic Discharge Information

A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work
perfectly throughout a normal cycle. The device may function normally for a while, but it has been
degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the
discharge contains enough power to alter device parameters or melt silicon junctions.

Generating Static
The following table shows that:
e Different activities generate different amounts of static electricity.

e  Static electricity increases as humidity decreases.

Relative Humidity

Event 55% 40% 10%
Walking across carpet 7,500 V 15,000 V 35,000 V
Walking across vinyl floor 3,000V 5,000V 12,000 V
Motions of bench worker 400 V 800V 6,000 V
Removing DIPs from plastic tube 400 V 700 V 2,000V
Removing DIPs from vinyl tray 2,000V 4,000V 11,500 V
Removing DIPs from Styrofoam 3,500 V 5,000 V 14,500 V
Removing bubble pack from PCB 7,000V 20,000 V 26,500 V
Packing PCBs in foam-lined box 5,000 V 11,000 V 21,000 V

These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

B NOTE: 700 volts can degrade a product.

Preventing Electrostatic Damage to Equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the
degree of sensitivity. The following packaging and grounding precautions are necessary to prevent
damage to electric components and accessories.

e To avoid hand contact, transport products in static-safe containers such as tubes, bags, or
boxes.

e Protect all electrostatic parts and assemblies with conductive or approved containers or
packaging.

e  Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

e Place items on a grounded surface before removing them from their container.

24 Chapter 4 Identifying the Chassis, Routine Care, and Disassembly Preparation



Always be properly grounded when touching a sensitive component or assembly.
Avoid contact with pins, leads, or circuitry.

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or
conductive foam.

Personal Grounding Methods and Equipment

Use the following equipment to prevent static electricity damage to equipment:

Wrist straps are flexible straps with a maximum of one-megohm + 10% resistance in the ground
cords. To provide proper ground, a strap must be worn snug against bare skin. The ground cord
must be connected and fit snugly into the banana plug connector on the grounding mat or
workstation.

Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible
with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on
both feet with a maximum of one-megohm + 10% resistance between the operator and ground.

Static Shielding Protection Levels

Method Voltage
Antistatic plastic 1,500
Carbon-loaded plastic 7,500
Metallized laminate 15,000

Grounding the Work Area

To prevent static damage at the work area, use the following precautions:

Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

Use static-dissipative mats, foot straps, or air ionizers to give added protection.

Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at static-free work areas.

Turn off power and input signals before inserting and removing connectors or test equipment.

Use fixtures made of static-safe materials when fixtures must directly contact dissipative
surfaces.

Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended Materials and Equipment

Materials and equipment that are recommended for use in preventing static electricity include:

Antistatic tape

Antistatic smocks, aprons, or sleeve protectors

Electrostatic Discharge Information
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Conductive bins and other assembly or soldering aids

Conductive foam

Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance
Static-dissipative table or floor mats with hard tie to ground

Field service kits

Static awareness labels

Wrist straps and footwear straps providing one-megohm +/- 10% resistance
Material handling packages

Conductive plastic bags

Conductive plastic tubes

Conductive tote boxes

Opaque shielding bags

Transparent metallized shielding bags

Transparent shielding tubes

Operating Guidelines

To prevent overheating and to help prolong the life of the computer:
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Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and
cold.

Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all
vented sides of the computer and above the monitor to permit the required airflow.

Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign
matter can block the vents and limit the airflow. Be sure to unplug the computer before cleaning
the air vents.

Never operate the computer with the cover or side panel removed.

Do not stack computers on top of each other or place computers so near each other that they
are subject to each other’s re-circulated or preheated air.

If the computer is to be operated within a separate enclosure, intake and exhaust ventilation
must be provided on the enclosure, and the same operating guidelines listed above will still

apply.

Keep liquids away from the computer and keyboard.
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e Never cover the ventilation slots on the monitor with any type of material.

e Install or enable power management functions of the operating system or other software,
including sleep states.

Routine Care

General Cleaning Safety Precautions
1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and
then use the cloth on the component.

Always unplug the computer when cleaning with liquids or damp cloths.

3
4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.
5. Disconnect the keyboard before cleaning it.

6

Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case

Follow all safety precautions in General Cleaning Safety Precautions on page 27 before cleaning the
computer.

To clean the computer case, follow the procedures described below:
e Toremove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

e  For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

e  For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave a residue.

e  After cleaning, always wipe the unit with a clean, lint-free cloth.

e  Occasionally clean the air vents on the computer. Lint and other foreign matter can block the
vents and limit the airflow.

Cleaning the Keyboard

Follow all safety precautions in General Cleaning Safety Precautions on page 27 before cleaning the
keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the
Computer Case on page 27.

When cleaning debris from under the keys, review all rules in General Cleaning Safety Precautions
on page 27 before following these procedures:
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/A CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys.

e Visible debris underneath or between the keys may be removed by vacuuming or shaking.

e Canned, pressurized air may be used to clean debris from under the keys. Caution should be
used as too much air pressure can dislodge lubricants applied under the wide keys.

e If you remove a key, use a specially designed key puller to prevent damage to the keys. This
tool is available through many electronic supply outlets.

/A CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these
keys are improperly removed or installed, the keyboard may not function properly.

e Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed
out. Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to
remove any fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the Monitor

e  Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for
cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into
the housing and damage a component. Never use solvents or flammable liquids on the monitor.

e To clean the monitor body follow the procedures in Cleaning the Computer Case on page 27.

Cleaning the Mouse
Before cleaning the mouse, ensure that the power to the computer is turned off.

e Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out
any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

e To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 27.

Service Considerations

Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Power Supply Fan

The power supply fan is a variable-speed fan based on the temperature in the power supply.

/A CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is
off when the computer is in “Standby,” “Suspend,” or “Off’ modes.

You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.
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Tools and Software Requirements

To service the computer, you need the following:

Screws

Torx T-15 screwdriver (HP screwdriver with bits, PN 161946-001)

Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)
Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)
Phillips #2 screwdriver

Diagnostics software

HP tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or HP tamper-
resistant bits (Smart Cover FailSafe Key, PN 166527-002)

The screws used in the computer are not interchangeable. They may have standard or metric threads
and may be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with
the part that was removed, then returned to their proper locations.

/\ CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard
drives only.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the
work area to prevent damage.

Cables and Connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with
care to avoid damage. Apply only the tension required to seat or unseat the cables during insertion or
removal from the connector. Handle cables by the connector whenever possible. In all cases, avoid
bending or twisting the cables, and ensure that the cables are routed in such a way that they cannot
be caught or snagged by parts being removed or replaced.

/A CAUTION: When servicing this computer, ensure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the computer.

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
applies to failed drives as well as replacement spares.

If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

Avoid dropping drives from any height onto any surface.

If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive
while the computer is on or in standby mode.
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e Before handling a drive, ensure that you are discharged of static electricity. While handling a
drive, avoid touching the connector. For more information about preventing electrostatic
damage, refer to Electrostatic Discharge Information on page 24

e Do not use excessive force when inserting a drive.

e Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic
fields such as monitors or speakers.

Lithium Coin Cell Battery

The battery that comes with the computer provides power to the real-time clock and has a minimum
lifetime of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this
guide for instructions on the replacement procedures.

/A WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose
in water or fire, or expose it to temperatures higher than 140°F (60°C). Do not attempt to recharge the
battery.

L)

NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, their authorized partners, or their agents.
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5 Removal and Replacement Procedures
Convertible Minitower (CMT) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to
verify that all components operate properly.

B NOTE: Not all features listed in this guide are available on all computers.

Preparation for Disassembly

See Ildentifying the Chassis, Routine Care, and Disassembly Preparation on page 21 for initial safety
procedures.

1.  Remove/disengage any security devices that prohibit opening the computer (External Security
Devices on page 77).

Close any open software applications.
Exit the operating system.

Remove any diskette, compact disc, or media card from the computer.

o » 0 N

Turn off the computer and any peripheral devices that are connected to it.

/A CAUTION: Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the
system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be
disconnected before servicing a unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.
7. Disconnect all peripheral device cables from the computer.

8. As applicable, lay the computer down on its side to achieve a safe working position.

B NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

/A CAUTION: The screws used in the computer are of different thread sizes and lengths; using the
wrong screw in an application may damage the unit.
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Unlocking the Smart Cover Lock

B NOTE: The Smart Cover Lock is an optional feature included on some models only.

The Smart Cover Lock is a software-controllable cover lock, controlled by the setup password. This
lock prevents unauthorized access to the internal components. The computer ships with the

Smart Cover Lock in the unlocked position. For more information about locking the Smart Cover Lock,
refer to the Desktop Management Guide.

Smart Cover FailSafe Key

If you enable the Smart Cover Lock and cannot enter your password to disable the lock, you will need
a Smart Cover FailSafe Key to open the computer cover. You will need the key to access the internal
computer components in any of the following circumstances:

e Power outage
e  Startup failure
e PC component (for example, processor or power supply) failure

e  Forgotten password

B NOTE: The Smart Cover FailSafe Key is a specialized tool available from HP. Be prepared; order
this key before you need it.

To obtain a FailSafe Key:

e Contact an authorized HP reseller or service provider. Order PN 166527-001 for the wrench-
style key or PN 166527-002 for the screwdriver bit key.

e  Refer to the HP Web site (http://www.hp.com) for ordering information.

e  Call the appropriate number listed in the warranty or in the Support Telephone Numbers guide.

Using the Smart Cover FailSafe Key to Remove the Smart Cover Lock

To open the access panel with the Smart Cover Lock engaged:

1. Remove/disengage any security devices that prohibit opening the computer.

2. Remove all removable media, such as compact discs or USB flash drives, from the computer.
3. Turn off the computer properly through the operating system, then turn off any external devices.
4.

Disconnect the power cord from the power outlet and disconnect any external devices.

/A CAUTION: Regardless of the power-on state, voltage is always present on the system board
as long as the system is plugged into an active AC outlet. You must disconnect the power cord
to avoid damage to the internal components of the computer.
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5. Use the Smart Cover FailSafe Key to remove the two tamper-proof screws that secure the Smart
Cover Lock to the chassis.

Figure 5-1 Removing the Smart Cover Lock Screws

You can now remove the access panel. See Computer Access Panel on page 150.

To reattach the Smart Cover Lock, secure the lock in place with the tamper-proof screws.
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Computer Access Panel

1. Prepare the computer for disassembly (Preparation for Disassembly on page 31)

2. Lay the computer down on its large base for greater stability.
3. Lift up on the access panel handle (1) then lift the access panel off the computer (2).

Figure 5-2 Removing the Computer Access Panel

To install the access panel, reverse the removal procedure.
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Front Bezel

Front bezel appearance varies by model.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 31).

2. Remove the computer access panel (Computer Access Panel on page 34).

3. Lift up the three tabs on the side of the bezel (1), then rotate the bezel off the chassis (2).

Figure 5-3 Removing the Front Bezel

To install the front bezel, reverse the removal procedure.
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Bezel Blanks

1. Prepare the computer for disassembly (Preparation for Disassembly on page 31).

Remove the computer access panel (Computer Access Panel on page 34).

Remove the front bezel (Front Bezel on page 35).

P owoN

Gently pull the subpanel, with the bezel blanks secured in it, away from the front bezel, then
remove the desired bezel blank.

/A CAUTION: Hold the subpanel straight when you pull it away from the front bezel. Pulling the
subpanel away at an angle could damage the pins that align it within the front bezel.

Figure 5-4 Removing Bezel Blanks from the Subpanel (Desktop Shown)

B NOTE: When replacing the subpanel, ensure that the aligning pins and any remaining bezel blanks
are in their proper orientation. The logo on the subpanel should be located at the bottom of the
subpanel when properly oriented.
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Cable Management

Always follow good cable management practices when working inside the computer.

Keep cables away from major heat sources like the heat sink.

Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

Keep cables clear of sliding or moveable parts to prevent them from being cut or crimped when
the parts are moved.

When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the
wires.

Some flat ribbon cables come prefolded. Never change the folds on these cables.
Do not bend any cable sharply. A sharp bend can break the internal wires.

Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

Never crease a SATA data cable.

Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the connectors on the system board, always
follow these steps:

1.
2,

Squeeze on the top of the retaining latch attached to the cable end of the connector (1).

Grasp the cable end of the connector and pull it straight up (2).

/A CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could

damage the cable and result in a failed power supply.

Figure 5-5 6-pin power connector

Cable Management

37



Cable Connections
System board connectors are color-coded to make it easier to find the proper connection.

System Board Connections

System Board Connector Connector Color Description

PWR White Power supply, 6-pin
PWRCPU White Power supply, 4-pin
CHFAN2 Brown Rear chassis fan
SATAPWRO Black ODD power connector
SATAPWRA1 Black HDD power connector
PB/LED Black Front power button/LED
FRNT USB Yellow Front I/O USB cable
FRNT USB2 Green Front 1/O USB cable
FRONT AUD Blue Front audio

SPRK White Internal speaker

COMB Black Serial port

HLOCK Black Hood lock solenoid
HSENSE White Hood sensor

MEDIA Black Media card reader

PAR Black Flying parallel port header

38 Chapter 5 Removal and Replacement Procedures Convertible Minitower (CMT) Chassis



Installing Additional Memory

The computer comes with double data rate 2 synchronous dynamic random access memory (DDR2-
SDRAM) dual inline memory modules (DIMMs).

DIMMs

The memory sockets on the system board can be populated with up to four industry-standard DIMMs.
These memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum
memory support, you can populate the system board with up to 16-GB of memory configured in a
high-performing dual channel mode.

DDR3-SDRAM DIMMs
For proper system operation, the DDR3-SDRAM DIMMs must be:
e industry-standard 240-pin

e unbuffered non-ECC PC3-8500 DDR3-1066 MHz-compliant or PC3-10600 DDR3-1333 MHz-
compliant

° 1.5 volt DDR3-SDRAM DIMMs
The DDR3-SDRAM DIMMs must also:

e support CAS latency 7 DDR3 1066 MHz (7-7-7 timing) and CAS latency 9 DDR3 1333 MHz
(9-9-9 timing)

e  contain the mandatory JEDEC SPD information

In addition, the computer supports:

e  512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies
e single-sided and double-sided DIMMs

° DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not
supported

Br NOTE: The system will not operate properly if you install unsupported DIMMs.
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Populating DIMM Sockets

There are four DIMM sockets on the system board, with two sockets per channel. The sockets are
labeled XMM1, XMM2, XMM3, and XMM4. Sockets XMM1 and XMM2 operate in memory channel A.
Sockets XMM3 and XMM4 operate in memory channel B.

Figure 5-6 DIMM Socket Locations

Table 5-1 DIMM Socket Locations

Item Description Socket Color
1 XMM1 socket, Channel A (populate first) Black
2 XMM2 socket, Channel A (populate third) White
3 XMM3 socket, Channel B (populate second) White
4 XMM4 socket, Channel B (populate fourth) White

NOTE: A DIMM must occupy the black XMM1 socket. Otherwise, the system will
display a POST error message indicating that a memory module must be installed in
the wrong socket.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

e  The system will operate in single channel mode if the DIMM sockets are populated in one
channel only.

e The system will operate in a higher-performing dual channel mode if the total memory capacity
of the DIMMs in Channel A is equal to the total memory capacity of the DIMMs in Channel B.
The technology and device width can vary between the channels. For example, if Channel A is
populated with two 1-GB DIMMs and Channel B is populated with one 2-GB DIMM, the system
will operate in dual channel mode.

e  The system will operate in flex mode if the total memory capacity of the DIMMs in Channel A is
not equal to the total memory capacity of the DIMMs in Channel B. In flex mode, the channel
populated with the least amount of memory describes the total amount of memory assigned to
dual channel and the remainder is assigned to single channel. For optimal speed, the channels
should be balanced so that the largest amount of memory is spread between the two channels.
If one channel will have more memory than the other, the larger amount should be assigned to
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Channel A. For example, if you are populating the sockets with one 2-GB DIMM, and three 1-GB
DIMMs, Channel A should be populated with the 2-GB DIMM and one 1-GB DIMM, and Channel
B should be populated with the other two 1-GB DIMMs. With this configuration, 4-GB will run as
dual channel and 1-GB will run as single channel.

e In any mode, the maximum operational speed is determined by the slowest DIMM in the system.

Installing DIMMs

/A CAUTION: You must disconnect the power cord before adding or removing memory modules.
Regardless of the power-on state, voltage is always supplied to the memory modules as long as the
computer is plugged into an active AC outlet. Adding or removing memory modules while voltage is
present may cause irreparable damage to the memory modules or system board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 31).

2. Remove the computer access panel (Computer Access Panel on page 34).

3. Locate the memory module sockets on the system board.

A WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system
components to cool before touching.
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4. Open both latches of the memory module socket (1), and insert the memory module into the
socket (2).

Figure 5-7 Installing a DIMM

o

-
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B NOTE: A memory module can be installed in only one way. Match the notch on the module
with the tab on the memory socket.

A DIMM must occupy the black XMM1 socket.
Populate the DIMM sockets in the following order: XMM1, XMM3, XMM2, then XMM4.

For maximum performance, populate the sockets so that the memory capacity is spread as
equally as possible between Channel A and Channel B.

g

Push the module down into the socket, ensuring that the module is fully inserted and properly
seated. Make sure the latches are in the closed position (3).

Repeat steps 4 and 5 to install any additional modules.

6

7. Replace the computer access panel.

8. Reconnect the power cord and turn on the computer.
9

Lock any security devices that were disengaged when the computer access panel was removed.

The computer should automatically recognize the additional memory the next time you turn on the
computer.
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Expansion Cards

The computer has three standard full-height PCI expansion slots, one PCl Express x1 expansion slot,
one PCI Express x16 expansion slot, and one PCl Express x16 expansion slot that is downshifted to
a x4 slot.

Figure 5-8 Expansion Slot Locations

Table 5-2 Expansion Slot Locations

Item Description

1 PCI expansion slot

2 PCI expansion slot

3 PCI expansion slot

4 PCI Express x16 expansion slot that is

downshifted to a x4 slot

5 PCI Express x16 expansion slot

6 PCI Express x1 expansion slot

B NOTE: You can install a PCl Express x1, x8, or x16 expansion card in the PCI Express x16 slots.

For dual graphics card configurations, the first (primary) card must be installed in the PCI Express
x16 slot that is NOT downshifted to a x4 slot.

To remove, replace, or add an expansion card:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 31).

2. Remove the computer access panel (Computer Access Panel on page 34).

3. Locate the correct vacant expansion socket on the system board and the corresponding
expansion slot on the back of the computer chassis.
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4. Press straight down on the two green thumb tabs inside the chassis (1) and rotate the expansion
card retention latch up (2).

Figure 5-9 Opening the Expansion Slot Retainer

5. Before installing an expansion card, remove the expansion slot cover or the existing expansion
card.

Er NOTE: Before removing an installed expansion card, disconnect any cables that may be
attached to the expansion card.

a. If you are installing an expansion card in a vacant socket, remove the appropriate
expansion slot cover on the back of the chassis. Lift the expansion slot cover from the

expansion slot.

Figure 5-10 Removing an Expansion Slot Cover
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b. If you are removing a standard PCI card or PCI Express x1 card, hold the card at each end
and carefully rock it back and forth until the connectors pull free from the socket. Lift the
card straight up to remove it. Be sure not to scrape the card against other components.

B NOTE: Before removing an installed expansion card, disconnect any cables that may be
attached to the expansion card.

Figure 5-11 Removing a Standard PCI Expansion Card

c. Ifyou are removing a PCI Express x16 card, pull the retention arm on the back of the
expansion socket away from the card and carefully rock the card back and forth until the
connectors pull free from the socket. Lift the card straight up to remove it. Be sure not to
scrape the card against other components.

6. Store the removed card in anti-static packaging.
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7. If you are not installing a new expansion card, install an expansion slot cover to close the open
slot.

/A CAUTION: After removing an expansion card, you must replace it with a new card or
expansion slot cover for proper cooling of internal components during operation.

8. Toinstall a new expansion card, slide the bracket on the end of the card down into the slot on
the back of the chassis and press the card down firmly into the socket on the system board.

Figure 5-13 Installing an Expansion Card

- i

B NOTE: When installing an expansion card, press firmly on the card so that the whole
connector seats properly in the expansion card slot.

9. Close the expansion card retention latch, making sure that it snaps firmly into place.

10. Connect external cables to the installed card, if needed. Connect internal cables to the system
board, if needed.

11. Reconfigure the computer, if necessary. Refer to Computer Setup (F10) Utility on page 4 for
instructions on using Computer Setup.
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Drives

When installing additional drives, follow these guidelines:

The primary Serial ATA (SATA) hard drive must be connected to the dark blue SATA connector
on the system board labeled SATAO.

Connect the first SATA optical drive to the white SATA connector on the system board labeled
SATA1.

Connect devices in order of SATAO, SATA1, SATA2, then SATAS.
Connect an optional eSATA adapter cable to the black ESATA connector on the system board.

Connect a media card reader USB cable to the USB connector on the system board labeled
MEDIA. If the media card reader has a 1394 port, connect the 1394 cable to the 1394 PCI card.

The system does not support Parallel ATA (PATA) optical drives or PATA hard drives.
You may install either a third-height or a half-height drive into a half-height bay.

You must install guide screws to ensure the drive will line up correctly in the drive cage and lock
in place. HP has provided extra guide screws installed on the chassis. The hard drive uses 6-32
isolation mounting guide screws, eight of which are installed on the hard drive bracket under the
access panel. All other drives use M3 metric screws, eight of which are installed on the optical
drive bracket under the access panel. The HP-supplied metric guide screws are black. The HP-
supplied 6-32 isolation mounting guide screws are silver and blue. If you are replacing the
primary hard drive, you must remove the four silver and blue 6-32 isolation mounting guide
screws from the old hard drive and install them in the new hard drive.

Figure 5-14 Extra Guide Screw Locations

No. Guide Screw Device
1 Black M3 Metric Screws 5.25-inch Drives
2 Silver and Blue 6-32 Isolation Mounting Screws 3.5-inch Hard Drives
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/\ CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the
computer, and unplug the power cord. Do not remove a drive while the computer is on or in standby
mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Handle a drive carefully; do not drop it.
Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and
label the package “Fragile: Handle With Care.”

System Board Drive Connections
Refer to the following illustration and table to identify the system board drive connectors.

Figure 5-15 System Board Drive Connections

Table 5-3 System Board Drive Connections

No. System Board Connector System Board Label Color

1 SATAO SATAO dark blue
2 SATA1 SATA1 white

3 SATA2 SATA2 light blue
4 SATA3 SATA3 orange

5 eSATA ESATA black

6 Media Card Reader MEDIA black
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Drive Positions

Figure 5-16 Desktop and Minitower Drive Positions

Table 5-4 Drive Positions

1 Three 5.25-inch external drive bays for optional drives (optical drives and media card reader shown)

2 Three 3.5-inch internal hard drive bays

NOTE: The drive configuration on your computer may be different than the drive configuration shown above.

The bottom 5.25-inch drive bay has a shorter depth than the upper two bays. The bottom bay
supports a half-height drive or other device that is no more than 14.5 cm (5.7 inches) in depth. Do not
try to force a larger drive, such as an optical drive, into the bottom bay. This could cause damage to
the drive and the system board. The use of unnecessary force when installing any drive into the drive
bay may result in damage to the drive.

To verify the type and size of the storage devices installed in the computer, run Computer Setup.
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Removing a Drive from a Drive Bay

/A CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 31).

2. Remove the computer access panel (Computer Access Panel on page 34).

3. Disconnect the drive cables, as indicated in the following illustrations:

/A CAUTION: When removing the cables, pull the tab or connector instead of the cable itself to
avoid damaging the cable.

e If you are removing an optical drive, disconnect the power cable (1) and data cable (2) from
the back of the drive.

Figure 5-17 Disconnecting the Optical Drive Cables
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e If you are removing a media card reader, disconnect the USB cable from the system board.
If the media card reader has a 1394 port, disconnect the 1394 cable from the PCI card.

Figure 5-18 Disconnecting the Media Card Reader USB Cable
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4. Remove the drive from the drive bay as follows:

e Toremove a 5.25-inch drive in the desktop configuration, press down on the yellow
drivelock mechanism (1) and slide the drive from the drive bay (2).

/A CAUTION: When the yellow drivelock is pressed, all the external 5.25-inch drives are
released so do not tilt the unit and allow the drives to fall out.

Figure 5-20 Removing a 5.25-inch Drive in the Desktop Configuration (Optical Drive
shown)

e Toremove a 5.25-inch drive in the minitower configuration, pull up on the green drivelock
mechanism (1) for that specific drive and slide the drive from the drive bay (2).

Figure 5-21 Removing a 5.25-inch Drive in the Minitower Configuration (Optical Drive
shown)
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e Toremove a hard drive from and internal 3.5-inch drive bay, pull up on the green hard drive
drivelock mechanism (1) for that drive and slide the drive from the drive bay (2).

Figure 5-22 Removing a Hard Drive

Jlg,' __.-.___‘“ L i .“I‘-..‘

5. Store the removed drive in anti-static packaging.
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Installing a 5.25-inch Drive into an External Drive Bay

1.  Prepare the computer for disassembly (Preparation for Disassembly on page 31).

2. Remove the computer access panel (Computer Access Panel on page 34).

3.  Remove the front bezel (Front Bezel on page 35). If you are installing a drive in a bay covered
by a bezel blank, remove the bezel blank. See Bezel Blanks on page 36 for more information.

4. Install four M3 metric guide screws in the lower holes on each side of the drive (1). HP has
provided four extra M3 metric guide screws on the 5.25-inch drive bracket under the access
panel. The M3 metric guide screws are black.

EBr NOTE: If you are replacing a drive, transfer the guides screws from the old drive to the new
one.

/A CAUTION: Use only 5-mm long screws as guide screws. Longer screws can damage the
internal components of the drive.

Figure 5-23 Installing a 5.25-Inch Drive in a Minitower (top) and Desktop (bottom)

5. Install the drive in the desired drive bay by sliding it all the way into the front of the drive cage
until it locks (2). The drivelock automatically secures the drive in the bay.

/A CAUTION: The bottom 5.25-inch drive bay has a shorter depth than the upper two bays. The
bottom bay supports a half-height drive or other device that is no more than 14.5 cm (5.7 inches)
in depth. Do not try to force a larger drive, such as an optical drive, into the bottom bay. This
could cause damage to the drive and the system board. The use of unnecessary force when
installing any drive into the drive bay may result in damage to the drive.
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6. Connect the power cable (1) and data cable (2) to the rear of the drive.

Figure 5-24 Connecting the Drive Cables (Optical Drive shown)

7. If you are installing a new drive, connect the opposite end of the data cable to the appropriate
system board connector.

Ef NOTE: If you are installing a SATA optical drive, connect the first optical drive to the white
SATA connector on the system board labeled SATA1. Connect a second optical drive to the next
available (unpopulated) SATA connector following the numbered sequence of the connectors.

If your are installing a media card reader, connect the USB cable to the USB system board
connector labeled MEDIA. If the media card reader includes a 1394 port, connect the 1394 cable
to the 1394 PCI card.

Refer to System Board Drive Connections on page 48 for an illustration of the system board
drive connectors.

8. Replace the front bezel and computer access panel.
9. Reconnect the power cord and turn on the computer.
10. Lock any security devices that were disengaged when the computer access panel was removed.

11. Reconfigure the computer, if necessary.
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Installing a 3.5-inch SATA Hard Drive into an Internal Drive Bay

B NOTE: The system does not support Parallel ATA (PATA) hard drives.

Before you remove the old hard drive, be sure to back up the data from the old hard drive so that you
can transfer the data to the new hard drive.

To install a hard drive in a 3.5-inch internal drive bay:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 31).

2. Remove the computer access panel (Computer Access Panel on page 34).
3. Install four 6-32 isolation mounting guide screws, two on each side of the drive.

Figure 5-25 Installing the Hard Drive Guide Screws

Br NOTE: The hard drive uses 6-32 isolation mounting guide screws. Eight extra guide screws
are installed on the hard drive bracket under the access panel. The HP-supplied isolation
mounting guide screws are silver and blue.

If you are replacing a drive, transfer the guides screws from the old drive to the new one.

4. Slide the hard drive down into the drive cage until it locks. The drivelock automatically secures
the drive in the bay.

Figure 5-26 Installing a Hard Drive into the Hard Drive Bay

/\ CAUTION: Make sure the guide screws line up with the guide slots in the drive cage. The use
of unnecessary force when installing any drive into the drive bay may result in damage to the
drive.
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5. Connect the power cable (1) and data cable (2) to the rear of the hard drive.

Figure 5-27 Connecting the Power Cable and Data Cable to a SATA Hard Drive

6. Connect the opposite end of the data cable to the appropriate system board connector.

EY NOTE: If your system has only one SATA hard drive, you must connect the hard drive data
cable to the dark blue connector labeled SATAO to avoid any hard drive performance problems.
If you are adding a second hard drive, connect the data cable to the next available (unpopulated)
SATA connector on the system board in the following order: SATAO, SATA1, SATA2, SATAS.

7. Replace the computer access panel.
8. Reconnect the power cord and turn on the computer.
9. Lock any security devices that were disengaged when the computer access panel was removed.

10. Reconfigure the computer, if necessary.

Removing and Replacing a Removable 3.5-inch SATA Hard Drive

Some models are equipped with a Removable SATA Hard Drive Enclosure in the 5.25-inch external
drive bay. The hard drive is housed in a carrier that can be quickly and easily removed from the drive
bay. To remove and replace a drive in the carrier:

B NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive.

1. Unlock the hard drive carrier with the key provided and slide the carrier out of the enclosure.
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2. Remove the screw from the rear of the carrier (1) and slide the top cover off the carrier (2).

Figure 5-28 Removing the Carrier Cover

3.  Remove the adhesive strip that secures the thermal sensor to the top of the hard drive (1) and
move the thermal sensor away from the carrier (2).

Figure 5-29 Removing the Thermal Sensor
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4. Remove the four screws from the bottom of the hard drive carrier.

Figure 5-30 Removing the Security Screws

5. Slide the hard drive back to disconnect it from the carrier then lift it up and out of the carrier.

Figure 5-31 Removing the Hard Drive
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Place the new hard drive in the carrier then slide the hard drive back so that it seats in the SATA
connector on the carrier's circuit board. Be sure the connector on the hard drive is pressed all

the way into the connector on the carrier's circuit board.

Figure 5-32 Replacing the Hard Drive

7. Replace the four screws in the bottom of the carrier to hold the drive securely in place.

Figure 5-33 Replacing the Security Screws
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8. Place the thermal sensor on top of the hard drive in a position that does not cover the label (1)
and attach the thermal sensor to the top of the hard drive with the adhesive strip (2).

Figure 5-34 Replacing the Thermal Sensor

9. Slide the cover on the carrier (1) and replace the screw on the rear of the carrier to secure the
cover in place (2).

Figure 5-35 Replacing the Carrier Cover

10. Slide the hard drive carrier into the enclosure on the computer and lock it with the key provided.

B NOTE: The carrier must be locked for power to be supplied to the hard drive.
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Hood Sensor

The hood sensor is located on the top of the rear chassis panel.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 31).

2. Remove the computer access panel (Computer Access Panel on page 34).

3. Unplug the hood sensor cable from the white connector labeled HSENSE on the system board

(1).

4. Slide the hood sensor straight out of the slot in the chassis (2).

To reinstall the hood sensor, reverse the removal procedure.
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Front I/0, USB Assembly

The front 1/0, USB assembly is mounted to the front of the chassis and is removed by pulling it away
from the chassis.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 31).

Remove the computer access panel (Computer Access Panel on page 34).

2

3.  Remove the front bezel (Front Bezel on page 35).

4. Disconnect the three cables from the following system board connectors:
e  Yellow connector labeled FRONT USB
e  Green connector labeled FRONT USB2
e  Blue connector labeled FRONT AUD

B NOTE: The blue FRONT AUD connector is not located near the other two connectors
used for the front I/O assembly. See the image below for its location.

5. Remove the screw that secures the assembly to the front of the chassis (1).
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6. Rotate the right side of the assembly away from the chassis, and then pull the assembly toward
the right and away from the chassis (2) while threading the wires through the slot between the
drive cage and chassis front and the hole in the front of the chassis.

Figure 5-37 Removing the front I/O, USB, power switch assembly
_ —_— 2 _—

To reinstall the assembly, reverse the removal procedure.

64 Chapter 5 Removal and Replacement Procedures Convertible Minitower (CMT) Chassis



Power Switch Assembly

The power switch assembly is mounted to the front of the chassis and removed by pulling it away
from the chassis.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 31).

Remove the computer access panel (Computer Access Panel on page 34).

Remove the computer access panel (Front Bezel on page 35).

2
3
4. Disconnect the cable from the black system board connector labeled PB/LED.
5. Press downward on the tab (1) at the top of the assembly.

6

Rotate the top of the assembly downward (2), and then pull it away from the chassis while
threading the wires through the hole in the front of the chassis.

Figure 5-38 Removing the po

T —

wer switch assembly

To install the power switch assembly, reverse the removal procedure.

Power Switch Assembly 65



Speaker

The speaker is mounted to the inside front of the chassis with two screws.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 31).

Remove the computer access panel (Computer Access Panel on page 34).

2
3. Disconnect the speaker wire from the white system board connector labeled SPKR.
4

From the inside of the unit, remove the two screws (1) that secure the speaker to the front of the
chassis.

5. Rotate the top of the speaker downward (2), and then remove it from the chassis.

Figure 5-39 Removing the speaker
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To install the speaker, reverse the removal procedures.
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Rear Chassis Fan

The rear fan is mounted to the rear chassis wall and secured by four Phillips screws.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 31).

Remove the computer access panel (Computer Access Panel on page 34).

2
3. Disconnect the fan control cable from the red/brown system board labeled CHFANZ2.
4. Remove the four screws that secure the fan housing to the chassis.

5. Remove the fan from the chassis.

Figure 5-40 Removing the rear chassis fan

c

To install the fan, reverse the removal procedure. Be sure to orient the air flow out of the unit.
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Heat sink

1. Prepare the computer for disassembly (Preparation for Disassembly on page 31).

Remove the computer access panel (Computer Access Panel on page 34).

Disconnect the fan cable from the white system board connector labeled CPUFAN (1).

A N

Unscrew the four captive screws (2) that secure the heat sink to the system board.

/A CAUTION: Heat sink retaining screws should be removed in diagonally opposite pairs (as in
an X) to even the downward forces on the processor. This is especially important as the pins on
the socket are very fragile and any damage to them may require replacing the system board.

5. Lift the heat sink from the processor.

Figure 5-41 Removing the heat sink

When reinstalling the heat sink, make sure that its bottom has been cleaned with an alcohol wipe and
fresh thermal grease has been applied to the top of the processor.

/\ CAUTION: Heat sink retaining screws should be tightened in diagonally opposite pairs (as in an X)
to evenly seat the heat sink on the processor. Failure to do so could result in damage that requires
replacing the system board.
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Processor
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Prepare the computer for disassembly (Preparation for Disassembly on page 31).

Remove the computer access panel (Computer Access Panel on page 34).

Remove the heat sink (Heat sink on page 68).

Rotate the locking lever to its full open position (1).
Raise and rotate the microprocessor retainer to its fully open position (2).

Carefully lift the processor from the socket (3)).

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

The heat sink must be installed within 24 hours of installing the processor to prevent damage to
the processor’s solder connections.

Figure 5-42 Removing the processor

To install a new processor:

1.
2.

Place the processor in its socket and close the retainer.
Secure the locking lever.

If reusing the existing heat sink, go to step 3.

If using a new heat sink, go to step 5.

If reusing the existing heat sink, apply the thermal grease provided in the spares kit to the top of
the processor.

Clean the bottom of the heat sink with the provided alcohol pad and place it atop the processor.
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5. If using a new heat sink, remove the protective covering from the bottom of the heat sink and
place it in position atop the processor.

6. Secure the heat sink to the system board and system board tray with the 4 captive screws and
attach the heat sink control cable to the system board.

/A CAUTION: Heat sink retaining screws should be tightened in diagonally opposite pairs (as in
an X) to evenly seat the heat sink on the processor. This is especially important as the pins on
the socket are very fragile and any damage to them may require replacing the system board.

B NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can
be found on the Web at: http://h18000.www1.hp.com/support/files.

Power Supply

A WARNING! To reduce potential safety issues, only the power supply provided with the computer, a
replacement power supply provided by HP, or a power supply purchased as an accessory from HP
should be used with the computer.

The power supply is secured to the rear of the chassis by four Torx screws. A lever on the chassis
floor also holds the power supply in place.

The power supply is secured by two security screws that require use of a Smart Cover FailSafe Key
to remove.

L)

NOTE: The Smart Cover FailSafe Key is a specialized tool available from HP. Be prepared; order
this key before you need it.

Perform any of the following to obtain a FailSafe Key:
e  Order PN 166527-001 for the wrench-style key or PN 166527-002 for the screwdriver bit key.

o  Refer to the HP Web site (http://www.hp.com) for ordering information.

e  (Call the appropriate number listed in the warranty or in the Support Telephone Numbers guide.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 31).

2. Remove the computer access panel (Computer Access Panel on page 34).

3. Disconnect all power cables from the mass storage devices and from the system board.
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4. Remove the power cables from the white plastic clamp on the chassis floor.

5. Remove the two Torx screws (1) and the two security screws (2) that connect the power supply
to the chassis.

Figure 5-43 Removing the power supply, screw locations
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6. Press the tab in front of the power supply that holds it in place.

Figure 5-44 Removing the power supply, release lever

7. Slide the power supply toward the front of the computer, rotate toward the fan so the power
supply clears the lip on the top of the chassis, and then lift the power supply out of the chassis.

To install the power supply, reverse the removal procedure.

System Board

1. Prepare the computer for disassembly (Preparation for Disassembly on page 31).

2.  When replacing the system board, make sure the following components are removed from the
defective system board and installed on the replacement system board:

e  Memory modules (seelnstalling Additional Memory on page 39)

e  Expansion cards (Expansion Cards on page 43)

e  Heat sink (Heat sink on page 68).

e  Processor (Processor on page 69)

Remove the computer access panel (Computer Access Panel on page 34).

Disconnect all cables connected to the system board, noting their location for reinstallation.

Remove the 10 screws that secure the system board to the chassis.

o o

Slide the system board toward the front of the computer so that the connectors loosen from the
rear of the chassis.
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7.  Lift the system board out of the computer.

Figure 5-45 Removing the system board
Ul - _

Br NOTE: When replacing the system board, you must also change the chassis serial number in the
BIOS.

/\ CAUTION: Before reinstalling the heat sink you must clean the top of the processor and the bottom
of the heat sink with an alcohol pad supplied in the spares kit. After the alcohol has evaporated, apply
thermal grease to the top of the processor from the syringe supplied in the spares kit.

Battery

The battery that comes with your computer provides power to the real-time clock and has a lifetime of
about three years. When replacing the battery, use a battery equivalent to the battery originally
installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

Er NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.
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/A WARNING! This computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 140°F (60°C).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.
Replace the battery only with the HP spare designated for this product.

/\ CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared. Refer to Computer
Setup (F10) Utility on page 4 for information on backing up the CMOS settings.

B NOTE: HP encourages customers to recycle used electronic hardware, HP original print cartridges,
and rechargeable batteries. For more information about recycling programs, go to http://www.hp.com/
recycle.

/\ CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object.

1.  Prepare the computer for disassembly (Preparation for Disassembly on page 31).

2. Remove the computer access panel (Computer Access Panel on page 34).

Br NOTE: It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. Depending on the type of battery holder on your system board, complete the following
instructions to replace the battery:

Type 1 Battery Holder
1.  Lift the battery out of its holder.

Figure 5-46 Removing the battery from a type 1 holder

2. Slide the replacement battery into position, positive side up.
3. The battery holder automatically secures the battery in the proper position.

4. Replace the computer access panel.
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5. Plug in the computer and turn on power to the computer.

6. Reset the date and time and any special system setups using Computer Setup. Refer to
Computer Setup (F10) Utility on page 4.

Type 2 Battery Holder

1. To release the battery from its holder, squeeze the metal clamp (1) that extends above one edge
of the battery. When the battery pops up, lift it out.

2. Toinsert the new battery, slide one edge of the replacement battery under the holder’s lip with
the positive side up (2). Push the other edge down until the clamp snaps over the other edge of
the battery.

Figure 5-47 Removing the battery from a type 2 holder

3. Replace the computer access panel.
4. Plug in the computer and turn on power to the computer.

5. Reset the date and time and any special system setups using Computer Setup. Refer to
Computer Setup (F10) Utility on page 4.

Type 3 Battery Holder
1. Pull back on the clip (1) that holds the battery in place, then remove the battery (2).
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2. Insert the new battery and position the clip back in place.

Figure 5-48 Removing the battery from a type 3 holder

3. Replace the computer access panel.
4. Plug in the computer and turn on power to the computer.

5. Reset the date and time and any special system setups using Computer Setup.
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External Security Devices

The following security devices are used to prevent unauthorized access to the internal components of
the computer and/or secure the computer to a fixed object.

Installing a Security Lock

The security locks displayed below and on the following page can be used to secure the computer.

HP/Kensington MicroSaver Security Cable Lock
Figure 5-49 Installing a Cable Lock
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Padlock
Figure 5-50 Installing a Padlock

HP Business PC Security Lock
1. Fasten the security cable by looping it around a stationary object.

Figure 5-51 Securing the Cable to a Fixed Object
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2. Thread the keyboard and mouse cables through the lock.

Figure 5-52 Threading the Keyboard and Mouse Cables

3. Screw the lock to the chassis using the screw provided.

Figure 5-53 Attaching the Lock to the Chassis

External Security Devices
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Insert the plug end of the security cable into the lock (1) and push the button in (2) to engage the
lock. Use the key provided to disengage the lock.

Figure 5-54 Engaging the Lock

Front Bezel Security

The front bezel can be locked in place by installing a security screw provided by HP. To install the
security screw:

1.

2
3.
4

Prepare the computer for disassembly (Preparation for Disassembly on page 31).

Remove the computer access panel (Computer Access Panel on page 34).

Remove the front bezel (Front Bezel on page 35).

Remove the security screw from the inside of the front bezel.

Figure 5-55 Retrieving the Front Bezel Security Screw
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5. Replace the front bezel.

6. Install the screw through the interior of the front of the chassis into the front bezel. The screw
hole is located on the left edge of the chassis next to the top hard drive bay.

Figure 5-56 Installing the Front Bezel Security Screw

7. Replace the access panel.
8. Reconnect the power cord and turn on the computer.

9. Lock any security devices that were disengaged when the access panel was removed.
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Changing from a Minitower to a Desktop Configuration

1. Remove/disengage any security devices that prohibit opening the computer.
2. Remove all removable media, such as compact discs or USB flash drives, from the computer.
3. Turn off the computer properly through the operating system, then turn off any external devices.

4. Disconnect the power cord from the power outlet and disconnect any external devices.

/A CAUTION: Regardless of the power-on state, voltage is always present on the system board
as long as the system is plugged into an active AC outlet. You must disconnect the power cord
to avoid damage to the internal components of the computer.

Remove the computer access panel.
Remove the front bezel.

Disconnect all power and data cables from the back of the drives in the 5.25-inch drive bays.

© N o o

To release the drives from the 5.25-inch drive bay, lift the release tab on the green latch drive
bracket for the drive (1). While lifting the release tab, slide the drive from its drive bay (2).
Repeat this step for each 5.25-inch drive.

Figure 5-57 Releasing the 5.25-inch Drives from the Drive Bays (Minitower)
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9. Gently slide the drive into the uppermost available bay until it snaps into place. When the drive is
properly inserted, the drivelock will secure it. Repeat this step for each drive.

Figure 5-58 Installing a Drive in the Desktop Configuration

/A CAUTION: The bottom 5.25-inch drive bay has a shorter depth than the upper two bays. The
bottom bay supports a half-height drive or other device that is no more than 14.5 cm (5.7 inches)
in depth. Do not try to force a larger drive, such as an optical drive, into the bottom bay. This
could cause damage to the drive and the system board. The use of unnecessary force when
installing any drive into the drive bay may result in damage to the drive.

10. Reconnect all power and data cables to the drives in the 5.25-inch drive bays.

11. Remove the bezel subpanel as described in Bezel Blanks on page 36.

/A CAUTION: Hold the subpanel straight when you pull it away from the front bezel. Pulling the
subpanel away at an angle could damage the pins that align it within the front bezel.

12. Reposition the bezel blanks within the subpanel in the proper orientation for the desktop
configuration.

Changing from a Minitower to a Desktop Configuration
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13. Reposition the subpanel (rotate it 90°) with the logo at the bottom, then snap it back into the
bezel.

Figure 5-59 Changing from a Minitower to a Desktop Configuration

14. Replace the front bezel and computer access panel.
15. Reconnect the power cord and turn on the computer.

16. Lock any security devices that were disengaged when the computer access panel was removed.

Changing from a Desktop to a MinitowerConfiguration

1. Remove/disengage any security devices that prohibit opening the computer.
2. Remove all removable media, such as compact discs or USB flash drives, from the computer.
3. Turn off the computer properly through the operating system, then turn off any external devices.

4. Disconnect the power cord from the power outlet and disconnect any external devices.

/A CAUTION: Regardless of the power-on state, voltage is always present on the system board
as long as the system is plugged into an active AC outlet. You must disconnect the power cord
to avoid damage to the internal components of the computer.

5. Remove the computer access panel.
6. Remove the front bezel.

7. Disconnect all power and data cables from the back of the drives in the 5.25-inch drive bays.
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8. To release the drives from the 5.25-inch drive bay, press down on the short yellow drivelock as
shown (1). While pressing the drivelock, pull the drives out of the drive bay (2).

Figure 5-60 Releasing the 5.25-inch Drives from the Drive Bays (Desktop)

9. Gently slide the drive into the uppermost available bay until it snaps into place. When the drive is
properly inserted, the drivelock will secure it. Repeat this step for each drive.

Figure 5-61 Installing a Drive in the Minitower Configuration

/A CAUTION: The bottom 5.25-inch drive bay has a shorter depth than the upper two bays. The
bottom bay supports a half-height drive or other device that is no more than 14.5 cm (5.7 inches)
in depth. Do not try to force a larger drive, such as an optical drive, into the bottom bay. This
could cause damage to the drive and the system board. The use of unnecessary force when
installing any drive into the drive bay may result in damage to the drive.

10. Reconnect all power and data cables to the drives in the 5.25-inch drive bays.

11. Remove the bezel subpanel as described in the Bezel Blanks on page 36 section.
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/A CAUTION: Hold the subpanel straight when you pull it away from the front bezel. Pulling the
subpanel away at an angle could damage the pins that align it within the front bezel.

12. Reposition the bezel blanks within the subpanel in the proper orientation for the minitower
configuration.

13. Reposition the subpanel (rotate it 90°) with the logo at the bottom, then snap it back into the
bezel.

Figure 5-62 Changing from a Desktop to a Minitower Configuration

14. Replace the front bezel and computer access panel.
15. Reconnect the power cord and turn on the computer.

16. Lock any security devices that were disengaged when the computer access panel was removed.

86 Chapter 5 Removal and Replacement Procedures Convertible Minitower (CMT) Chassis



Removal and Replacement Procedures

Small Form Factor (SFF) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to
verify that all components operate properly.

B NOTE: Not all features listed in this guide are available on all computers.

Preparation for Disassembly

See Ildentifying the Chassis, Routine Care, and Disassembly Preparation on page 21 for initial safety
procedures.

1.

o » 0N

Remove/disengage any security devices that prohibit opening the computer (Unlocking the
Smart Cover Lock on page 32 and External Security Devices on page 90).

Close any open software applications.
Exit the operating system.
Remove any compact disc or media card from the computer.

Turn off the computer and any peripheral devices that are connected to it.

CAUTION: Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the
system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be
disconnected before servicing a unit.

Disconnect the power cord from the electrical outlet and then from the computer.

Disconnect all peripheral device cables from the computer.

NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using
the wrong screw in an application may damage the unit.
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Unlocking the Smart Cover Lock

B NOTE: The Smart Cover Lock is an optional feature included on some models only.

The Smart Cover Lock is a software-controllable cover lock, controlled by the setup password. This
lock prevents unauthorized access to the internal components. The computer ships with the

Smart Cover Lock in the unlocked position. For more information about locking the Smart Cover Lock,
refer to the Desktop Management Guide.

Smart Cover FailSafe Key

If you enable the Smart Cover Lock and cannot enter your password to disable the lock, you will need
a Smart Cover FailSafe Key to open the computer cover. You will need the key to access the internal
computer components in any of the following circumstances:

e Power outage
e  Startup failure
e PC component (for example, processor or power supply) failure

e  Forgotten password

B NOTE: The Smart Cover FailSafe Key is a specialized tool available from HP. Be prepared; order
this key before you need it.

To obtain a FailSafe Key:

e Contact an authorized HP reseller or service provider. Order PN 166527-001 for the wrench-
style key or PN 166527-002 for the screwdriver bit key.

e  Refer to the HP Web site (http://www.hp.com) for ordering information.

e  Call the appropriate number listed in the warranty or in the Support Telephone Numbers guide.

Using the Smart Cover FailSafe Key to Remove the Smart Cover Lock

To open the access panel with the Smart Cover Lock engaged:

1. Remove/disengage any security devices that prohibit opening the computer.

2. Remove all removable media, such as compact discs or USB flash drives, from the computer.
3. Turn off the computer properly through the operating system, then turn off any external devices.
4.

Disconnect the power cord from the power outlet and disconnect any external devices.

/A CAUTION: Regardless of the power-on state, voltage is always present on the system board
as long as the system is plugged into an active AC outlet. You must disconnect the power cord
to avoid damage to the internal components of the computer.

5. If the computer is on a stand, remove the computer from the stand.
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6. Use the Smart Cover FailSafe Key to remove the tamper-proof screw that secures the Smart
Cover Lock to the chassis.

Figure 6-1 Removing the Smart Cover Lock Screw

You can now remove the access panel. See Computer Access Panel on page 150.

To reattach the Smart Cover Lock, secure the lock in place with the tamper-proof screw.
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External Security Devices

B NOTE: For information on data security features, refer to the Desktop Management Guide and the
HP ProtectTools Security Manager Guide (some models) at http://www.hp.com.

Installing a Security Lock

The security locks displayed below and on the following pages can be used to secure the computer.

HP/Kensington MicroSaver Security Cable Lock

Figure 6-2 Installing a Cable Lock

90 Chapter 6 Removal and Replacement Procedures Small Form Factor (SFF) Chassis


http://www.hp.com

Padlock
Figure 6-3 Installing a Padlock

HP Business PC Security Lock
1. Fasten the security cable by looping it around a stationary object.

Figure 6-4 Securing the Cable to a Fixed Object
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2. Thread the keyboard and mouse cables through the lock

Figure 6-5 Threading the Keyboard and Mouse Cables

3. Screw the lock to the chassis using the screw provided.

Figure 6-6 Attaching the Lock to the Chassis
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4. Insert the plug end of the security cable into the lock (1) and push the button in (2) to engage the
lock. Use the key provided to disengage the lock.

Figure 6-7 Engaging the Lock

Front Bezel Security

The front bezel can be locked in place by installing a security screw provided by HP. To install the
security screw:

1.  Remove/disengage any security devices that prohibit opening the computer.

2. Remove all removable media, such as compact discs or USB flash drives, from the computer.
3. Turn off the computer properly through the operating system, then turn off any external devices.
4

Disconnect the power cord from the power outlet and disconnect any external devices.

/A CAUTION: Regardless of the power-on state, voltage is always present on the system board
as long as the system is plugged into an active AC outlet. You must disconnect the power cord
to avoid damage to the internal components of the computer.

5. If the computer is on a stand, remove the computer from the stand.

6. Remove the access panel and front bezel.
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7.

10.
11.
12
13.

Remove one of the five silver 6-32 standard screws located on the front of the chassis behind

the bezel.

Figure 6-8 Retrieving the Front Bezel Security Screw

Replace the front bezel.

Install the security screw next to the middle front bezel release tab to secure the front bezel in
place.

Figure 6-9 Installing the Front Bezel Security Screw

Replace the access panel.
If the computer was on a stand, replace the stand.
Reconnect the power cord and turn on the computer.

Lock any security devices that were disengaged when the access panel was removed.
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Computer Access Panel

1. Prepare the computer for disassembly (Preparation for Disassembly on page 87).

2. Ifthe computer is on a stand, remove the computer from the stand.
3. Lift up on the access panel handle (1) then lift the access panel off the computer (2).

Figure 6-10 Removing the Access Panel

To install the access panel, reverse the removal procedure.
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Front Bezel

1. Prepare the computer for disassembly (Preparation for Disassembly on page 87).

2. Remove the access panel (Computer Access Panel on page 95).

3. Lift up the three tabs on the side of the bezel (1), then rotate the bezel off the chassis (2).

Figure 6-11 Removing the Front Bezel

To install the front bezel, reverse the removal procedure.
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Bezel Blanks

On some models, there are bezel blanks covering the 3.5-inch and 5.25-inch external drive bays that
need to be removed before installing a drive. To remove a bezel blank:

1.
2,
3.

4,

Remove the access panel (Computer Access Panel on page 95).

Remove the front bezel (Front Bezel on page 96)..

To remove a bezel blank, push the two retaining tabs that hold the bezel blank in place towards
the outer right edge of the bezel (1) and slide the bezel blank back and to the right to remove it

().

Figure 6-12 Removing a Bezel Blank

Replace the front bezel.

Bezel Blanks
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Installing Additional Memory

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) dual inline memory modules (DIMMs).

DIMMs

The memory sockets on the system board can be populated with up to four industry-standard DIMMs.
These memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum
memory support, you can populate the system board with up to 16-GB of memory configured in a
high-performing dual channel mode.

DDR3-SDRAM DIMMs
For proper system operation, the DDR3-SDRAM DIMMs must be:
e industry-standard 240-pin

e unbuffered non-ECC PC3-8500 DDR3-1066 MHz-compliant or PC3-10600 DDR3-1333 MHz-
compliant

° 1.5 volt DDR3-SDRAM DIMMs
The DDR3-SDRAM DIMMs must also:

e support CAS latency 7 DDR3 1066 MHz (7-7-7 timing) and CAS latency 9 DDR3 1333 MHz
(9-9-9 timing)

e  contain the mandatory JEDEC SPD information

In addition, the computer supports:

e  512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies
e single-sided and double-sided DIMMs

° DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not
supported

B NOTE: The system will not operate properly if you install unsupported DIMMs.
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Populating DIMM Sockets

There are four DIMM sockets on the system board, with two sockets per channel. The sockets are
labeled DIMM1, DIMM2, DIMM3, and DIMM4. Sockets DIMM1 and DIMM2 operate in memory
channel A. Sockets DIMM3 and DIMM4 operate in memory channel B.

Figure 6-13 DIMM Socket Locations

o

Table 6-1 DIMM Socket Locations

Item Description Socket Color
1 DIMM1 socket, Channel A (populate first) Black
2 DIMM2 socket, Channel A (populate third) White
3 DIMM3 socket, Channel B (populate second) White
4 DIMM4 socket, Channel B (populate fourth) White

NOTE: A DIMM must occupy the black DIMM1 socket. Otherwise, the system will
display a POST error message indicating that a memory module must be installed in
the wrong socket.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

e  The system will operate in single channel mode if the DIMM sockets are populated in one
channel only.

e The system will operate in a higher-performing dual channel mode if the total memory capacity
of the DIMMs in Channel A is equal to the total memory capacity of the DIMMs in Channel B.
The technology and device width can vary between the channels. For example, if Channel A is
populated with two 1-GB DIMMs and Channel B is populated with one 2-GB DIMM, the system
will operate in dual channel mode.

e  The system will operate in flex mode if the total memory capacity of the DIMMs in Channel A is
not equal to the total memory capacity of the DIMMs in Channel B. In flex mode, the channel
populated with the least amount of memory describes the total amount of memory assigned to
dual channel and the remainder is assigned to single channel. For optimal speed, the channels
should be balanced so that the largest amount of memory is spread between the two channels.
If one channel will have more memory than the other, the larger amount should be assigned to
Channel A. For example, if you are populating the sockets with one 2-GB DIMM, and three 1-GB
DIMMs, Channel A should be populated with the 2-GB DIMM and one 1-GB DIMM, and Channel
B should be populated with the other two 1-GB DIMMs. With this configuration, 4-GB will run as
dual channel and 1-GB will run as single channel.

e In any mode, the maximum operational speed is determined by the slowest DIMM in the system.
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Installing DIMMs

/A CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power
to drain before adding or removing memory modules. Regardless of the power-on state, voltage is
always supplied to the memory modules as long as the computer is plugged into an active AC outlet.
Adding or removing memory modules while voltage is present may cause irreparable damage to the
memory modules or system board. If you see an LED light on the system board, voltage is still
present.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1.  Prepare the computer for disassembly (Preparation for Disassembly on page 87).

2. Remove the access panel (Computer Access Panel on page 95).

3. Rotate up the external drive bay housing to access the memory module sockets on the system
board.

Figure 6-14 Rotating the Drive Cage Up
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4. Open both latches of the memory module socket (1), and insert the memory module into the
socket (2).

Figure 6-15 Installing a DIMM

o

-
@

B NOTE: A memory module can be installed in only one way. Match the notch on the module
with the tab on the memory socket.

A DIMM must occupy the black DIMM1 socket.
Populate the DIMM sockets in the following order: DIMM1, DIMM3, DIMMZ2, then DIMM4.

For maximum performance, populate the sockets so that the memory capacity is spread as
equally as possible between Channel A and Channel B. Refer to Populating DIMM Sockets
on page 40 for more information.

o

Push the module down into the socket, ensuring that the module is fully inserted and properly
seated. Make sure the latches are in the closed position (3).

6. Repeat steps 4 and 5 to install any additional modules.

7. Replace the access panel.

8. If the computer was on a stand, replace the stand.

9. Reconnect the power cord and turn on the computer.

10. Lock any security devices that were disengaged when the access panel was removed.

The computer should automatically recognize the additional memory the next time you turn on the
computer.
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Expansion Cards

The computer has one PCI expansion slot, two PCI Express x1 expansion slots, and one PCI
Express x16 expansion slot.

B NOTE: The PCl and PCI Express slots support only low profile cards.

Figure 6-16 Expansion Slot Locations

a

Table 6-2 Expansion Slot Locations

Item

Description

1

PCI expansion slot

2

PCI Express x16 expansion slot

3

PCI Express x1 expansion slot

4

PCI Express x1 expansion slot

B NOTE: You can install a PCl Express x1, x4, x8, or x16 expansion card in the PCI Express x16 slot.

To install an expansion card:

1.
2,

Prepare the computer for disassembly (Preparation for Disassembly on page 87).

Remove the access panel (Computer Access Panel on page 95).

Locate the correct vacant expansion socket on the system board and the corresponding
expansion slot on the back of the computer chassis.

Release the slot cover retention latch that secures the PCI slot covers by lifting the green tab on
the latch and rotating the latch to the open position.

Figure 6-17 Opening the Expansion Slot Retainer
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5. Before installing an expansion card, remove the expansion slot cover or the existing expansion

card.

If you are installing an expansion card in a vacant socket, remove the appropriate
expansion slot cover on the back of the chassis. Pull the slot cover straight up then away

from the inside of the chassis.

a.

Figure 6-18 Removing an Expansion Slot Cover
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b. If you are removing a standard PCI card or PCI Express x1 card, hold the card at each end,
and carefully rock it back and forth until the connectors pull free from the socket. Pull the
expansion card straight up from the socket (1) then away from the inside of the chassis to
release it from the chassis frame (2). Be sure not to scrape the card against the other
components.

Br NOTE: Before removing an installed expansion card, disconnect any cables that may be
attached to the expansion card.

Figure 6-19 Removing a Standard PCI Expansion Card
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c. If you are removing a PCI Express x16 card, pull the retention arm on the back of the
expansion socket away from the card and carefully rock the card back and forth until the
connectors pull free from the socket. Pull the expansion card straight up from the socket
then away from the inside of the chassis to release it from the chassis frame. Be sure not to
scrape the card against the other components.

Figure 6-20 Removing a PCI Express x16 Expansion Card

6. Store the removed card in anti-static packaging.

7. If you are not installing a new expansion card, install an expansion slot cover to close the open
slot.

/A CAUTION: After removing an expansion card, you must replace it with a new card or
expansion slot cover for proper cooling of internal components during operation.
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To install a new expansion card, hold the card just above the expansion socket on the system
board then move the card toward the rear of the chassis (1) so that the bracket on the card is
aligned with the open slot on the rear of the chassis. Press the card straight down into the
expansion socket on the system board (2).

Figure 6-21 Installing an Expansion Card

B NOTE: When installing an expansion card, press firmly on the card so that the whole

10.

1.
12.

connector seats properly in the expansion card slot.

Rotate the slot cover retention latch back in place to secure the expansion card.

Figure 6-22 Closing the Expansion Slot Retainer

Connect external cables to the installed card, if needed. Connect internal cables to the system
board, if needed.

Replace the access panel.

If the computer was on a stand, replace the stand.
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13. Reconnect the power cord and turn on the computer.
14. Lock any security devices that were disengaged when the access panel was removed.

15. Reconfigure the computer, if necessary.

Cable Management

The Small Form Factor chassis is a very compact computer and proper routing of the internal cables
is critical to the operation of the computer. Follow good cable management practices when working
inside the computer.

e Keep cables away from major heat sources like the heat sink.

e Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

e Keep cables clear of movable or rotating parts like the power supply and drive cage to prevent
them from being cut or crimped when the component is lowered into its normal position.

e  When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the
wires.

e Some flat ribbon cables come prefolded. Never change the folds on these cables.
e Do not bend any cable sharply. A sharp bend can break the internal wires.

e Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

e Never crease a SATA data cable.

e Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the connector on the system board, always
follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector (1).

2. Grasp the cable end of the connector and pull it straight up (2).

/A CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could
damage the cable and result in a failed power supply.

Figure 6-23 6-pin power connector
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Cable Connections

System board connectors are color-coded to make it easier to find the proper connection.

System Board Connector Connector Color Description

P1 White Power supply, 6-pin

PWRCPU White Power supply, 4-pin

SATA PWR1 Black ODD power connector

SATA PWR2 Black HDD power connector

CHFAN Brown Chassis fan

PB/LED Black Front power button/LED

FRONT USBH1 Yellow Front /O USB

FRONT USB2 Green Front /O USB

FRONT AUD Blue Front audio

SPKR White Internal speaker

COMB Black Serial port

HLOCK Black Hood lock solenoid

HSENSE White Hood sensor

MEDIA Black Media card reader

PAR Black Flying parallel port header
Drives

A Torx T-15 screwdriver is needed to remove and install the guide screws on a drive.

/A CAUTION: Make sure personal files on the hard drive are backed up to an external storage device
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary
hard drive, you will need to run the Restore Plus! CD to load the HP factory-installed files.

Drive Positions

Figure 6-24 Drive Positions

— —
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Table 6-3 Drive Positions

1 3.5-inch internal hard drive bay

2 3.5-inch external drive bay for optional drives (media card reader shown)

3 5.25-inch external drive bay for optional drives (optical drive shown)

NOTE: The drive configuration on your computer may be different than the drive
configuration shown above.

To verify the type, size, and capacity of the storage devices installed in the computer, run Computer
Setup.
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Installing and Removing Drives
When installing additional drives, follow these guidelines:

e The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA
connector on the system board labeled SATAO.

e  Connect a SATA optical drive to the white SATA connector on the system board labeled SATA1.
e  Connect devices in order of SATAO, SATA1, then SATA2
e Connect an optional eSATA adapter cable to the black ESATA connector on the system board.

e Connect a media card reader USB cable to the USB connector on the system board labeled
MEDIA. If the media card reader has a 1394 port, connect the 1394 cable to the 1394 PCI card.

e  The system does not support Parallel ATA (PATA) optical drives or PATA hard drives.

e  You must install guide screws to ensure the drive will line up correctly in the drive cage and lock
in place. HP has provided extra guide screws for the external drive bays (five 6-32 standard
screws and four M3 metric screws), installed in the front of the chassis, under the front bezel.
The 6-32 standard screws are required for a secondary hard drive. All other drives (except the
primary hard drive) use M3 metric screws. The HP-supplied metric screws are black and the HP-
supplied standard screws are silver. If you are replacing the primary hard drive, you must
remove the four silver and blue 6-32 isolation mounting guide screws from the old hard drive and
install them in the new hard drive.

Figure 6-25 Extra Guide Screw Locations

e

No. Guide Screw Device
1 Black M3 Metric Screws All Drives (except hard drives)
2 Silver 6-32 Standard Screws Secondary Hard Drive

There are at total of five extra silver 6-32 standard screws. Four are used as guide screws for a
secondary hard drive. The fifth is used for bezel security (see Front Bezel Security on page 80 for more
information).

110 Chapter 6 Removal and Replacement Procedures Small Form Factor (SFF) Chassis



/A CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the
computer, and unplug the power cord. Do not remove a drive while the computer is on or in standby
mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Handle a drive carefully; do not drop it.
Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and
label the package “Fragile: Handle With Care.”

System Board Drive Connections
Refer to the following illustration and table to identify the system board drive connectors.

Figure 6-26 System Board Drive Connections

o

Table 6-4 System Board Drive Connections

No. System Board Connector System Board Label Color
1 Media Card Reader MEDIA black
2 SATAO SATAO dark blue
3 SATA1 SATA1 white
4 SATA2 SATA2 light blue
5 eSATA ESATA black
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Removing an External 5.25-inch Drive

/A CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

To remove a 5.25-inch external drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 87).

If the computer is on a stand, remove the computer from the stand.

2
3.  Remove the access panel (Computer Access Panel on page 95).
4. Rotate the drive cage to its upright position.

Figure 6-27 Rotating the Drive Cage Up

5. If removing an optical drive, disconnect the power cable (1) and data cable (2) from the rear of
the optical drive.

Figure 6-28 Disconnecting the Power and Data Cables
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6. Rotate the drive cage back down to its normal position.

/A CAUTION: Be careful not to pinch any cables or wires when rotating the drive cage down.

Figure 6-29 Rotating the Drive Cage Down

7. Press down on the green drive retainer button located on the left side of the drive to disengage
the drive from the drive cage (1). While pressing the drive retainer button, slide the drive back
until it stops, then lift it up and out of the drive cage (2).

Figure 6-30 Removing the 5.25-inch Drive

Br NOTE: To replace the drive, reverse the removal procedure. When replacing a drive, transfer the
four guide screws from the old drive to the new one.

Installing an Optical Drive into the 5.25-inch Drive Bay
To install an optional 5.25-inch optical drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 87).

2. Ifthe computer is on a stand, remove the computer from the stand.

3.  Remove the access panel (Computer Access Panel on page 95).
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4. If you are installing a drive in a bay covered by a bezel blank, remove the front bezel then
remove the bezel blank. See Bezel Blanks on page 97 for more information.

5. Install four M3 metric guide screws in the lower holes on each side of the drive. HP has provided
four extra M3 metric guide screws on the front of the chassis, under the front bezel. The M3
metric guide screws are black. Refer to Installing and Removing Drives on page 110 for an
illustration of the extra M3 metric guide screws location.

/A CAUTION: Use only 5-mm long screws as guide screws. Longer screws can damage the
internal components of the drive.

B NOTE: When replacing the drive, transfer the four M3 metric guide screws from the old drive to
the new one.

Figure 6-31 Installing Guide Screws in the Optical Drive

6. Position the guide screws on the drive into the J-slots in the drive bay. Then slide the drive
toward the front of the computer until it locks into place.

Figure 6-32 Installing the Optical Drive
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7. Rotate the drive cage to its upright position.

Figure 6-33 Rotating the Drive Cage Up

8. Connect the SATA data cable to the white system board connector labeled SATA1.

9. Route the data cable through the cable guides.

/A CAUTION: There are two cable guides that keep the data cable from being pinched by the
drive cage when raising or lowering it. One is located on the bottom side of the drive cage. The
other is located on the chassis frame under the drive cage. Ensure that the data cable is routed
through these guides before connecting it to the optical drive.

10. Connect the power cable (1) and data cable (2) to the rear of the optical drive.

Figure 6-34 Connecting the Power and Data Cables
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11. Rotate the drive cage back down to its normal position.

/A CAUTION: Be careful not to pinch any cables or wires when rotating the drive cage down.

Figure 6-35 Rotating the Drive Cage Down

12. Replace the access panel.

13. If the computer was on a stand, replace the stand.

14. Reconnect the power cord and turn on the computer.

15. Lock any security devices that were disengaged when the access panel was removed.

The system automatically recognizes the drive and reconfigures the computer.

Removing an External 3.5-inch Drive

/A CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

The 3.5-inch drive is located underneath the 5.25-inch drive. You must remove the external 5.25-inch
drive before removing the external 3.5-inch drive.

1. Follow the procedure in Removing an External 5.25-inch Drive on page 112 to remove the 5.25-
inch drive and access the 3.5-inch drive.

/A CAUTION: Ensure that the computer is turned off and that the power cord is disconnected
from the electrical outlet before proceeding.
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2. Disconnect the drive cables from the rear of the drive, or, if you are removing a media card
reader, disconnect the USB and 1394 cables from the system board as indicated in the following
illustrations.

EY NOTE: On some models, the media card reader does not include a 1394 port or cable.
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3. Press down on the green drive retainer button located on the left side of the drive to disengage
the drive from the drive cage (1). While pressing the drive retainer button, slide the drive back
until it stops, then lift it up and out of the drive cage (2).

Figure 6-38 Removing a 3.5-inch Drive (Media Card Reader Shown)

B NOTE: To replace the 3.5-inch drive, reverse the removal procedure.

When replacing a 3.5-inch drive, transfer the four guide screws from the old drive to the new one.

Installing a Drive into the 3.5-inch External Drive Bay

The 3.5-inch bay is located underneath the 5.25-inch drive. To install a drive into the 3.5-inch bay:

B NOTE: Install guide screws to ensure the drive will line up correctly in the drive cage and lock in
place. HP has provided extra guide screws for the external drive bays (four 6-32 standard screws and
four M3 metric screws), installed in the front of the chassis, under the front bezel. A secondary hard
drive uses 6-32 standard screws. All other drives (except the primary hard drive) use M3 metric
screws. The HP-supplied M3 metric screws are black and the HP-supplied 6-32 standard screws are
silver. Refer to Installing and Removing Drives on page 110 for illustrations of the guide screw
locations.

1. Follow the procedure in Removing an External 5.25-inch Drive on page 112 to remove the 5.25-
inch drive and access the 3.5-inch drive bay.

/A CAUTION: Ensure that the computer is turned off and that the power cord is disconnected
from the electrical outlet before proceeding.

2. Ifyou are installing a drive in a bay covered by a bezel blank, remove the front bezel then
remove the bezel blank. See Bezel Blanks on page 97 for more information.
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3. Position the guide screws on the drive into the J-slots in the drive bay. Then slide the drive
toward the front of the computer until it locks into place.

Figure 6-39 Installing a Drive into the 3.5-inch Drive Bay (Media Card Reader Shown)

4. Connect the appropriate drive cables:

a. Ifinstalling a second hard drive, connect the power and data cables to the rear of the drive
and connect the other end of the data cable to the next available (unpopulated) SATA
connector on the system board by following the numbered sequence of the connectors.

b. Ifiinstalling a media card reader, connect the USB cable from the media card reader to the
USB connector on the system board labeled MEDIA. If the media card reader includes a
1394 port, connect the 1394 cable to the 1394 PCI card.

B NOTE: Referto System Board Drive Connections on page 111 for an illustration of the
system board drive connectors.

Replace the 5.25-inch drive.
Replace the front bezel and access panel.
If the computer was on a stand, replace the stand.

Reconnect the power cord and turn on the computer.
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Lock any security devices that were disengaged when the access panel was removed.
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Removing and Replacing the Primary 3.5-inch Internal SATA Hard Drive

EY NOTE: The system does not support Parallel ATA (PATA) hard drives.

Before you remove the old hard drive, be sure to back up the data from the old hard drive so that you
can transfer the data to the new hard drive.

The preinstalled 3.5-inch hard drive is located under the power supply. To remove and replace the
hard drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 87).

If the computer is on a stand, remove the computer from the stand.

2
3.  Remove the access panel (Computer Access Panel on page 95).
4. Rotate the drive cage for external drives to its upright position.

Figure 6-40 Rotating the Drive Cage Up
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5. Rotate the power supply to its upright position. The hard drive is located beneath the power
supply.

Figure 6-41 Raising the Power Supply

5

6. Disconnect the power cable (1) and data cable (2) from the back of the hard drive.

Figure 6-42 Disconnecting the Hard Drive Power Cable and Data Cable
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7. Press down on the green release latch next to the hard drive (1). While holding the latch down,
slide the drive forward until it stops, then lift the drive up and out of the bay (2).

Figure 6-43 Removing the Hard Drive

8. Toinstall a hard drive, you must transfer the silver and blue isolation mounting guide screws
from the old hard drive to the new hard drive.

Figure 6-44 Installing Hard Drive Guide Screws
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9. Align the guide screws with the slots on the chassis drive cage, press the hard drive down into
the bay, then slide it back until it stops and locks in place.

Figure 6-45 Installing the Hard Drive

10. Connect the power and data cables to the back of the hard drive.

Ef NOTE: When replacing the primary hard drive, be sure to route the SATA and power cables
through the cable guide on the bottom of the chassis frame behind the hard drive.

If the system has only one SATA hard drive, the data cable must be connected to the dark blue
connector labeled SATAO on the system board to avoid any hard drive performance problems.

11. Rotate the drive cage for external drives and the power supply down to their normal positions.
12. Replace the access panel.

13. If the computer was on a stand, replace the stand.

14. Reconnect the power cord and turn on the computer.

15. Lock any security devices that were disengaged when the access panel was removed.
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Removing and Replacing a Removable 3.5-inch SATA Hard Drive

Some models are equipped with a Removable SATA Hard Drive Enclosure in the 5.25-inch external
drive bay. The hard drive is housed in a carrier that can be quickly and easily removed from the drive
bay. To remove and replace a drive in the carrier:

B NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive.

1. Unlock the hard drive carrier with the key provided and slide the carrier out of the enclosure.
2. Remove the screw from the rear of the carrier (1) and slide the top cover off the carrier (2).

Figure 6-46 Removing the Carrier Cover

3.  Remove the adhesive strip that secures the thermal sensor to the top of the hard drive (1) and
move the thermal sensor away from the carrier (2).

Figure 6-47 Removing the Thermal Sensor
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4. Remove the four screws from the bottom of the hard drive carrier.

Figure 6-48 Removing the Security Screws

5. Slide the hard drive back to disconnect it from the carrier then lift it up and out of the carrier.

Figure 6-49 Removing the Hard Drive
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Place the new hard drive in the carrier then slide the hard drive back so that it seats in the SATA
connector on the carrier's circuit board. Be sure the connector on the hard drive is pressed all

the way into the connector on the carrier's circuit board.

Figure 6-50 Replacing the Hard Drive

7. Replace the four screws in the bottom of the carrier to hold the drive securely in place.

Figure 6-51 Replacing the Security Screws
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8. Place the thermal sensor on top of the hard drive in a position that does not cover the label (1)
and attach the thermal sensor to the top of the hard drive with the adhesive strip (2).

Figure 6-52 Replacing the Thermal Sensor

9. Slide the cover on the carrier (1) and replace the screw on the rear of the carrier to secure the
cover in place (2).

Figure 6-53 Replacing the Carrier Cover

10. Slide the hard drive carrier into the enclosure on the computer and lock it with the key provided.

B NOTE: The carrier must be locked for power to be supplied to the hard drive.
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Baffle

The baffle sits between the front fan and the heat sink.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 87).

2. Remove the access panel (Computer Access Panel on page 95).

3. Lift the baffle straight up out of the chassis.

Figure 6-54 Removing the baffle

To install the baffle, reverse the removal procedure.
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Front Fan Assembly

The front fan assembly is attached to the front of the chassis.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 87).

Remove the access panel (Computer Access Panel on page 95).

2
3.  Remove the front bezel (Front Bezel on page 96).
4

Remove the baffle (Baffle on page 128).

o

Disconnect the fan cable from the red/brown system board connector labeled CHFAN1.

6. Press the two tabs (one of left, one on bottom) that secure the fan assembly to the front of the
chassis.

Figure 6-55 Removing the front fan
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7.  Pull the assembly toward the rear of the unit, and then lift it out of the chassis.

To install the front fan, reverse the removal procedure. Be sure to orient the air flow into the unit.
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Hood Sensor

The hood sensor is attached in a slot in the rear of the chassis.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 87).

Remove the access panel (Computer Access Panel on page 95).

2
3. Unplug the sensor cable from the white system board connected labeled HSENSE.
4

Slide the hood sensor straight out of the notch in the chassis.

Br NOTE: A flat blade screwdriver can be used to push the hood sensor out of the slot.

Figure 6-56 Removing the hood sensor from the chassis fan

To install the hood sensor, reverse the removal procedure.
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Front I/O, Power Switch Assembly

The front 1/0 and power switch/LEDs are one assembly, attached to the front of the chassis. Push the
assembly into the chassis to remove.

1.

2
3.
4

o

Prepare the computer for disassembly (Preparation for Disassembly on page 87).

Remove the access panel (Computer Access Panel on page 95).

Remove the front bezel (Front Bezel on page 96).

Remove the chassis fan (Front Fan Assembly on page 129).

Rotate the drive cage to its upright position.

Disconnect the four cables from the system board as follows:

Yellow connector labeled FRNT USB1
Green connector labeled FRNT USB2
Blue connector labeled FRNT AUD
Black connector labeled PB/LED

Remove the screw that secures the assembly to the front of the chassis.

Figure 6-57 Removing the front I/O, power switch/LED assembly screw
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Route the cables through the slots beneath the drive cage (1), pull the assembly (right side first)
into the chassis (2), and then remove the assembly from the computer.

Figure 6-58 Routing the cables and removing the power switch assembly

To install the front I/0O and power switch assembly, reverse the removal procedure.

Ef NOTE: Be sure to correctly route the cables beneath the drive cage when reinstalling the assembly.
Proper cable routing prevents damage to the cables and allows the drive cage to close properly.

Speaker

The speaker is attached to the front of the chassis under the rotating drive cage.

1.

2
3.
4
5

Prepare the computer for disassembly (Preparation for Disassembly on page 87).

Remove the access panel (Computer Access Panel on page 95).

Remove the front bezel (Front Bezel on page 96).

Rotate the drive cage to its upright position.

Disconnect the speaker wire from the white system board labeled SPKR
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6. Remove the two screws that secure the speaker to the chassis.
Figure 6-59 Removing the speaker
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7.  Lift the speaker from the inside of the chassis to remove it.

To install the speaker, reverse the removal procedures.
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Heat sink

The heat sink is secured atop the processor with four captive Torx screws. The heat sink does not
include a fan.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 87).

Remove the access panel (Computer Access Panel on page 95).

Remove the baffle (Baffle on page 128).

2
3
4. Remove the chassis fan (Front Fan Assembly on page 129).
5

Loosen the four captive screws that secure the heat sink to the system board tray.

/A CAUTION: Heat sink retaining screws should be removed in diagonally opposite pairs (as in
an X) to even the downward forces on the processor. This is especially important as the pins on
the socket are very fragile and any damage to them may require replacing the system board.

6. Lift the heat sink from atop the processor and set it on its side to keep from contaminating the
work area with thermal grease.

Figure 6-60 Removing the heat sink
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When reinstalling the heat sink, make sure that its bottom has been cleaned with an alcohol wipe and
fresh thermal grease has been applied to the top of the processor.

/\ CAUTION: Heat sink retaining screws should be tightened in diagonally opposite pairs (as in an X)

to evenly seat the heat sink on the processor to avoid damage that could require replacing the system
board.

Failure to install the baffle may cause the computer to overheat.
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Processor

1. Prepare the computer for disassembly (Preparation for Disassembly on page 87).

Remove the access panel (Computer Access Panel on page 95).

Remove the fan shroud (Baffle on page 128).

Remove the heat sink (Heat sink on page 134).

Rotate the locking lever to its full open position (1).

Raise and rotate the microprocessor retainer to its fully open position (2).
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Carefully lift the processor from the socket (3).

/A CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

The heat sink must be installed within 24 hours of installing the processor to prevent damage to
the processor’s solder connections.

Figure 6-61 Removing the processor

To install a new processor:
1. Place the processor in its socket and close the retainer.

2. Secure the locking lever. If reusing the existing heat sink, go to step 3. If using a new heat sink,
go to step 6.

3. Ifreusing the existing heat sink, clean the bottom of the heat sink with the alcohol pad provided
in the spares kit.

/\ CAUTION: Before reinstalling the heat sink you must clean the top of the processor and the
bottom of the heat sink with an alcohol pad supplied in the spares kit. After the alcohol has
evaporated, apply thermal grease to the top of the processor from the syringe supplied in the
spares kit.
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4. Apply the thermal grease provided in the spares kit to the top of the processor and install the
heat sink atop the processor.

5. Gotostep?7.

6. If using a new heat sink, remove the protective covering from the bottom of the heat sink and
place it in position atop the processor.

7. Secure the heat sink to the system board and system board tray with the four captive screws
and attach the heat sink control cable to the system board.

/A CAUTION: heat sink retaining screws should be tightened in diagonally opposite pairs (as in
an X) to evenly seat the heat sink on the processor. This is especially important as the pins on
the socket are very fragile and any damage to them may require replacing the system board.

B NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can
be found on the Web at: http://h18000.www1.hp.com/support/files.

Power Supply

A WARNING! To reduce potential safety issues, only the power supply provided with the computer, a
replacement power supply provided by HP, or a power supply purchased as an accessory from HP
should be used with the computer.

The rotating power supply is located at the rear of the chassis. It is held in place by a bracket — no
screws are used.

A WARNING! Voltage is always present on the system board when the computer is plugged into an
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord
should be disconnected from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 87).

Remove the access panel (Computer Access Panel on page 95).

2
3. Rotate the drive cage up and disconnect the power cables from all of the drives.
4

Disconnect the power cables from the system board and drives.

<,

Rotate the power supply to its full upright position.

6. Release the power supply cables from the cable retaining clip under the drive cage.
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7.  Pull the power supply forward until the posts on the power supply move forward in the power
supply bracket, and then lift the power supply straight up and out of the chassis.

Figure 6-62 Removing the power supply
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To install the power supply, reverse the removal procedure.

/A CAUTION: When installing the power supply cables, make sure they are properly positioned so
they are not cut by the drive cage and are not pinched by the rotating power supply.
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System Board

1. Prepare the computer for disassembly (Preparation for Disassembly on page 87).

2. Remove the access panel (Computer Access Panel on page 95).

3. When replacing the system board, make sure the following components are removed from the
defective system board and installed on the replacement system board:

e  Memory modules (seelnstalling Additional Memory on page 98)

e  Expansion cards (Expansion Cards on page 102)

e  Heat sink (Heat sink on page 134)

e  Processor (Processor on page 135)

Remove the baffle from the chassis (Baffle on page 128).

Remove the fan from the chassis (Front Fan Assembly on page 129).

4

5

6. Rotate the drive cage to its upright position.
7. Rotate the power supply to its full upright position.

8. Disconnect all data and power cables from the system board.

9. Disconnect the balance of the cables from the system board.

10. Remove the eight screws that secure the system board to the chassis.

Figure 6-63 Removing the system board
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11. Lift up the front of the system board, and then pull the system board forward, up, and out of the
chassis.

To install the system board, reverse the removal procedure.

Bf NOTE: When replacing the system board, you must also change the chassis serial number in the
BIOS.
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CAUTION: Before reinstalling the heat sink you must clean the top of the processor and the bottom
of the heat sink with an alcohol pad supplied in the spares kit. After the alcohol has evaporated, apply
thermal grease to the top of the processor from the syringe supplied in the spares kit.

CAUTION: When reconnecting the cables it is important that they be positioned so they do not
interfere with the rotation of the drive cage or power supply.

Battery

A

The battery that comes with your computer provides power to the real-time clock and has a lifetime of
about three years. When replacing the battery, use a battery equivalent to the battery originally
installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.

WARNING! This computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 140°F (60°C).

Do not disassembile, crush, puncture, short external contacts, or dispose of in fire or water.
Replace the battery only with the HP spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared. Refer to Computer
Setup (F10) Utility on page 4 for information on backing up the CMOS settings.

NOTE: HP encourages customers to recycle used electronic hardware, HP original print cartridges,
and rechargeable batteries. For more information about recycling programs, go to http://www.hp.com/

recycle.

CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 87).

2. Remove the access panel (Computer Access Panel on page 95).

B NOTE: It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. Depending on the type of battery holder on your system board, complete the following
instructions to replace the battery:
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Type 1 Battery Holder
1.  Lift the battery out of its holder.

Figure 6-64 Removing the battery from a type 1 holder

Slide the replacement battery into position, positive side up.
The battery holder automatically secures the battery in the proper position.
Replace the computer access panel.

Plug in the computer and turn on power to the computer.
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Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to Computer Setup (F10) Utility on page 4.

Type 2 Battery Holder

1. To release the battery from its holder, squeeze the metal clamp that extends above one edge of
the battery. When the battery pops up, lift it out (1).

2. Toinsert the new battery, slide one edge of the replacement battery under the holder’s lip with
the positive side up (2). Push the other edge down until the clamp snaps over the other edge of
the battery.

Figure 6-65 Removing the battery from a type 2 holder
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3. Replace the computer access panel.
4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to Computer Setup (F10) Utility on page 4.

Type 3 Battery Holder
1. Pull back on the clip (1) that holds the battery in place, then remove the battery (2).
2. Insert the new battery and position the clip back in place.

Figure 6-66 Removing the battery from a type 3 holder

a

3. Replace the computer access panel.

4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to Computer Setup (F10) Utility on page 4.
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Using the Small Form Factor Computer in a Tower
Orientation

The Small Form Factor computer can be used in a tower orientation. The HP logo plate on the front
bezel is adjustable for either desktop or tower orientation.

1.  Prepare the computer for disassembly (Preparation for Disassembly on page 87).

2. Orient the computer so that its right side is facing down and place the computer in the optional
stand.

Figure 6-67 Changing from Desktop to Tower Orientation

Br NOTE: To stabilize the computer in a tower orientation, HP recommends the use of the
optional tower stand.

3. Lock any security devices that were disengaged when the access panel was removed.

B NOTE: Ensure atleast 10.2 centimeters (4 inches) of space on all sides of the computer remains
clear and free of obstructions.
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7 Removal and Replacement Procedures
Ultra-Slim Desktop (USDT) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to
verify that all components operate properly.

B NOTE: Not all features listed in this guide are available on all computers.

Preparation for Disassembly

See Ildentifying the Chassis, Routine Care, and Disassembly Preparation on page 21 for initial safety
procedures.

1. Remove/disengage any security devices that prohibit opening the computer (Security Lock
Provisions on page 144).

Close any open software applications.
Exit the operating system.

Remove any compact disc from the computer.
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Turn off the computer and any peripheral devices that are connected to it.

/A CAUTION: Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the
system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be
disconnected before servicing a unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.

& NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

/\ CAUTION: The screws used in the computer are of different thread sizes and lengths; using
the wrong screw in an application may damage the unit.

8. If the PC is mounted in the accessory mounting stand, remove it from the stand.
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Security Lock Provisions

B NOTE: For information on data security features, refer to the Desktop Management Guide and the
HP ProtectTools Security Manager Guide (some models) at http://www.hp.com.

The security locks displayed below and on the following pages can be used to secure the computer.

Installing a Security Lock

HP/Kensington MicroSaver Security Cable Lock

There are two cable lock slots on the rear of the computer. The slot next to the thumbscrew should be

used when there is no port cover. The slot on the far right should be used when a port cover is
installed.

Figure 7-1 Installing a Cable Lock with No Port Cover

Figure 7-2 Installing a Cable with a Port Cover Installed
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Padlock
Figure 7-3 Installing a Padlock

HP Business PC Security Lock
1. Fasten the security cable by looping it around a stationary object.

Figure 7-4 Securing the Cable to a Fixed Object
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2. Thread the keyboard and mouse cables through the lock.

Figure 7-5 Threading the Keyboard and Mouse Cables

3. Screw the lock to the chassis using the screw provided.

Figure 7-6 Attaching the Lock to the Chassis
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4. Insert the plug end of the security cable into the lock (1) and push the button in (2) to engage the
lock. Use the key provided to disengage the lock.

Figure 7-7 Engaging the Lock
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Front Bezel Security

The front bezel can be locked in place by installing a security screw provided by HP. To install the
security screw:

1.  Remove/disengage any security devices that prohibit opening the computer.

2. Remove all removable media, such as compact discs or USB flash drives, from the computer.
3. Turn off the computer properly through the operating system, then turn off any external devices.
4

Disconnect the power cord from the power outlet and disconnect any external devices.

/A CAUTION: Regardless of the power-on state, voltage is always present on the system board
as long as the system is plugged into an active AC outlet. You must disconnect the power cord
to avoid damage to the internal components of the computer.

5. If the computer is on a stand, remove the computer from the stand.
6. Remove the access panel and front bezel.

7. Remove the black screw on the front of the chassis behind the bezel. The screw is located next
to the optical drive and is labeled "BEZEL."

Figure 7-8 Retrieving the Front Bezel Security Screw

8. Replace the front bezel.
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9. Install the security screw through the middle front bezel release tab and into the chassis to
secure the front bezel in place.

Figure 7-9 Installing the Front Bezel Security Screw

10. Replace the access panel.
11. If the computer was on a stand, replace the stand.
12. Reconnect the power cord and turn on the computer.

13. Lock any security devices that were disengaged when the access panel was removed.
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Computer Access Panel

To access internal components, you must remove the access panel:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 143).

2. Loosen the thumbscrew on the rear of the computer (1), slide the access panel toward the front
of the computer, and then lift it off (2).

Figure 7-10 Removing the Computer Access Panel

To install the access panel, reverse the removal procedure.
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Front Bezel

1. Prepare the computer for disassembly (Preparation for Disassembly on page 143).

2. Remove the computer access panel (Computer Access Panel on page 150).

3. Lift up the three tabs on the side of the bezel (1), then rotate the bezel off the chassis (2).

Figure 7-11 Removing the Front Bezel

To install the front bezel, reverse the removal procedure.

Bezel Blank

On some models, there is a bezel blank covering the external drive bay that needs to be removed
before installing a drive. To remove a bezel blank:

1. Remove the computer access panel (Computer Access Panel on page 150).

2. Remove the front bezel (Front Bezel on page 151).
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3. Push the two retaining tabs that hold the bezel blank in place towards the outer right edge of the
bezel (1) and pull the bezel blank inwards to remove it (2).

Figure 7-12 Removing a Bezel Blank
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Installing Additional Memory

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) small outline dual inline memory modules (SODIMMs).

SODIMMs

The memory sockets on the system board can be populated with up to two industry-standard
SODIMMs. These memory sockets are populated with at least one preinstalled SODIMM. To achieve
the maximum memory support, you can populate the system board with up to 8-GB of memory.

DDR3-SDRAM SODIMMs
For proper system operation, the SODIMMs must be:

e industry-standard 204-pin

e unbuffered non-ECC PC3-8500 DDR3-1066 MHz-compliant or PC3-10600 DDR3-1333 MHz-
compliant

e 1.5 volt DDR3-SDRAM SODIMMs
The DDR3-SDRAM SODIMMs must also:

e support CAS latency 7 DDR3 1066 MHz (7-7-7 timing) and CAS latency 9 DDR3 1333 MHz
(9-9-9 timing)

e contain the mandatory Joint Electronic Device Engineering Council (JEDEC) specification
In addition, the computer supports:

e  512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

e single-sided and double-sided SODIMMS

e SODIMMs constructed with x8 and x16 devices; SODIMMs constructed with x4 SDRAM are not
supported

Br NOTE: The system will not operate properly if you install unsupported SODIMMs.
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Populating SODIMM Sockets

There are two SODIMM sockets on the system board, with one socket per channel. The sockets are
labeled XMM1 and XMM3. The XMM1 socket operates in memory channel A. The XMM3 socket
operates in memory channel B.

Figure 7-13 SODIMM Socket Locations

Table 7-1 SODIMM Socket Locations

Item Description Socket Color
1 SODIMM1 socket, Channel A Black
2 SODIMM3 socket, Channel B White

NOTE: A SODIMM must occupy the black XMM1 socket. Otherwise, the
system will display a POST error message indicating that a memory module
must be installed in the black socket.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the SODIMMs are installed.

154 Chapter 7

The system will operate in single channel mode if the SODIMM sockets are populated in one
channel only.

The system will operate in a higher-performing dual channel mode if the memory capacity of the
SODIMM in Channel A is equal to the memory capacity of the SODIMM in Channel B.

The system will operate in flex mode if the memory capacity of the SODIMM in Channel A is not
equal to the memory capacity of the SODIMM in Channel B. In flex mode, the channel populated
with the least amount of memory describes the total amount of memory assigned to dual
channel and the remainder is assigned to single channel. If one channel will have more memory
than the other, the larger amount should be assigned to channel A.

In any mode, the maximum operational speed is determined by the slowest SODIMM in the
system.
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Installing SODIMMs

/A CAUTION: You must disconnect the power cord before adding or removing memory modules.
Regardless of the power-on state, voltage is always supplied to the memory modules as long as the
computer is plugged into an active AC outlet. Adding or removing memory modules while voltage is
present may cause irreparable damage to the memory modules or system board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 143).

2. Remove the access panel (Computer Access Panel on page 150).

3. Locate the memory module sockets on the system board.

A WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system
components to cool before touching.

4. If you are adding a second SODIMM, remove the SODIMM from the top XMM1 socket to access
the bottom XMM3 socket. Press outward on the two latches on each side of the SODIMM (1)
then pull the SODIMM out of the socket (2).

Figure 7-14 Removing a SODIMM
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5. Slide the new SODIMM into the socket at approximately a 30° angle (1) then press the SODIMM
down (2) so that the latches lock it in place.

Figure 7-15 Installing a SODIMM

Br NOTE: A memory module can be installed in only one way. Match the notch on the module
with the tab on the memory socket.

A SODIMM must occupy the XMM1 (top) socket.

Replace the SODIMM in the DIMM1 socket if it was removed.
Replace the access panel.

If the computer was on a stand, replace the stand.

© ® N @

Reconnect the power cord and turn on the computer.

10. Lock any security devices that were disengaged when the computer cover or access panel was
removed.

The computer automatically recognizes the additional memory when you turn on the computer.
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Cable Management

Always follow good cable management practices when working inside the computer.
e  Keep cables away from major heat sources like the heat sink.

e Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

e  Keep cables clear of sliding or moveable parts to prevent their being cut or crimped when the
parts are moved.

e Do not bend any cable sharply. A sharp bend can break the internal wires.
e Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.
e Never crease a SATA data cable.

e Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.

Cable Connections
System board connectors are color-coded to make it easier to find the proper connection.

System Board Connections

System Board Connector Connector Name Connector Color Description

P9 CHFAN1 Maroon Front chassis fan
P11 CHFAN2 Brown Rear chassis fan

P6 SPRK White Internal speaker
P61 SATA1 White Optical data

P125 HSENSE White Hood sensor

P151 BOOST Black ReadyBoost module
P160 N/A Black Optical power

P160 N/A Black Optical power

Replacing the Optical Drive

The Ultra-Slim Desktop uses a slimline Serial ATA (SATA) optical drive.

Removing the Existing Optical Drive

1. Prepare the computer for disassembly (Preparation for Disassembly on page 143).

2. If the computer is on a stand, remove the computer from the stand and lay the computer down.

3.  Remove the computer access panel (Computer Access Panel on page 150).

Cable Management 157



4. Disconnect the cable on the rear of the optical drive (1), push the green release latch on the right
rear side of the drive toward the center of the drive (2), then slide the drive forward and out of

the bay through the front bezel (3).

Figure 7-16 Removing the Optical Drive
i ‘ _—
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Preparing the New Optical Drive
Before the new optical drive can be used, the release latch must be attached.
1. Peel the backing off the adhesive on the release latch.

2.  Without allowing the release latch to touch the optical drive, carefully align the holes on the
release latch with the pins on the side of the optical drive. Make sure the release latch is
oriented properly.

3. Insert the pin at the front of the optical drive into the hole at the end of the release latch, and
press firmly.

4. Insert the second pin, and press the entire release latch firmly to fasten the latch securely to the
optical drive.

Figure 7-17 Aligning the Release Latch
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Installing the New Optical Drive

B NOTE: If you are installing an optical drive in a bay that did not previously have a drive in it, you
must remove the access panel and the bezel blank covering the opening of the bay before
proceeding. Follow the procedures in Computer Access Panel on page 150 and Bezel Blank

on page 151.

1. Attach the release latch to the new optical drive. Refer to Preparing the New Optical Drive
on page 159.

2. With the back of the optical drive facing the computer and the release latch on the inner side of
the drive, align the drive with the opening in the front bezel.

3. Slide the optical drive through the front bezel all the way into the bay so that it locks in place (1),
then connect the cable to the rear of the drive (2).

Figure 7-18 Installing the Optical Drive
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Hard Drive

B NOTE: The Ultra-Slim Desktop supports only 2.5-inch Serial ATA (SATA) internal hard drives;
parallel ATA (PATA) internal hard drives are not supported.

Before you remove the old hard drive, be sure to back up the data from the old hard drive so that you
can transfer the data to the new hard drive.

The 2.5-inch hard drive is enclosed in a carrier under the optical drive.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 143).

If the computer is on a stand, remove the computer from the stand and lay the computer down.

2
3.  Remove the computer access panel (Computer Access Panel on page 150).
4

Remove the optical drive. Refer to Removing the Existing Optical Drive on page 157 for
instructions.

5. Press in the release latch on the left side of the hard drive carrier (1) then rotate the carrier
handle to the right (2).

Figure 7-19 Unlocking the Hard Drive Carrier
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6. Lift the hard drive carrier straight up and out of the chassis.

Figure 7-20 Removing the Hard Drive Carrier

7. Remove the four guide screws from the sides of the hard drive carrier.

Figure 7-21 Removing the Guide Screws

8. Lift the hard drive up to the top of the carrier (1) and slide the drive out of the carrier (2).

Figure 7-22 Removing the Hard Drive from the Carrier
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162 Chapter 7 Removal and Replacement Procedures Ultra-Slim Desktop (USDT) Chassis



9. Position the hard drive so that the top of the hard drive is up against the top of the carrier (1) so
that the circuit board on the bottom of the hard drive does not come in contact wit the tabs on the
bottom of the carrier, then slide the new hard drive into the carrier (2).

/A CAUTION: Do not allow the circuit board on the bottom of the hard drive to scrape along the
tabs on the bottom of the carrier when sliding the hard drive into the carrier. Doing so can cause
irreparable damage to the hard drive.

Figure 7-23 Sliding the Hard Drive into the Carrier
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10. Set the hard drive down into the bottom of the carrier (1), then replace the four guide screws on
the sides of the carrier to secure the drive in the carrier (2).

Figure 7-24 Lowering the Hard Drive and Replacing the Guide Screws
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11. To place the hard drive carrier back in the chassis, align the guide screws with the slots on the
drive bay, drop the carrier straight down into the drive bay (1), and press the handle on the
carrier all the way down (2) so that the drive is properly seated and locked in place.

Figure 7-25 Installing the Hard Drive Carrier

o

12. Replace the optical drive and reconnect the cable on the back of the optical drive.
13. Replace the computer access panel.

14. If the computer was on a stand, replace the stand.

15. Reconnect the power cord and turn on the computer.

16. Lock any security devices that were disengaged when the computer cover or access panel was
removed.

Br NOTE: No configuration of the SATA hard drive is necessary; the computer automatically
recognizes it the next time you turn on the computer.

Hard Drive Cage

The drive cage sits behind the USB ports on the front of the chassis.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 143).

Remove the computer access panel (Computer Access Panel on page 150).

2
3.  Remove the optical drive and connector (Removing the Existing Optical Drive on page 157).
4

Remove the hard drive (Hard Drive on page 161).
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5. Remove the two Torx T15 screws that secure the cage to the chassis (1), lift the tab (2) on the
hard drive cage, slide the cage toward the rear of the unit (3), and then pull the cage up and out
of the chassis.

Figure 7-26 Removing the hard drive cage
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To install the hard drive cage, reverse the removal procedures.
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Port Cover

An optional rear port cover is available for the computer.
To install the port cover:

1. Thread the cables through the bottom hole on the port cover (1) and connect the cables to the
rear ports on the computer.

2. Insert the hooks on the port cover into the slots on the rear of the chassis, then slide the cover to
the right to secure it in place (2).

Figure 7-27 Installing a Port Cover

B NOTE: For security purposes, you can install an optional cable lock to the chassis that locks the
port cover and secures the computer. See Installing a Security Lock on page 144.

The port cover is secured in place by a retention lever just inside the port cover opening. To remove
the port cover, pull the lever back towards the port cover opening (1), then slide the cover to the left
and off the computer (2).

Figure 7-28 Removing a Port Cover
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Front Fan

The front fan sits against the front on the left side of the chassis.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 143).

Remove the computer access panel (Computer Access Panel on page 150).

2
3. Disconnect the fan control cable from the red system board connector labeled CHFAN.
4

Lift the fan straight up and out of the chassis.

Figure 7-29 Removing the front fan

To install the front fan, reverse the removal procedure.
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Card Reader

The card reader is secured to the front right corner of the chassis.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 143).

Remove the computer access panel (Computer Access Panel on page 150).

2
3. Remove the front bezel (Front Bezel on page 151).
4. Disconnect the cable from the black system board connector labeled MEDIA.

5. On the outside of the chassis, remove the one torx T15 screw that secures the card reader to
the chassis.

Flgure 7-30 Removmg the card reader

6. Pull the reader away from the front of the chassis while threading the cable through the slot in
the front of the chassis.

To install the card reader, reverse the removal procedure.
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Speaker

The speaker is secured to the front of the chassis between the fan and the 1/O ports.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 143).

Remove the computer access panel (Computer Access Panel on page 150).

Remove the front bezel (Front Bezel on page 151).

2
3
4. Disconnect the speaker cable from the white system board connector labeled SPKR.
5

On the outside of the chassis, remove the two torx T8 screws that secure the speaker to the
chassis, and then from the inside of the chassis, slide the speaker up to remove it.

Figure 7-31 Removing the speaker

To install the speaker, reverse the removal procedure.
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Heat sink

The heat sink is secured by four Torx T15 screws. It does not have an attached fan.

1.
2,

5.

Prepare the computer for disassembly (Preparation for Disassembly on page 143).

Remove the computer access panel (Computer Access Panel on page 150).

Lift the front fan up and place it on top of the optical drive to access the front bezel release tabs.
You do not need to disconnect the fan cable from the system board.

Loosen the four Torx T15 screws that secure the heat sink to the system board, and then lift the
heat sink from the system board.

Figure 7-32 Removmg the heat sink
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/A CAUTION: Heat smk retalmng screws should be removed in dlagonally opposite pairs (as in
an X) to even the downward forces on the processor to avoid damage that could require
replacing the system board.

Lay the heat sink on its top in a safe area to prevent the thermal grease from contaminating the
work surface.

If reusing the existing heat sink go to step 1.

If using a new heat sink, go to step 3.

1.

If reusing the existing heat sink, clean bottom of the heat sink and apply the thermal grease
provided in the spares kit to the top of the processor.

Position the heat sink atop the processor.

If using a new heat sink, remove the protective covering from the bottom of the heat sink and
place it in position atop the processor.

Secure the heat sink to the system board and system board tray with the 4 captive screws and
attach the heat sink control cable and the thermal sensor cable to the system board.
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/A CAUTION: Heat sink retaining screws should be tightened in diagonally opposite pairs (as in
an X) to evenly seat the heat sink on the processor. This is especially important as the pins on
the socket are very fragile and any damage to them may require replacing the system board.

Processor

1. Prepare the computer for disassembly (Preparation for Disassembly on page 143).

Remove the computer access panel (Computer Access Panel on page 150).

Remove the heat sink (Heat sink on page 170).

Rotate the processor locking lever to its full open position (1).

Raise and rotate the microprocessor retainer to its fully open position (2).
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Carefully lift the processor from the socket (3).

/A CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

The heat sink must be installed within 24 hours of installing the processor to prevent damage to
the processor’s solder connections.

Figure 7-33 Removing the processor

To install a new processor:
1. Place the processor in its socket and close the retainer.
2. Secure the locking lever.

If reusing the existing heat sink, go to step 3.

If using a new heat sink, go to step 5.

3. Ifreusing the existing heat sink, clean bottom of the heat sink and apply the thermal grease
provided in the spares kit to the top of the processor.

Processor 171



4. Position the heat sink atop the processor.

5. If using a new heat sink, remove the protective covering from the bottom of the heat sink and
place it in position atop the processor.

6. Secure the heat sink to the system board and system board tray with the 4 captive screws and
attach the heat sink control cable to the system board.

/A CAUTION: Heat sink retaining screws should be tightened in diagonally opposite pairs (as in
an X) to evenly seat the heat sink on the processor. This is especially important as the pins on
the socket are very fragile and any damage to them may require replacing the system board.

B NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can
be found on the Web at: http://h18000.www1.hp.com/support/files.
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TV Tuner Module

Prepare the computer for disassembly (Preparation for Disassembly on page 143).

-

Remove the computer access panel (Computer Access Panel on page 150).

Remove the optical drive (Removing the Existing Optical Drive on page 157).

Remove the hard drive (Hard Drive on page 161).

Remove the hard drive cage (Hard Drive Cage on page 164).

Remove the heat sink (Heat sink on page 170).

Disconnect the antenna cable from the connector on the TV tuner module.

Remove the two Torx T5 screws that secure the TV tuner module to the system board.
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Lift the card to a 45 degree angle, and then remove the module from the connector by pulling it
away at an angle.

Figure 7-34 Removing the TV tuner module
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To install the TV tuner module, reverse the removal procedure. Make sure the antenna cable is
correctly routed over the speaker and in the clips mounted on the inside chassis wall.

System Board

/A CAUTION: Be very careful when removing or replacing the system board to prevent damaging it.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 143).

2. Remove the computer access panel (Computer Access Panel on page 150).

3. Remove the optical drive (Removing the Existing Optical Drive on page 157).
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Remove the memory modules (Installing Additional Memory on page 153).

Remove the front fan (Front Fan on page 167).

Remove the hard drive (Hard Drive on page 161).

Remove the hard drive cage (Hard Drive Cage on page 164).
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Remove the front I/O panel cage:

a. Remove the screw from the right side of the cage that secures the 1/O panel cage to the
front of the chassis (1).

b. Press the tab on right side of the cage (2), and then swing the right side of the cage away
from the chassis to remove it (3).

Br NOTE: If the cage sticks and will not come loose, press down on the top of the panel near
the tab while pressing the tab.

9. Remove the heat sink (Heat sink on page 170).

10. Disconnect all cables connected to the system board, noting their location for reinstallation.
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11. Remove the three remaining screws that secure the system board to the chassis.

Figure 7-36 Removing the system board

12. Slide system board toward the front of the unit until the rear connectors are clear of their slots in
the chassis.

13. Lift the rear of the system board until it clears the chassis, and then remove the system board
from the chassis.

To install the system board, reverse the removal procedure.

B NOTE: When replacing the system board, you must also change the chassis serial number in the
BIOS.

Rear Fan

The rear fan is secured to the rear right corner of the chassis. You must remove the system board
before you can remove the rear fan.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 143).

Remove the computer access panel (Computer Access Panel on page 150).

2
3.  Remove the system board (TV Tuner Module on page 173).
4

Disconnect the fan control cable from the red/brown system board connector labeled CHFAN2.
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From the outside of the chassis, remove the four Phillips screws that secure the fan to the
chassis, then from the inside of the chassis, slide the fan forward and lift it up and out of the
chassis.

Figure 7-37 Removing the rear fan

To install the rear fan, reverse the removal procedure.

Hood Sensor

1.

2
3.
4

Prepare the computer for disassembly (Preparation for Disassembly on page 143).

Remove the computer access panel (Computer Access Panel on page 150).

Remove the optical drive (Removing the Existing Optical Drive on page 157).

Unplug the hood sensor cable from the white system board connector labeled HSENSE and
remove the cable from the white clip mounted on the inside chassis wall.

Slide the hood sensor into the chassis to remove it from its slot.

Figure 7-38 Removing the hood sensor
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To install the hood sensor, reverse the removal procedures.
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Battery

The battery that comes with your computer provides power to the real-time clock and has a lifetime of
about three years. When replacing the battery, use a battery equivalent to the battery originally
installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

Br NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.

A WARNING! This computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 140°F (60°C).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.
Replace the battery only with the HP spare designated for this product.

/A CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared. Refer to Computer
Setup (F10) Utility on page 4 for information on backing up the CMOS settings.

B NOTE: HP encourages customers to recycle used electronic hardware, HP original print cartridges,
and rechargeable batteries. For more information about recycling programs, go to http://www.hp.com/

recycle.

/A CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 143).

Remove the computer access panel (Computer Access Panel on page 150).

2
3. Pull back on the clip(1) that holds the battery in place, then remove the battery (2).
4. Insert the new battery and position the clip back in place.

Figure 7-39 Removing the battery

a

5. After the battery has been replaced, reverse the disassembly procedure.

6. Plug in the computer and turn on power to the computer.

7. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to the Computer Setup (F10) Utility Guide.
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Changing from Desktop to Tower Configuration

1. Prepare the computer for disassembly (Preparation for Disassembly on page 143).

2. Place the computer firmly down into the stand.

Figure 7-40 Placing the Computer on the Stand

1§

3. Reconnect the external equipment, plug the power cord into a power outlet, and turn the
computer on.

4. Lock any security devices that were disengaged when the computer cover or access panel was
removed.

To change from the tower configuration to the desktop configuration, reverse the previous steps.

Ef NOTE: An optional Quick Release mounting bracket is available from HP for mounting the computer
to a wall, desk, or swing arm.
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Power Supply, External

The USDT chassis uses an external power supply.

A WARNING! To reduce potential safety issues, only the power supply provided with the computer, a
replacement power supply provided by HP, or a power supply purchased as an accessory from HP
should be used with the computer.
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A Connector Pin Assignments

This appendix contains the pin assignments for many computer and workstation connectors. Some of
these connectors may not be used on the product being serviced.

Keyboard

Connector and Icon Pin Signal
1 Data
2 Unused
[af 18] ooooooo 3 Ground
O =068 ooooooa
] = | me— = | 4 +5VDC
5 Clock
6 Unused
Mouse
Connector and Icon Pin Signal
1 Data
2 Unused
EE!;EE A 3 Ground
(B]u] 4 +5VDC
5 Clock
6 Unused

Ethernet BNC

Connector and Icon Pin Signal

1 Data

" % 2 Ground
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Ethernet RJ-45

Connector and Icon Pin Signal
1 (+) Transmit Data
2 (-) Transmit Data
3 (+) Receive Data
@ @ 4 Unused
G ‘ﬁ‘ 5 Unused
6 (-) Receive Data
7 Unused
8 Unused

Serial Interface, Powered and Non-Powered

USB

Connector and Icon Pin Signal
1 Carrier Detect (12V if powered)
2 Receive Data
3 Transmit Data
Data Terminal Ready
Il O Il O Il 5 Signal Ground
6 Data Set Ready
7 Request to Send
8 Clear to Send
9 Ring Indicator (5V if powered)
Connector and Icon Pin Signal
1 +5VDC
ﬁ /"%’ % 2 - Data
e 3 + Data
4 Ground

Ethernet RJ-45
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Microphone

Headphone

Connector and Icon (1/8” miniphone) Pin Signal
1 (Tip) Audio_left
123
&nﬁﬂﬂ:ﬂ: UOU 2 (Ring) Power_Right
3 (Shield) Audio_right
Connector and Icon (1/8” miniphone) Pin Signal
1 (Tip) Audio_left
123
&lﬁfﬂ]:[]: << )) 2 (Ring) Power_Right
3 (Shield) Ground
Line-in Audio
Connector and Icon (1/8” miniphone) Pin Signal
1 (Tip) Audio_In_Left
123
q&.ﬁﬂﬂ:[]: . 2 (Ring) Audio_In_Right
3 (Shield) Ground
Line-out Audio
Connector and Icon (1/8” miniphone) Pin Signal
1 (Tip) Audio_Out_Left
123
@.ﬁ.ﬂﬂ:ﬂ: = 2 (Ring) Audio_Out_Right
3 (Shield) Ground
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Monitor

Connector and Icon

Pin Signal Pin Signal
1 Red Analog 9 +5V (fused)
2 Green Analog 10 Ground
3 Blue Analog 11 Not used
4 Not used 12 DDC Serial Data
5 Ground 13 Horizontal Sync
6 Ground 14 Vertical Sync
7 Ground 15 DDC Serial Clock
8 Ground
DisplayPort
Connector and Icon
ik w Fimcs
(e
TOP ROW BOTTOM ROW
Pin Signal Type Pin Name Pin Signal Type Pin Name
1 Ground GND 2 In Hot Plug Detect
3 Out ML Lane 0 (p) 4 CONFIG CONFIG 1
5 Out ML Lane 0 (n) 6 CONFIG CONFIG 2
7 Ground GND 8 GND GND
9 Out ML Lane 1 (p) 10 Out ML Lane 3 (p)
Ground
11 Out ML Lane 1 (n) 12 Out ML Lane 3 (n)
13 Ground GND 14 GND GND
15 Out ML Lane 2 (p) 16 1/0 AUX CH (p)
17 Out ML Lane 2 (n) 18 110 AUX CH (n)
19 Ground GND 20 PWR Out DP_PWR
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4-Pin Power (for CPU)

Connector and Icon Pin Signal
43 1 GND
—
o{EEho 2 e
@E 3 +12V CPU
2 1 4 -12V CPU
6-Pin Power (for CPU) (CMT, SFF)
Connector and Icon Pin Signal
1 GND
1 3 2 GND
[=](™)(™) 3 GND
O: @EE 4 12V CPU
4 =6
5 12V CPU
6 +12V
SATA Data and Power
Drive Connector
S1 S7 P1 P15
L T CE
Pin Signal Pin Signal Pin Signal Pin Signal
S1 Ground S2 A+ S3 A- S4 Ground
S5 B- S6 B+ S7 Ground
P1 Ground P2 V3.3 P3 V3.3 P4 Ground
P5 B- P6 Ground P7 V5 P8 V5
P9 V5 P10  Ground P11 Reserved P12 Ground
P13 V12 P14 V12 P15 V12

S = Data, P = Power
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PCI Express

x1, x4, x8, and x16 PCI Express Connector

~

A18
g

0000000000 000000
[rrrerrrrer v

A0000000000 0BO0A0

IV [ N | N N

N

B1 B18

Pin A

Pin Signal Pin Signal Pin Signal Pin  Signal Pin Signal
1 PRSNT1 6 JTAG3 11  PERST# 16  PERpO 21 PERp1
2 +12V 7 JTAG4 12 GND 17  PERnO 22  PERnN1
3 +12V 8 JTAG5 13  REFCLK+ 18 GND 23 GND

4 GND 9 +3.3V 14  REFCLK- 19 RSVD 24 GND

5 JTAG2 10 +3.3V 15 GND 20 GND 25 PERp2
26  PERn(2) 31  GND 36 PERn4 41 GND 46 GND
27 GND 32 RSVD 37 GND 42 GND 47  PERp7
28 GND 33 RSVD 38 GND 43  PERp6 48 PERn7
29 PERp3 34 GND 39 PERp5 44  PERn6 49 GND
30 PERn3 35 PERp4 40 PERn5 45 GND 50 RSVD
51 GND 56  PERp9 61 PERn10 66 GND 71 GND
52  PERp8 57 PERn9 62 GND 67 GND 72  PERp13
53 PERNS8 58 GND 63 GND 68 PERp12 73 PERn13
54 GND 59 GND 64 PERp11 69 PERn12 74 GND
55 GND 60 PERp10 65 PERNn11 70 GND 75 GND
76  PERp14 81 PERn15

77 PERn14 82 GND

78 GND

79 GND

80 PERp15

NOTE: x1 PCI Express uses pins 1-18

x4 PCI Express uses pins 1-32

x8 PCI Express uses pins 1-49

x16 PCI Express uses pins 1-8
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PCI Express

x1, x4, x8, and x16 PCI Express Connector

A1

Imm“wwmmmﬂ
t'H-ltj|l|l'lt]t1'1a-'1'1'ltllllkkllli-ltlllllvltl'l'l'l-J-J|1'1-(-1'llltltltllli.-ltlllll-ltlll'bltllj|l'ltM'1'lt1-J|l-l-.'-l-J|l'l-J'I-|-l-|tI|I|I-MtJ|I
) S — — — — — — — — — — — — — - "

AB2

B1 B82
Pin B
Pin Signal Pin Signal Pin Signal Pin Signal Pin Signal
1 +12V 6 SMDAT 11 WAKE# 16 GND 21  GND
2 +12V 7 GND 12 RSVD 17 GND 22 GND
3 RSVD 8 +3.3V 13  GND 18 GND 23  PETp2
4 GND 9 JTAG1 14  PETpO 19  PETp1 24  PETn2
5 SMCLK 10  3.3vAux 15  PETnO 20 PETn1 25 GND
26 GND 31  PRSNT2# 36 GND 41  PETp6 46  PETn7
27  PETp3 32 GND 37 PETp5 42  PRTn6 47 GND
28 PETn3 33 PETp4 38 PETn5 43 GND 48  PRSNT2#
29 GND 34 PETn4 39 GND 44  GND 49 GND
30 RSVD 35 GND 40 GND 45  PETp7 50 PETp8
51 PETn8 56 GND 61 GND 66 PETp12 71 PETn13
52 GND 57 GND 62 PETp11 67 PETn12 72 GND
53 GND 58 PETp10 63 PETn11 68 GND 73 GND
54  PETp9 59  PETn10 64 GND 69 GND 74  PETp14
55  PETn9 60 GND 65 GND 70 PETp13 75 PETn14
76  GND 81  PRSNT2#
77 GND 82 RSVD
78 PETp15
79 PETn15
80 GND
NOTE: x1 PCI Express uses pins 1-18

x4 PCI Express uses pins 1-32
x8 PCI Express uses pins 1-49

x16 PCI Express uses pins 1-8
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B Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch
feature on the computer permits it to operate from any line voltage between 100-120 or 220-240 volts
AC. Power supplies on those computers that do not have external power switches are equipped with
internal switches that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where
you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use
the computer.

General Requirements

The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for
evaluation in the country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a
nominal voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm, or 18AWG, and the length of the cord
must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed
upon it or against it. Particular attention should be paid to the plug, electrical outlet, and the point
where the cord exits from the product.

A WARNING! Do not operate this product with a damaged power cord set. If the power cord set is
damaged in any manner, replace it immediately.

Japanese Power Cord Requirements

For use in Japan, use only the power cord received with this product.

/A CAUTION: Do not use the power cord received with this product on any other products.
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Country-Specific Requirements

Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency Country Accrediting Agency
Australia (1) EANSW Italy (1) IMQ

Austria (1) OVE Japan (3) METI

Belgium (1) CEBC Norway (1) NEMKO

Canada (2) CSA Sweden (1) SEMKO

Denmark (1) DEMKO Switzerland (1) SEV

Finland (1) SETI United Kingdom (1) BSI

France (1) UTE United States (2) UL

Germany (1) VDE

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm, conductor size. Power cord set fittings (appliance

coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it
will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm, conductor size. Wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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POST Error Messages

This appendix lists the error codes, error messages, and the various indicator light and audible
sequences that you may encounter during Power-On Self-Test (POST) or computer restart, the
probable source of the problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count
and non-error text messages. If a POST error occurs, the screen will display the error message. To
manually switch to the POST Messages Enabled mode during POST, press any key (except F10,
F11, or F12). The default mode is POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.

Quick Boot is a fast startup process that does not run all of the system level tests, such as the
memory test. Full Boot runs all of the ROM-based system tests and takes longer to complete.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish
the schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.

B NOTE: For more information on Computer Setup, see the Computer Setup (F10) Utility Guide.
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POST Numeric Codes and Text Messages

This section covers those POST errors that have numeric codes associated with them. The section
also includes some text messages that may be encountered during POST.

B NOTE: The computer will beep once after a POST text message is displayed on the screen.

Table C-1 Numeric Codes and Text Messages

Control panel message Description

Recommended action

101-Option ROM Checksum Error System ROM or expansion board option
ROM checksum.

1. Verify the correct ROM.
2. Flash the ROM if needed.

3. If an expansion board was recently
added, remove it to see if the problem
remains.

4. Clear CMOS. (See Appendix B,
Password Security and Resetting
CMOS on page 243.)

5.  If the message disappears, there may
be a problem with the expansion card.

6. Replace the system board.

103-System Board Failure DMA or timers.

1. Clear CMOS. (See Appendix B,
Password Security and Resetting

CMOS on page 243.)

2. Remove expansion boards.

3. Replace the system board.

110-Out of Memory Space for Option ROMs Recently added PCI expansion card
contains an option ROM too large to
download during POST.

1. Ifa PCl expansion card was recently
added, remove it to see if the problem
remains.

2. In Computer Setup, set Advanced >
Device Options > NIC PXE Option
ROM Download to DISABLE to
prevent PXE option ROM for the
internal NIC from being downloaded
during POST to free more memory for
an expansion card's option ROM.
Internal PXE option ROM is used for
booting from the NIC to a PXE server.

162-System Options Not Set Configuration incorrect.

RTC (real-time clock) battery may need to
be replaced.

Run Computer Setup and check the
configuration in Advanced > Onboard
Devices.

Reset the date and time under Control
Panel. If the problem persists, replace the
RTC battery. See the Hardware Reference
Guide for instructions on installing a new
battery, or contact an authorized dealer or
reseller for RTC battery replacement.
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

163-Time & Date Not Set

Invalid time or date in configuration
memory.

RTC (real-time clock) battery may need to
be replaced.

Reset the date and time under Control
Panel (Computer Setup can also be used).
If the problem persists, replace the RTC
battery. See the Hardware Reference Guide
for instructions on installing a new battery,
or contact an authorized dealer or reseller
for RTC battery replacement.

163-Time & Date Not Set

CMOS jumper may not be properly
installed.

Check for proper placement of the CMOS
jumper if applicable.

164-MemorySize Error

Memory amount has changed since the last
boot (memory added or removed).

Press the F1 key to save the memory
changes.

164-MemorySize Error

Memory configuration incorrect.

1. Run Computer Setup or Windows
utilities.

2. Make sure the memory module(s) are
installed properly.

3.  If third-party memory has been added,
test using HP-only memory.

4.  Verify proper memory module type.

201-Memory Error

RAM failure.

1. Ensure memory modules are correctly
installed.

2. Verify proper memory module type.

3.  Remove and replace the identified
faulty memory module(s).

4. If the error persists after replacing
memory modules, replace the system
board.

213-Incompatible Memory Module in
Memory Socket(s) X, X, ...

A memory module in memory socket
identified in the error message is missing
critical SPD information, or is incompatible
with the chipset.

1. Verify proper memory module type.
2. Try another memory socket.

3. Replace DIMM with a module
conforming to the SPD standard.

214-DIMM Configuration Warning

Populated DIMM Configuration is not
optimized.

Rearrange the DIMMs so that each channel
has the same amount of memory.

219-ECC Memory Module Detected ECC
Modules not supported on this Platform

Recently added memory module(s) support
ECC memory error correction.

1.  If additional memory was recently
added, remove it to see if the problem
remains.

2. Check product documentation for
memory support information.

301-Keyboard Error

Keyboard failure.

1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3.  Ensure that none of the keys are
depressed.

4. Replace keyboard.
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

303-Keyboard Controller Error

I/O board keyboard controller.

1. Reconnect keyboard with computer
turned off.

2. Replace the system board.

304-Keyboard or System Unit Error

Keyboard failure.

1. Reconnect the keyboard with computer
turned off.

2. Ensure that none of the keys are
depressed.

3. Replace the keyboard.

4. Replace the system board.

501-Display Adapter Failure

Graphics display controller.

1. Reseat the graphics card
(if applicable).

2. Clear CMOS. (See Appendix B,
Password Security and Resetting

CMOS on page 243.)

3. Verify monitor is attached and turned
on.

4. Replace the graphics card (if possible).

510-Flash Screen Image Corrupted

Flash Screen image has errors.

Reflash the system ROM with the latest
BIOS image.

511-CPU, CPUA, or CPUB Fan not
Detected

CPU fan is not connected or may have
malfunctioned.

1. Reseat CPU fan.
2. Reseat fan cable.

3. Replace CPU fan.

512-Chassis, Rear Chassis, or Front
Chassis Fan not Detected

Chassis, rear chassis, or front chassis fan is
not connected or may have malfunctioned.

1. Reseat chassis, rear chassis, or front
chassis fan.

2. Reseat fan cable.

3. Replace chassis, rear chassis, or front
chassis fan.

514-CPU or Chassis Fan not Detected

CPU or chassis fan is not connected or may
have malfunctioned.

1.  Reseat CPU or chassis fan.
2. Reseat fan cable.

3. Replace CPU or chassis fan.

660-Display cache is detected unreliable

Integrated graphics controller display cache
is not working properly and will be disabled.

Replace system board if minimal graphics
degrading is an issue.

912-Computer Cover Has Been Removed
Since Last System Startup

Computer cover was removed since last
system startup.

No action required.

917-Front Audio Not Connected

Front audio harness has been detached or
unseated from motherboard.

Reconnect or replace front audio harness.

918-Front USB Not Connected

Front USB harness has been detached or
unseated from motherboard.

Reconnect or replace front USB harness.

921-Device in PCI Express slot failed to
initialize

There is an incompatibility/problem with this
device and the system or PCI Express Link
could not be retrained to an x1.

Try rebooting the system. If the error
reoccurs, the device may not work with this
system
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

1151-Serial Port A Address Conflict
Detected

Both external and internal serial ports are
assigned to COM1.

1. Remove any serial port expansion
cards.

2. Clear CMOS. (See Appendix B,
Password Security and Resetting

CMOS on page 243.)

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1152-Serial Port B Address Conflict
Detected

Both external and internal serial ports are
assigned to COM2.

1. Remove any serial port expansion
cards.

2. Clear CMOS. (See Appendix B,
Password Security and Resetting

CMOS on page 243.)

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1155-Serial Port Address Conflict Detected

Both external and internal serial ports are
assigned to same IRQ.

1. Remove any serial port expansion
cards.

2. Clear CMOS. (See Appendix B,
Password Security and Resetting

CMOS on page 243.)

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive is about to fail. (Some hard
drives have a hard drive firmware patch that
will fix an erroneous error message.)

1. Determine if hard drive is giving correct
error message. Enter Computer Setup
and run the Drive Protection System
test under Storage > DPS Self-test.

2. Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3. Back up contents and replace hard
drive.

1796-SATA Cabling Error

One or more SATA devices are improperly
attached. For optimal performance, the
SATA 0 and SATA 1 connectors must be
used before SATA 2 and SATA 3.

Ensure SATA connectors are used in
ascending order. For one device, use SATA
0. For two devices, use SATA 0 and SATA
1. For three devices, use SATA 0, SATA 1,
and SATA 2.

1801-Microcode Patch Error

Processor is not supported by ROM BIOS.

1. Upgrade BIOS to proper version.

2. Change the processor.
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

2200-PMM Allocation Error during MEBXx
Download

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1.  Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.  If the memory configuration was
recently changed, unplug the
computer, restore the original memory
configuration, and reboot the
computer.

4. If the error persists, replace the system
board.

2201-MEBx Module did not checksum
correctly

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.  If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the
computer.

4. If the error persists, replace the system
board.

2202-PMM Deallocation Error during MEBx
cleanup

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.  If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the
computer.

4. If the error persists, replace the system
board.

2203-Setup error during MEBx execution

MEBX selection or exit resulted in a setup
failure.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.  If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the
computer.

4. If the error persists, replace the system
board.
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

2204-Inventory error during MEBXx execution

BIOS information passed to the MEBx
resulted in a failure.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version.

3. If the error still persists, replace the
system board.

2205-Interface error during MEBXx execution

MEBXx operation experienced a hardware

error during communication with ME.

1. Reboot the computer.

2. If the error persists, update to the latest
BIOS version.

3. If the error still persists, replace the
system board.

2211-Memory not configured correctly for
proper MEBx execution.

DIMM1 is not installed.

Make sure there is a memory module in the
black DIMM1 socket and that it is properly
seated.

Invalid Electronic Serial Number

Electronic serial number is missing.

Enter the correct serial number in Computer
Setup.

Network Server Mode Active and No
Keyboard Attached

Keyboard failure while Network Server
Mode enabled.

1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3.  Ensure that none of the keys are
depressed.

4. Replace keyboard.

Parity Check 2

Parity RAM failure.

Run Computer Setup and Diagnostic
utilities.
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Interpreting POST Diagnostic Front Panel LEDs and

Audible Codes

This section covers the front panel LED codes as well as the audible codes that may occur before or
during POST that do not necessarily have an error code or text message associated with them.

/A WARNING!

When the computer is plugged into an AC power source, voltage is always applied to

the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to

cool before touching.

= NOTE:

If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of

the computer and refer to the following table to determine the front panel LED codes.

Recommended actions in the following table are listed in the order in which they should be

performed.

Not all diagnostic lights and audible codes are available on all models.

Table C-2 Diagnostic Front Panel LEDs and Audible Codes

Activity Beeps Possible Cause Recommended Action
Green Power LED On. None Computer on. None
Green Power LED flashes None Computer in Suspend to None required. Press any key or move the
every two seconds. RAM mode (some models mouse to wake the computer.
only) or normal Suspend
mode.
Red Power LED flashes two 2 Processor thermal 1. Ensure that the computer air vents are not
times, once every second, protection activated: blocked and the processor cooling fan is
followed by a two second running.
pause. Beeps stop after fifth A fan may be blocked or
iteration but LEDs continue not turning. 2. Open hood, press power button, and see if
until problem is solved. the processor fan spins. If the processor fan
OR is not spinning, make sure the fan's cable is
plugged onto the system board header.
The heat sink/fan
assembly is not properly 3. If fan is plugged in, but is not spinning, then
attached to the processor. replace heat sink/fan assembly.
4. Contact an authorized reseller or service
provider.
Red Power LED flashes three 3 Processor not installed 1. Check to see that the processor is present.

times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

(not an indicator of bad
processor).

2. Reseat the processor.
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Table C-2 Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause Recommended Action
Red Power LED flashes four 4 Power failure (power 1. Open the hood and ensure the 4 or 6-wire
times, once every second, supply is overloaded). power supply cable is seated into the
followed by a two second connector on the system board.
pause. Beeps stop after fifth OR
iteration but LEDs continue 2. Check if a device is causing the problem by
until problem is solved. The incorrect external removing ALL attached devices (such as
power supply adapter is hard, diskette, or optical drives, and
being used on the USDT. expansion cards). Power on the system. If
the system enters the POST, then power off
and replace one device at a time and
repeat this procedure until failure occurs.
Replace the device that is causing the
failure. Continue adding devices one at a
time to ensure all devices are functioning
properly.
3. Replace the power supply.
4. Replace the system board.
OR
The USDT power supply adapter must be at
135W and use the Smart ID technology before
the system will power up. Replace the power
supply adapter with the HP-supplied USDT
power supply adapter.
Red Power LED flashes five 5 Pre-video memory error. CAUTION: To avoid damage to the DIMMs or
times, once every second, the system board, you must unplug the computer
followed by a two second power cord before attempting to reseat, install, or
pause. Beeps stop after fifth remove a DIMM module.
iteration but LEDs continue
until problem is solved. 1. Reseat DIMMs.
2. Replace DIMMs one at a time to isolate the
faulty module.
3. Replace third-party memory with HP
memory.
4. Replace the system board.
Red Power LED flashes six 6 Pre-video graphics error.  For systems with a graphics card:
times, once every second,
followed by a two second 1. Reseat the graphics card.
pause. Beeps stop after fifth _
iteration but LEDs continue 2. Replace the graphics card.
until problem is solved.
3. Replace the system board.
For systems with integrated graphics, replace
the system board.
Red Power LED flashes 7 System board failure Replace the system board.

seven times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but LEDs
continue until problem is
solved.

(ROM detected failure
prior to video).
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Table C-2 Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause Recommended Action

Red Power LED flashes eight 8 Invalid ROM based on 1. Reflash the system ROM with the latest
times, once every second, bad checksum. BIOS image. See the “Boot Block

followed by a two second Emergency Recovery Mode” section of the
pause. Beeps stop after fifth Desktop Management Guide for more
iteration but LEDs continue information.

until problem is solved.

2. Replace the system board.

Red Power LED flashes nine 9 System powers on but is 1. Check that the voltage selector, located on
times, once every second, unable to boot. the rear of the power supply (some
followed by a two second models), is set to the appropriate voltage.
pause. Beeps stop after fifth Proper voltage setting depends on your
iteration but LEDs continue region.

until problem is solved.

2. Unplug the AC power cord from the
computer, wait 30 seconds, then plug the
power cord back in to the computer.

3. Replace the system board.

4. Replace the processor.

Red Power LED flashes ten 10 Bad option card. 1. Check each option card by removing the

times, once every second, card (one at a time if multiple cards), then

followed by a two second power on the system to see if fault goes

pause. Beeps stop after fifth away.

iteration but LEDs continue

until problem is solved. 2. Once a bad card is identified, remove and
replace the bad option card.

3. Replace the system board.
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Table C-2 Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause Recommended Action

Red Power LED flashes 11 The current processor 1. Install a TXT capable processor.

eleven times, once every does not support a

second, followed by a two feature previously 2. Disable TXT in the Computer Setup (F10)

second pause. Beeps stop enabled on this system. utility.

after fifth iteration but LEDs

continue until problem is 3. Reinstall the original processor.

solved.

System does not power on None System unable to power Press and hold the power button for less than 4

and LEDs are not flashing. on. seconds. If the hard drive LED turns green, the
power button is working correctly. Try the
following:

1. Check that the voltage selector (some
models), located on the rear of the power
supply, is set to the appropriate voltage.
Proper voltage setting depends on your
region.

2. Replace the system board.
OR

Press and hold the power button for less than 4
seconds. If the hard drive LED does not turn on
green then:

1. Check that the unit is plugged into a
working AC outlet.

2.  Open hood and check that the power button
harness is properly connected to the
system board.

3. Check that both power supply cables are
properly connected to the system board.

4. Check to see if the 5V_aux light on the
system board is turned on. If it is turned on,
then replace the power button harness. If
the problem persists, replace the system
board.

5.  If the 5V_aux light on the system board is
not turned on, remove the expansion cards
one at a time until the 5V_aux light on the
system board turns on. It the problem
persists, replace the power supply.

Interpreting POST Diagnostic Front Panel LEDs and Audible Codes 199



D Troubleshooting Without Diagnostics

This chapter provides information on how to identify and correct minor problems, such as diskette
drive, hard drive, optical drive, graphics, audio, memory, and software problems. If you encounter
problems with the computer, refer to the tables in this chapter for probable causes and recommended
solutions.

Bf NOTE: For information on specific error messages that may appear on the screen during Power-On
Self-Test (POST) at startup, refer to Appendix A, POST Error Messages on page 189.

Safety and Comfort

A WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment
may result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/
ergo for more information on choosing a workspace and creating a safe and comfortable work
environment. This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. For more information, refer to the Safety & Regulatory
Information guide.

Before You Call for Technical Support

If you are having problems with the computer, try the appropriate solutions below to try to isolate the
exact problem before calling for technical support.

e Run the HP diagnostic tool.

e Run the hard drive self-test in Computer Setup. Refer to the Computer Setup (F10) Utility Guide
for more information.

e  Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights
are error codes that will help you diagnose the problem. Refer to Appendix A, POST Error
Messages on page 189 for more information.

e If the screen is blank, plug the monitor into a different video port on the computer if one is
available. Or, replace the monitor with a monitor that you know is functioning properly.

e If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

e If you recently added new hardware, remove the hardware and see if the computer functions
properly.

e If you recently installed new software, uninstall the software and see if the computer functions
properly.
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e Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When
booting the operating system, use “Last Known Configuration.”

e Refer to the comprehensive online technical support at http://www.hp.com/support.

e Refer to Helpful Hints on page 201 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with
self-solve diagnostics. If you need to contact HP support, use HP Instant Support Professional
Edition's online chat feature. Access HP Instant Support Professional Edition at: http://www.hp.com/

golispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online
support information, software and drivers, proactive notification, and worldwide community of peers
and HP experts.

If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that
your service call is handled properly:

e Be in front of your computer when you call.

e  Write down the computer serial number, product ID number, and monitor serial number before
calling.

e  Spend time troubleshooting the problem with the service technician.
e Remove any hardware that was recently added to your system.
e Remove any software that was recently installed.

e Restore the system from the Recovery Disc Set that you created or restore the system to its
original factory condition in HP Backup and Recovery Manager.

/\ CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data
files before running the restore process.

B NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized
service provider or dealer.

Helpful Hints

If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:

e Check that the computer and monitor are plugged into a working electrical outlet.

e Check that the voltage select switch (some models) is set to the appropriate voltage for your
region (115V or 230V).

e  Check that the computer is turned on and the green power light is on.
e  Check that the monitor is turned on and the green monitor light is on.

e Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights
are error codes that will help you diagnose the problem. Refer to Appendix A, POST Error
Messages on page 189 for more information.

e  Turn up the brightness and contrast controls of the monitor if the monitor is dim.
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e Press and hold any key. If the system beeps, then the keyboard should be operating correctly.
e Check all cable connections for loose connections or incorrect connections.

e  Wake the computer by pressing any key on the keyboard or pressing the power button. If the
system remains in suspend mode, shut down the computer by pressing and holding the power
button for at least four seconds then press the power button again to restart the computer. If the
system will not shut down, unplug the power cord, wait a few seconds, then plug it in again. The
computer will restart if it is set to power on automatically as soon as power is restored in
Computer Setup. If it does not restart, press the power button to start the computer.

e Reconfigure the computer after installing a non-plug and play expansion board or other option.
See Solving Hardware Installation Problems on page 227 for instructions.

e Be sure that all the needed device drivers have been installed. For example, if you are using a
printer, you need a driver for that model printer.

e Remove all bootable media (diskette, CD, or USB device) from the system before turning it on.

e If you have installed an operating system other than the factory-installed operating system,
check to be sure that it is supported on the system.

e If the system has multiple video sources (embedded, PCI, or PCl-Express adapters) installed
(embedded video on some models only) and a single monitor, the monitor must be plugged into
the monitor connector on the source selected as the primary VGA adapter. During boot, the
other monitor connectors are disabled and if the monitor is connected into these ports, the
monitor will not function. You can select which source will be the default VGA source in
Computer Setup.

/A CAUTION: When the computer is plugged into an AC power source, there is always voltage applied
to the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.
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Solving General Problems

You may be able to easily resolve the general problems described in this section. If a problem
persists and you are unable to resolve it yourself or if you feel uncomfortable about performing the
operation, contact an authorized dealer or reseller.

A WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

Table D-1 Solving General Problems

Computer appears locked up and will not turn off when the power button is pressed.

Cause Solution

Software control of the power switch is not functional. 1. Press and hold the power button for at least four
seconds until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to USB keyboard or mouse.

Cause Solution

Computer is in standby mode. To resume from standby mode, press the power button or
press any key.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

System has locked up. Restart computer.

Computer date and time display is incorrect.

Cause Solution

RTC (real-time clock) battery may need to be replaced. First, reset the date and time under Control Panel
(Computer Setup can also be used to update the RTC date

NOTE: Connecting the computer to a live AC outlet and time). If the problem persists, replace the RTC battery.

prolongs the life of the RTC battery. See the Hardware Reference Guide for instructions on

installing a new battery, or contact an authorized dealer or
reseller for RTC battery replacement.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key may be on. Press the Num Lock key. The Num Lock light should not be
on if you want to use the arrow keys. The Num Lock key can
be disabled (or enabled) in Computer Setup.
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Table D-1 Solving General Problems (continued)

There is no sound or sound volume is too low.

Cause Solution

System volume may be set low or muted. 1. Check the F10 BIOS settings to make sure the internal
system speaker is not muted (this setting does not
affect the external speakers).

2. Make sure the external speakers are properly
connected and powered on and that the speakers'
volume control is set correctly.

3.  Use the system volume control available in the
operating system to make sure the speakers are not
muted or to increase the volume.

Cannot remove computer cover or access panel.

Cause Solution

Smart Cover Lock, featured on some computers, is locked. Unlock the Smart Cover Lock using Computer Setup.

The Smart Cover FailSafe Key, a device for manually
disabling the Smart Cover Lock, is available from HP. You
will need the FailSafe Key in case of forgotten password,
power loss, or computer malfunction. Order PN 166527-001
for the wrench-style key or PN 166527-002 for the
screwdriver bit key.

Poor performance is experienced.

Cause Solution

Processor is hot. 1.  Make sure airflow to the computer is not blocked. Leave
a 10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2. Make sure fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on
the hard drive.

Low on memory. Add more memory.
Hard drive fragmented. Defragment hard drive.
Program previously accessed did not release reserved Restart the computer.

memory back to the system.

Virus resident on the hard drive. Run virus protection program.
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Table D-1 Solving General Problems (continued)

Poor performance is experienced.

Cause Solution

Too many applications running. 1. Close unnecessary applications to free up memory.

2. Add more memory. Some applications run in the
background and can be closed by right-clicking on their
corresponding icons in the task tray. To prevent these
applications from launching at startup, go to Start >
Run (Windows XP) or Start > Accessories > Run
(Windows Vista) and type msconfig. On the Startup
tab of the System Configuration Utility, clear
applications that you do not want to launch
automatically.

Some software applications, especially games, are stressful 1.  Lower the display resolution for the current application

on the graphics subsystem or consult the documentation that came with the
application for suggestions on how to improve
performance by adjusting parameters in the application.

2. Add more memory.

3. Upgrade the graphics solution.

Cause unknown. Restart the computer.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a
two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing).

Cause Solution

Processor thermal protection activated: 1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.
A fan may be blocked or not turning.
2. Open hood, press power button, and see if the

OR processor fan spins. If the processor fan is not spinning,
make sure the fan's cable is plugged onto the system
The heat sink is not properly attached to the processor. board header.

3. Iffanis plugged in, but is not spinning, then replace the
heat sink/fan assembly.

4. Contact an authorized reseller or service provider.
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Table D-1 Solving General Problems (continued)

System does not power on and the LEDs on the front of the computer are not flashing.

Cause Solution

System unable to power on. Press and hold the power button for less than 4 seconds. If
the hard drive LED turns green, then:

1. Check that the voltage selector, located on the rear of
the power supply on some models, is set to the
appropriate voltage. Proper voltage setting depends on
your region.

2. Remove the expansion cards one at a time until the
5V_aux light on the system board turns on.

3. Replace the system board.
OR

Press and hold the power button for less than 4 seconds. If
the hard drive LED does not turn on green then:

1. Check that the unit is plugged into a working AC outlet.

2.  Open hood and check that the power button harness is
properly connected to the system board.

3. Check that both power supply cables are properly
connected to the system board.

4. Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power
button harness.

5. If the 5V_aux light on the system board is off, then
replace the power supply.

6. Replace the system board.
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Solving Power Problems

Common causes and solutions for power problems are listed in the following table.

Table D-2 Solving Power Problems

Power supply shuts down intermittently.

Cause Solution

Voltage selector switch on rear of computer chassis (some Select the proper AC voltage using the selector switch.
models) not switched to correct line voltage (115V or 230V).

Power supply will not turn on because of internal power Contact an authorized service provider to replace the power
supply fault. supply.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a
two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Processor thermal protection activated: 1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.
A fan may be blocked or not turning.
2. Open hood, press power button, and see if the

OR processor fan spins. If the processor fan is not spinning,
make sure the fan's cable is plugged onto the system
The heat sink is not properly attached to the processor. board header.

3. Iffanis plugged in, but is not spinning, then replace the
heat sink/fan assembly.

4. Contact an authorized reseller or service provider.
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Table D-2 Solving Power Problems (continued)

Power LED flashes Red four times, once every second, followed by a two second pause, and the computer beeps
four times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Power failure (power supply is overloaded). 1.

4.

5.

Check that the voltage selector, located on the rear of
the power supply (some models), is set to the
appropriate voltage. Proper voltage setting depends on
your region.

Open the hood and ensure the 4- or 6-wire power
supply cable is seated into the connector on the system
board.

Check if a device is causing the problem by removing
ALL attached devices (such as hard, diskette, or optical
drives, and expansion cards). Power on the system. If
the system enters the POST, then power off and
replace one device at a time and repeat this procedure
until failure occurs. Replace the device that is causing
the failure. Continue adding devices one at a time to
ensure all devices are functioning properly.

Replace the power supply.

Replace the system board.

The incorrect external power supply adapter is being used on The USDT power supply adapter must be at 135W and use

the USDT. the Smart ID technology before the system will power up.
Replace the power supply adapter with the HP-supplied
USDT power supply adapter.
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Solving Diskette Problems

Common causes and solutions for diskette problems are listed in the following table.

Br NOTE: The computer does not support internal diskette drives. Only USB diskette drives are
supported.

NOTE: You may need to reconfigure the computer when you add or remove hardware, such as an
additional diskette drive. See Solving Hardware Installation Problems on page 227 for instructions.

Table D-3 Solving Diskette Problems

Diskette drive light stays on.

Cause Solution

Diskette is damaged. In Microsoft Windows XP, right-click Start, click Explore,
and select a drive. Select File > Properties > Tools. Under
Error-checking click Check Now.

In Microsoft Windows Vista, right-click Start, click Explore,
and right-click on a drive. Select Properties then select the
Tools tab. Under Error-checking click Check Now.

Diskette is incorrectly inserted. Remove diskette and reinsert.

Drive cable is not properly connected. Reconnect drive cable. Ensure that all four pins on the
diskette power cable are connected to the drive.

Drive not found.

Cause Solution
Cable is loose. Reseat diskette drive data and power cable.
Removable drive is not seated properly. Reseat the drive.

Diskette drive cannot write to a diskette.

Cause Solution

Diskette is not formatted. Format the diskette.
1. From Windows Explorer select the disk (A) drive.
2. Right-click the drive letter and select Format.

3. Select the desired options, and click Start to begin
formatting the diskette.

Diskette is write-protected. Use another diskette or remove the write protection.
Writing to the wrong drive. Check the drive letter in the path statement.
Not enough space is left on the diskette. 1. Use another diskette.

2. Delete unneeded files from diskette.

Diskette is damaged. Replace the damaged disk.
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Table D-3 Solving Diskette Problems (continued)

Cannot format diskette.

Cause

Solution

Invalid media reported.

When formatting a disk in MS-DOS, you may need to specify
diskette capacity. For example, to format a 1.44-MB diskette,
type the following command at the MS-DOS prompt:

FORMAT A: /F:1440

Disk may be write-protected.

Open the locking device on the diskette.

Legacy diskette writes are disabled in Computer Setup.

Enter Computer Setup and enable Legacy Diskette Write in
Storage > Storage Options.

A problem has occurred with a disk transaction.

Cause

Solution

The directory structure is bad, or there is a problem with a
file.

In Microsoft Windows XP, right-click Start, click Explore,
and select a drive. Select File > Properties > Tools. Under
Error-checking, click Check Now.

In Microsoft Windows Vista, right-click Start, click Explore,
and right-click on a drive. Select Properties then select the
Tools tab. Under Error-checking click Check Now.

Diskette drive cannot read a diskette.

Cause

Solution

You are using the wrong diskette type for the drive type.

Check the type of drive that you are using and use the
correct diskette type.

You are reading the wrong drive.

Check the drive letter in the path statement.

Diskette is damaged.

Replace the diskette with a new one.

“Invalid system disk” message is displayed.

Cause

Solution

A diskette that does not contain the system files needed to
start the computer has been inserted in the drive.

When drive activity stops, remove the diskette and press the
Spacebar. The computer should start up.

Diskette error has occurred.

Restart the computer by pressing the power button.

Cannot Boot to Diskette.

Cause

Solution

Diskette is not bootable.

Replace with a bootable diskette.
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Table D-3 Solving Diskette Problems (continued)

Cannot Boot to Diskette.

Cause Solution

Diskette boot has been disabled in Computer Setup. 1. Run Computer Setup and enable diskette boot in
Storage > Boot Order.

2.  Run Computer Setup and enable diskette boot in
Storage > Storage Options > Removable Media
Boot.

NOTE: Both steps should be used as the Removable
Media Boot function in Computer Setup overrides the Boot
Order enable command.

Network server mode is enabled in Computer Setup. Run Computer Setup and disable Network Server Mode in
Security > Password Options.
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Solving Hard Drive Problems

Table D-4 Solving Hard Drive Problems

Hard drive error occurs.

Cause

Solution

Hard disk has bad sectors or has failed.

1. In Microsoft Windows XP, right-click Start, click
Explore, and select a drive. Select File > Properties >
Tools. Under Error-checking, click Check Now.

In Microsoft Windows Vista, right-click Start, click
Explore, and right-click on a drive. Select
Properties then select the Tools tab. Under Error-
checking click Check Now.

2. Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Disk transaction problem.

Cause

Solution

Either the directory structure is bad or there is a problem with
a file.

In Microsoft Windows XP, right-click Start, click Explore,
and select a drive. Select File > Properties > Tools. Under
Error-checking, click Check Now.

In Microsoft Windows Vista, right-click Start, click Explore,
and right-click on a drive. Select Properties then select the
Tools tab. Under Error-checking click Check Now.

Drive not found (identified).

Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 227 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

If this is a newly installed drive, run the Computer Setup
utility and try adding a POST delay under Advanced >
Power-On.

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.
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Table D-4 Solving Hard Drive Problems (continued)

Nonsystem disk/NTLDR missing message.

Cause

Solution

The system is trying to start from a diskette that is not
bootable.

Remove the diskette from the diskette drive.

The system is trying to start from the hard drive but the hard
drive may have been damaged.

1. Insert a bootable diskette into the diskette drive and
restart the computer.

2. Check the hard drive format using fdisk: If NTFS
formatting, use a third party reader to evaluate the
drive. If FAT32 formatting, the hard drive cannot be
accessed.

System files missing or not properly installed.

1. Insert a bootable diskette into the diskette drive and
restart the computer.

2. Check the hard drive format using Fdisk: If NFTFS
formatting, use a third party reader to evaluate the
drive. If FAT32 formatting, the hard drive cannot be
accessed.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup.

Run the Computer Setup utility and enable the hard drive
entry in the Storage > Boot Order list.

Bootable hard drive is not attached as first in a multi-hard
drive configuration.

If attempting to boot from a hard drive, ensure it is attached
to the system board connector labeled P60 SATA 0.

Bootable hard drive's controller is not listed first in the Boot
Order.

Run the Computer Setup utility and select Storage > Boot
Order and ensure the bootable hard drive's controller is
listed immediately under the Hard Drive entry.

Computer will not boot from hard drive.

Cause

Solution

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Hard Drive's “Emulation Type” is set to “None.”

Run the Computer Setup utility and change the “Emulation
Type” to “Hard Disk” in the device's details under Storage >
Device Configuration.

Hard drive is damaged.

Observe if the front panel Power LED is blinking RED and if
any beeps are heard. See Appendix A, POST Error
Messages on page 189 to determine possible causes for the
blinking red and beep codes.

See the Worldwide Limited Warranty for terms and
conditions.
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Table D-4 Solving Hard Drive Problems (continued)

Computer seems to be locked up.

Cause Solution

Program in use has stopped responding to commands. Attempt the normal Windows “Shut Down” procedure. If this
fails, press the power button for four or more seconds to turn
off the power. To restart the computer, press the power
button again.

The removable hard drive has no power to the hard drive enclosure.

Cause Solution

The lock on the enclosure is not turned to the “ON” position.  Insert the key and turn the lock clockwise 90 degrees. The
green LED on the front of the enclosure should be on.

Power cable from the computer power supply to the Check the power supply to make sure it is properly
enclosure frame is not properly connected. connected to the rear of the enclosure frame.

The removable hard drive is not recognized by the computer.

Cause Solution

The removable hard drive carrier is not fully seated in the Push the carrier into the enclosure frame so that the
enclosure frame or the hard drive is not fully seated in the connector on the rear of the frame is properly seated. If this
carrier. does not solve the problem, turn off the computer, remove

the carrier, and check to see if the connector on the hard
drive is properly seated in the carrier.

The removable hard drive enclosure is beeping and the green LED is flashing.

Cause Solution

Fan failure alarm on the removable hard drive enclosure has  Shut down the computer and contact HP for a replacement
been activated. enclosure.
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Solving Media Card Reader Problems

Table D-5 Solving Media Card Reader Problems

Media card will not work in a digital camera after formatting it in Microsoft Windows XP or Microsoft Windows Vista.

Cause Solution

By default, Windows XP and Windows Vista will format any Either format the media card in the digital camera or select
media card with a capacity greater than 32MB with the FAT file system to format the media card in a computer with
FAT32 format. Most digital cameras use the FAT (FAT16 & Windows XP or Windows Vista.

FAT12) format and can not operate with a FAT32 formatted

card.

A write-protected or locked error occurs when attempting to write to the media card.

Cause Solution

Media card is locked. Locking the media card is a safety If using an SD card, make sure that the lock tab located on
feature that prevents writing to and deleting from an SD/ the right of the SD card is not in the locked position. If using
Memory Stick/PRO card. a Memory Stick/PRO card, make sure that the lock tab

located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Can not write to the media card.

Cause Solution

The media card is a read-only memory (ROM) card. Check the manufacturer’'s documentation included with your
card to see if it writable. Refer to the previous section for a
list of compatible cards.

Media card is locked. Locking the media card is a safety If using an SD card, make sure that the lock tab located on
feature that prevents writing to and deleting from an SD/ the right of the SD card is not in the locked position. If using
Memory Stick/PRO card. a Memory Stick/PRO card, make sure that the lock tab

located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Unable to access data on the media card after inserting it into a slot.

Cause Solution
The media card is not inserted properly, is inserted in the Ensure that the card is inserted properly with the gold
wrong slot, or is not supported. contact on the correct side. The green LED will light if

inserted properly.
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Do not know how to remove a media card correctly.

Table D-5 Solving Media Card Reader Problems (continued)

Cause

Solution

The computer’s software is used to safely eject the card.

Open My Computer (Windows XP) or Computer (Windows
Vista), right-click on the corresponding drive icon, and select
Eject. Then pull the card out of the slot.

NOTE: Never remove the card when the green LED is
flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized

by the computer.

Cause

Solution

The operating system needs time to recognize the device if
the reader was just installed into the computer and you are
turning the PC on for the first time.

Wait a few seconds so that the operating system can
recognize the reader and the available ports, and then
recognize whatever media is inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause

Solution

The inserted media card has boot capability.

If you do not want to boot from the media card, remove it
during boot or do not select the option to boot from the
inserted media card during the boot process.

216 Appendix D Troubleshooting Without Diagnostics



Solving Display Problems

If you encounter display problems, see the documentation that came with the monitor and to the
common causes and solutions listed in the following table.

Table D-6 Solving Display Problems

Blank screen (no video).

Cause

Solution

Monitor is not turned on and the monitor light is not on.

Turn on the monitor and check that the monitor light is on.

Bad monitor.

Try a different monitor.

The cable connections are not correct.

Check the cable connection from the monitor to the computer
and to the electrical outlet.

You may have a screen blanking utility installed or energy
saver features are enabled.

Press any key or click the mouse button and, if set, type your
password.

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image. See
the “Boot Block Emergency Recovery Mode” section of the
Desktop Management Guide for more information

You are using a fixed-sync monitor and it will not sync at the
resolution chosen.

Be sure that the monitor can accept the same horizontal
scan rate as the resolution chosen.

Computer is in standby mode.

Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Monitor cable is plugged into the wrong connector.

If the computer system has both an integrated graphics
connector and an add-in graphics card connector, plug the
monitor cable into the graphics card connector on the back of
the computer.

Monitor settings in the computer are not compatible with the
monitor.

1. In Windows XP Control Panel, double-click the Display
icon and select the Settings tab.

In Windows Vista Control Panel, under Appearance
and Personalization, select Adjust screen

resolution.

2. Use the sliding control to reset the resolution.

Monitor is configured to use an input that is not active.

Use the monitor's on-screen menu controls to select the
input that is being driven by the system. Refer to the
monitor's user documentation for more information on the on-
screen controls and settings.

Cannot enable integrated graphics after installing a PCI Express graphics card.

Cause

Solution

On systems with Intel integrated graphics, the integrated
graphics cannot be enabled after installing a PCI Express
x16.

The integrated graphics can be enabled in Computer Setup if
a PCl or PCI Express x1 graphics card is installed, but it
cannot be enabled if there is a graphics card in the PCI
Express x16 slot.
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Table D-6 Solving Display Problems (continued)

Blank screen and the power LED flashes Red five times, once every second, followed by a two second pause, and
the computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Pre-video memory error.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Blank screen and the power LED flashes Red six times, once every second, followed by a two second pause, and
the computer beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Pre-video graphics error.

For systems with a graphics card:

1. Reseat the graphics card. Power on the system.
2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Blank screen and the power LED flashes Red seven times, once every second, followed by a two second pause, and
the computer beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

System board failure (ROM detected failure prior to video).

Replace the system board.

Monitor does not function properly when used with energy saver features.

Cause

Solution

Monitor without energy saver capabilities is being used with
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters.

Cause

Solution

The brightness and contrast controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly connected.

Check that the graphics cable is securely connected to the
graphics card and the monitor.
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Table D-6 Solving Display Problems (continued)

Blurry video or requested resolution cannot be set.

Cause Solution

If the graphics controller was upgraded, the correct graphics  Install the video drivers included in the upgrade kit.
drivers may not be loaded.

Monitor is not capable of displaying requested resolution. Change requested resolution.

Graphics card is bad. Replace the graphics card.

The picture is broken up, rolls, jitters, or flashes.

Cause Solution

The monitor connections may be incomplete or the monitor 1. Be sure the monitor cable is securely connected to the
may be incorrectly adjusted. computer.

2. In a two-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with
each other’s electromagnetic field by moving them

apart.
3. Fluorescent lights or fans may be too close to the
monitor.
Monitor needs to be degaussed. Degauss the monitor. Refer to the documentation that came

with the monitor for instructions.

Image is not centered.

Cause Solution

Position may need adjustment. Press the monitor's Menu button to access the OSD menu.
Select ImageControl/ Horizontal Position or Vertical
Position to adjust the horizontal or vertical position of the

image.
“No Connection, Check Signal Cable” displays on screen.
Cause Solution
Monitor video cable is disconnected. Connect the video cable between the monitor and computer.

CAUTION: Ensure that the computer power is off while
connecting the video cable.

“Out of Range” displays on screen.

Cause Solution
Video resolution and refresh rate are set higher than what Restart the computer and enter Safe Mode. Change the
the monitor supports. settings to a supported setting then restart the computer so

that the new settings take effect.
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Table D-6 Solving Display Problems (continued)

Vibrating or rattling noise coming from inside a CRT monitor when powered on.

Cause Solution

Monitor degaussing coil has been activated. None. It is normal for the degaussing coil to be activated
when the monitor is powered on.

Clicking noise coming from inside a CRT monitor.

Cause Solution

Electronic relays have been activated inside the monitor. None. It is normal for some monitors to make a clicking noise
when turned on and off, when going in and out of standby
mode, and when changing resolutions.

High pitched noise coming from inside a flat panel monitor.

Cause Solution

Brightness and/or contrast settings are too high. Lower brightness and/or contrast settings.

Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to
center the picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause Solution

Flat panel monitor’s internal digital conversion circuits may 1. Select the monitor's Auto-Adjustment option in the
be unable to correctly interpret the output synchronization of monitor’s on-screen display menu.
the graphics card.

2. Manually synchronize the Clock and Clock Phase on-
screen display functions. To download a SoftPaq that
will assist you with the synchronization, go to the
following Web site, select the appropriate monitor, and
download either SP32347 or SP32202:
http://www.hp.com/support

Graphics card is not seated properly or is bad. 1. Reseat the graphics card.

2. Replace the graphics card.

Certain typed symbols do not appear correct.

Cause Solution
The font you are using does not support that particular Use the Character Map to locate and select the appropriate
symbol. symbol. Click Start > All Programs > Accessories >

System Tools > Character Map. You can copy the symbol
from the Character Map into a document.
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Solving Audio Problems

If the computer has audio features and you encounter audio problems, see the common causes and

solutions listed in the following table.

Table D-7 Solving Audio Problems

Sound cuts in and out.

Cause

Solution

Processor resources are being used by other open
applications.

Shut down all open processor-intensive applications.

Direct sound latency, common in many media player
applications.

In Windows XP only:

1. From the Control Panel, select Sounds and Audio
Devices.

2. On the Audio tab, select a device from the Sound
Playback list.

3. Click the Advanced button and select the Performance
tab.

4. Set the Hardware acceleration slider to None and the
Sample rate conversion quality slider to Good and
retest the audio.

5. Set the Hardware acceleration slider to Full and the
Sample rate conversion quality slider to Best and
retest the audio.

Sound does not come out of the speaker or headphones.

Cause

Solution

Software volume control is turned down or muted.

Double-click the Speaker icon on the taskbar, then make
sure that Mute is not selected and use the volume slider to
adjust the volume.

Audio is hidden in Computer Setup.

Enable the audio in Computer Setup: Security >
Device Security > System Audio.

The external speakers are not turned on.

Turn on the external speakers.

The audio device may be connected to the wrong jack.

Ensure that the device is connected to the correct jack on the
computer. The speakers should be plugged into the rear line-
out jack and the headphones should be plugged into the
front headphone jack.

External speakers plugged into the wrong audio jack on a
recently installed sound card.

See the sound card documentation for proper speaker
connection.

Digital CD audio is not enabled.

Enable digital CD audio. In the Device Manager, right-click
on the CD/DVD device and select Properties. Make sure
Enable digital CD audio for this CD-ROM device is
checked.

Headphones or devices connected to the line-out connector
mute the internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external speakers.
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Table D-7 Solving Audio Problems (continued)

Sound does not come out of the speaker or headphones.

Cause

Solution

Computer is in standby mode.

Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Internal speaker is disabled in Computer Setup.

Enable the internal speaker in Computer Setup. Select
Advanced > Device Options > Internal Speaker.

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection, so multiple audio devices may be listed in
Device Manager. Make sure the correct device is being
used.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Sound from headphones is not clear or muffled.

Cause

Solution

Headphones are plugged into the rear audio output
connector. The rear audio output connector is for powered
audio devices and is not designed for headphone use.

Plug the headphones into the headphone connector on the
front of the computer.

Computer appears to be locked up while recording audio.

Cause

Solution

The hard disk may be full.

Before recording, make sure there is enough free space on
the hard disk. You can also try recording the audio file in a
compressed format.

Line-in jack is not functioning properly.

Cause

Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the
jack or set the jack to its default value.
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Table D-7 Solving Audio Problems (continued)

There is no sound or sound volume is too low.

Cause Solution

The application is set to use a different audio device than Some graphics cards support audio over the DisplayPort

speakers. connection, so multiple audio devices may be listed in
Device Manager. Make sure the correct device is being
used.

Some applications can select which audio output device is Make sure the application has selected the correct audio

used. device.

The operating system controls may be set to use a different Set the operating system to use the correct audio device.
audio device as the default output device than what is
expected.
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Solving Printer Problems

If you encounter printer problems, see the documentation that came with the printer and to the
common causes and solutions listed in the following table.

Table D-8 Solving Printer Problems

Printer will not print.

Cause

Solution

Printer is not turned on and online.

Turn the printer on and make sure it is online.

The correct printer drivers for the application are not
installed.

1. Install the correct printer driver for the application.
2. Try printing using the MS-DOS command:
DIR C:\ > [printer port]

where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.

If you are on a network, you may not have made the
connection to the printer.

Make the proper network connections to the printer.

Printer may have failed.

Run printer self-test.

Printer will not turn on.

Cause

Solution

The cables may not be connected properly.

Reconnect all cables and check the power cord and
electrical outlet.

Printer prints garbled information.

Cause

Solution

The correct printer driver for the application is not installed.

Install the correct printer driver for the application.

The cables may not be connected properly.

Reconnect all cables.

Printer memory may be overloaded.

Reset the printer by turning it off for one minute, then turn it
back on.

Printer is offline.

Cause

Solution

The printer may be out of paper.

224 Appendix D Troubleshooting Without Diagnostics



Solving Keyboard and Mouse Problems

If you encounter keyboard or mouse problems, see the documentation that came with the equipment
and to the common causes and solutions listed in the following table.

Table D-9 Solving Keyboard Problems

Keyboard commands and typing are not recognized by the computer.

Cause Solution

Keyboard connector is not properly connected. 1. On the Windows XP Desktop, click Start > Shut Down.

On the Windows Vista Desktop, click Start, click the
arrow on the lower right corner of the Start menu, then
select Shut Down.

2.  After the shutdown is complete, reconnect the keyboard
to the back of the computer and restart the computer.

Program in use has stopped responding to commands. Shut down your computer using the mouse and then restart
the computer.

Keyboard needs repairs. See the Worldwide Limited Warranty for terms and
conditions.
Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key may be on. Press the Num Lock key. The Num Lock light should not be
on if you want to use the arrow keys. The Num Lock key can
be disabled (or enabled) in Computer Setup.

Table D-10 Solving Mouse Problems

Mouse does not respond to movement or is too slow.

Cause Solution

Mouse connector is not properly plugged into the back of the  Shut down the computer using the keyboard.

computer.

1. Press the Ctrl and Esc keys at the same time (or press
the Windows logo key) to display the Start menu.

2. Use the arrow keys to select Shut Down and then
press the Enter key.

3.  After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.

Program in use has stopped responding to commands. Shut down the computer using the keyboard then restart the

computer.
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Table D-10 Solving Mouse Problems (continued)

Mouse does not respond to movement or is too slow.

Cause Solution

Mouse may need cleaning. Remove the roller ball cover on the mouse and clean the
internal components.

Mouse may need repair. See the Worldwide Limited Warranty for terms and
conditions.
Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause Solution
Mouse roller ball or the rotating encoder shafts that make Remove roller ball cover from the bottom of the mouse and
contact with the ball are dirty. clean the internal components with a mouse cleaning kit

available from most computer stores.
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Solving Hardware Installation Problems

You may need to reconfigure the computer when you add or remove hardware, such as an additional
drive or expansion card. If you install a plug and play device, Windows automatically recognizes the
device and configures the computer. If you install a non—plug and play device, you must reconfigure
the computer after completing installation of the new hardware. In Windows, use the Add Hardware

Wizard and follow the instructions that appear on the screen.

WARNING!

When the computer is plugged into an AC power source, voltage is always applied to

the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to

cool before touching.

Table D-11 Solving Hardware Installation Problems

A new device is not recognized as part of the system.

Cause

Solution

Device is not seated or connected properly.

Ensure that the device is properly and securely connected
and that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables
are unplugged.

Ensure that all cables are properly and securely connected
and that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on.

Turn off the computer, turn on the external device, then turn
on the computer to integrate the device with the computer
system.

When the system advised you of changes to the
configuration, you did not accept them.

Reboot the computer and follow the instructions for
accepting the changes.

A plug and play board may not automatically configure when

added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic
settings for the board and choose a basic configuration that
does not cause a resource conflict. You can also use
Computer Setup to reconfigure or disable devices to resolve
the resource conflict.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that Device
available is selected for appropriate USB ports under
Security > Device Security.

Computer will not start.

Cause

Solution

Wrong memory modules were used in the upgrade or
memory modules were installed in the wrong location.

1. Review the documentation that came with the system to
determine if you are using the correct memory modules
and to verify the proper installation.

NOTE: DIMM 1 must always be installed.

2. Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for
specific problems.

3. If you still cannot resolve the issue, contact Customer
Support.
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Table D-11 Solving Hardware Installation Problems (continued)

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps
five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Memory is installed incorrectly or is bad.

CAUTION: To avoid damage to the DIMMs or the system
board, you must unplug the computer power cord before
attempting to reseat, install, or remove a DIMM module.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

NOTE: DIMM 1 must always be installed.
3. Replace third-party memory with HP memory.

4. Replace the system board.

Power LED flashes Red six times, once every second, followed by a two second pause, and the computer beeps six
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Graphics card is not seated properly or is bad, or system
board is bad.

For systems with a graphics card:

1. Reseat the graphics card. Power on the system.
2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Power LED flashes Red ten times, once every second, followed by a two second pause, and the computer beeps ten
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Bad option card.

1. Check each option card by removing the cards one at
time (if multiple cards), then power on the system to see
if fault goes away.

2. Once bad card is identified, remove and replace bad
option card.

3. Replace the system board.
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Solving Network Problems

Some common causes and solutions for network problems are listed in the following table. These
guidelines do not discuss the process of debugging the network cabling.

Table D-12 Solving Network Problems

Wake-on-LAN feature is not functioning.

Cause Solution

S5 Maximum Power Saving feature is enabled. Disable the S5 Maximum Power Saving option in Computer
Setup. Select Power > Hardware Power Management > S5
Maximum Power Saving.

Wake-on-LAN is not enabled. To enable Wake-on-LAN in Windows XP:

1. Select Start > Control Panel.

2. Double-click Network Connections.

3. Double-click Local Area Connection.

4. Click Properties.

5. Click Configure.

6. Click the Power Management tab, then select the
check box to Allow this device to bring the computer
out of standby.

To enable Wake-on-LAN in Windows Vista:

1.  Select Start > Control Panel.

2. Under Network and Internet, select View network
status and tasks.

3. Inthe Tasks list, select Manage network connections.
4. Double-click Local Area Connection.

5.  Click the Properties button.

6. Click the Configure button.

7.  Click the Power Management tab, then select the
check box to Allow this device to wake the computer.

Network driver does not detect network controller.

Cause Solution

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system
via Device Manager.

Incorrect network driver. Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer's Web
site.
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Table D-12 Solving Network Problems (continued)

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution
No active network is detected. Check cabling and network equipment for proper connection.
Network controller is not set up properly. Check for the device status within Windows, such as Device

Manager for driver load and the Network Connections applet
within Windows for link status.

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system
via Device Manager.

Network driver is not properly loaded. Reinstall network drivers.

System cannot autosense the network. Disable auto-sensing capabilities and force the system into
the correct operating mode.

Diagnostics reports a failure.

Cause Solution

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The cable is attached to the incorrect connector. Ensure that the cable is attached to the correct connector.
There is a problem with the cable or a device at the other Ensure that the cable and device at the other end are

end of the cable. operating correctly.

Network controller interrupt is shared with an expansion Under the Computer Setup Advanced menu, change the
board. resource settings for the board.

The network controller is defective. Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause Solution

Network drivers are not loaded, or driver parameters do not Make sure the network drivers are loaded and that the driver
match current configuration. parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer. Select the Network icon in the Control Panel and configure
the network controller.

Network controller stopped working when an expansion board was added to the computer.

Cause Solution
Network controller interrupt is shared with an expansion Under the Computer Setup Advanced menu, change the
board. resource settings for the board.
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Table D-12 Solving Network Problems (continued)

Network controller stopped working when an expansion board was added to the computer.

Cause Solution

The network controller requires drivers. Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and Under the Computer Setup Advanced menu, change the
conflicts with the embedded NIC. resource settings for the board.

Network controller stops working without apparent cause.

Cause Solution

The files containing the network drivers are corrupted. Reinstall the network drivers, using the Recovery Disc Set
created from the hard drive's Recovery Partition.

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The network controller is defective. Contact an authorized service provider.

New network card will not boot.

Cause Solution
New network card may be defective or may not meet Install a working, industry-standard NIC, or change the boot
industry-standard specifications. sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause Solution

The network controller is not configured properly. Verify Network Connectivity, that a DHCP Server is present,
and that the Remote System Installation Server contains the
NIC drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.
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Solving Memory Problems

If you encounter memory problems, some common causes and solutions are listed in the following
table.

/A CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending
on the Management Engine (ME) settings). To avoid damage to the DIMMSs or the system board, you
must unplug the computer power cord before attempting to reseat, install, or remove a DIMM module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC
memory. Otherwise, the computer will not boot the operating system.

B NOTE: The memory count will be affected by configurations with the Management Engine (ME)
enabled. The ME uses 8MB of system memory in single channel mode or 16MB of memory in dual-
channel mode to download, decompress, and execute the ME firmware for Out-of-Band (OOB), third-
party data storage, and other management functions.

Table D-13 Solving Memory Problems

System will not boot or does not function properly after installing additional memory modules.

Cause Solution

A memory module is not installed in the XMM1 (or DIMM1) Ensure that a memory module is installed in the black XMM1
socket. (or DIMM1) socket on the system board. This socket must be
populated with a memory module.

Memory module is not the correct type or speed grade for Replace module with the correct industry-standard device for
the system or the new memory module is not seated the computer. On some models, ECC and non-ECC memory
properly. modules cannot be mixed.

Out of memory error.

Cause Solution
Memory configuration may not be set up correctly. Use the Device Manager to check memory configuration.
You have run out of memory to run the application. Check the application documentation to determine the

memory requirements.

Memory count during POST is wrong.

Cause Solution

The memory modules may not be installed correctly. Check that the memory modules have been installed
correctly and that proper modules are used.

Integrated graphics may use system memory. No action required.
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Table D-13 Solving Memory Problems (continued)

Insufficient memory error during operation.

Cause

Solution

Too many Terminate and Stay Resident programs (TSRs)
are installed.

Delete any TSRs that you do not need.

You have run out of memory for the application.

Check the memory requirements for the application or add
more memory to the computer.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps
five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Memory is installed incorrectly or is bad.

1.

2.

Reseat DIMMs. Power on the system.

Replace DIMMs one at a time to isolate the faulty
module.

Replace third-party memory with HP memory.

Replace the system board.
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Solving Processor Problems

If you encounter processor problems, common causes and solutions are listed in the following table.

Table D-14 Solving Processor Problems

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure the airflow to the computer is not blocked.

2. Make sure the fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Power LED flashes Red three times, once every second, followed by a two second pause.

Cause Solution

Processor is not seated properly or not installed. 1. Check to see that the processor is present.

2. Reseat the processor.

Power LED flashes Red eleven times, once every second, followed by a two second pause.

Cause Solution

The current processor does not support a feature previously 1. Install a TXT capable processor.

enabled on this system.
2. Disable TXT in the Computer Setup (F10) utility.

3. Reinstall the original processor.
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Solving CD-ROM and DVD Problems

If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the
following table or to the documentation that came with the optional device.

Table D-15 Solving CD-ROM and DVD Problems
System will not boot from CD-ROM or DVD drive.

Cause

Solution

The device is attached to a SATA port that has been hidden
in the Computer Setup utility.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
CD-ROM is enabled in Storage > Boot Order.

Network Server Mode is enabled in Computer Setup.

Run the Computer Setup utility and disable Network Server
Mode in Security > Password Options.

Non-bootable CD in drive.

Try a bootable CD in the drive.

Boot order not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Drive not found (identified).

Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 227 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

If this is a newly installed drive, run the Computer Setup
utility and try adding a POST delay under Advanced >
Power-On Options.

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

CD-ROM or DVD devices are not detected or driver is not loaded.

Cause

Solution

Drive is not connected properly or not properly configured.

See the documentation that came with the optional device.
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Table D-15 Solving CD-ROM and DVD Problems (continued)

Movie will not play in the DVD drive.

Cause

Solution

Movie may be regionalized for a different country.

See the documentation that came with the DVD drive.

Decoder software is not installed.

Install decoder software.

Damaged media.

Replace media.

Movie rating locked out by parental lock.

Use DVD software to remove parental lock.

Media installed upside down.

Reinstall media.

Cannot eject compact disc (tray-load unit).

Cause

Solution

Disc not properly seated in the drive.

Turn off the computer and insert a thin metal rod into the
emergency eject hole and push firmly. Slowly pull the tray
out from the drive until the tray is fully extended, then remove
the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause

Solution

Media has been inserted upside down.

Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to

determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive
determine the type of media being played. If the disc still
does not start, read the other solutions listed for this topic.

CD or DVD disc is dirty.

Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive.

1. Use Device Manager to remove or uninstall the device.

2. Restart the computer and let Windows detect the CD or
DVD driver.

Recording or copying CDs is difficult or impossible.

Cause

Solution

Wrong or poor quality media type.

1. Try using a slower speed when recording.
2. Verify that you are using the correct media for the drive.

3. Try a different brand of media. Quality varies widely
between manufacturers.
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USDT computer boots too slow after removing a CD-ROM or DVD drive.

Cause

Solution

The system is searching for the drive during boot because
the drive cable is still attached to the system board.

Disconnect the drive cable from the system board.

Solving USB Flash Drive Problems

If you encounter USB flash drive problems, common causes and solutions are listed in the following

table.

Table D-16 Solving USB Flash Drive Problems

USB flash drive is not seen as a drive letter in Windows.

Cause

Solution

The drive letter after the last physical drive is not available.

Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause

Solution

The device is attached to a USB port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure that “Device
available” is selected for “Front USB Ports” and “Rear USB
Ports” under Security > Device Security.

The device was not properly seated before power-up.

Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.

Cause

Solution

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
USB is enabled in Storage > Boot Order.

The image on the device is not bootable.

Follow the procedures described in the “ROM Flash:
Replicating the Setup: Creating a Bootable Device:
Supported USB Flash Media Device” section of the Service
Reference Guide.

The computer boots to DOS after making a bootable flash drive.

Cause

Solution

Flash drive is bootable.

Install the flash drive only after the operating system boots.
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Solving Front Panel Component Problems

If you encounter problems with devices connected to the front panel, refer to the common causes and
solutions listed in the following table.

Table D-17 Solving Front Panel Component Problems

A USB device, headphone, or microphone is not recognized by the computer.

Cause Solution

Device is not properly connected. 1. Turn off the computer.

2. Reconnect the device to the front of the computer and
restart the computer.

The device does not have power. If the USB device requires AC power, be sure one end is
connected to the device and one end is connected to a live
outlet.

The correct device driver is not installed. 1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work. 1. If possible, replace the cable.

2. Restart the computer.

The device is not working. 1. Replace the device.

2. Restart the computer.

USB ports on the computer are disabled in Computer Setup.  Run the Computer Setup utility and ensure that Device
available is selected for appropriate USB ports under
Security > Device Security.
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Solving Internet Access Problems

If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.

Table D-18 Solving Internet Access Problems

Unable to connect to the Internet.

Cause

Solution

Internet Service Provider (ISP) account is not set up
properly.

Verify Internet settings or contact your ISP for assistance.

Modem is not set up properly.

Reconnect the modem. Verify the connections are correct
using the quick setup documentation.

Web browser is not set up properly.

Verify that the Web browser is installed and set up to work
with your ISP.

Cable/DSL modem is not plugged in.

Plug in cable/DSL modem. You should see a “power” LED
light on the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted
due to bad weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected.

Connect the CAT5 UTP cable between the cable modem
and the computers’s RJ-45 connector. (If the connection is
good, the “PC” LED light on the front of the cable/DSL
modem will be on.)

IP address is not configured properly.

Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of
information that a Web server can store temporarily with the
Web browser. This is useful for having the browser
remember some specific information that the Web server can
later retrieve.)

Windows Vista

1. Select Start > Control Panel.
2. Click Network and Internet.
3.  Click Internet Options.

4. Inthe Browsing history section on the General tab,
click the Delete button.

5.  Click the Delete cookies button.
Windows XP

1.  Select Start > Control Panel.

2. Double-click Internet Options.

3. Onthe General tab, click the Delete Cookies button.

Cannot automatically launch Internet programs.

Cause

Solution

You must log on to your ISP before some programs will start.

Log on to your ISP and launch the desired program.
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Table D-18 Solving Internet Access Problems (continued)

Internet takes too long to download Web sites.

Cause Solution

Modem is not set up properly. Verify that the modem is connected and communicating
properly.
Windows XP

1. Select Start > Control Panel.
2. Double-click System.
3.  Click the Hardware tab.

4. Inthe Device Manager area, click the Device Manager
button.

5. Double-click Modems.

6. Double-click Agere Systems PCI-SV92PP Soft
Modem.

7. On the General tab, click Diagnostics.

8. Click Query Modem. A “Success” response indicates
the modem is connected and working properly.

Windows Vista

1. Select Start > Control Panel.

2. Click on System and Maintenance.

3. Click on System.

4. In the Tasks list, select Device Manager.
5.  Double-click Modems.

6. Double-click Agere Systems PCI-SV92PP Soft
Modem.

7. On the General tab, click Diagnostics.

8. Click Query Modem. A “Success” response indicates
the modem is connected and working properly.
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Solving Software Problems

Most software problems occur as a result of the following:

e  The application was not installed or configured correctly.

e There is insufficient memory available to run the application.

e There is a conflict between applications.

e  Be sure that all the needed device drivers have been installed.

e If you have installed an operating system other than the factory-installed operating system,
check to be sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Table D-19 Solving Software Problems

Computer will not continue and no HP logo screen has appeared.

Cause Solution

POST error has occurred. Observe the beeps and LED lights on the front of the
computer. See Appendix A, POST Error Messages
on page 189 to determine possible causes.

See the Restore Kit or the Worldwide Limited Warranty for
terms and conditions.

Computer will not continue after HP logo screen has appeared.

Cause Solution

System files may be damaged. Use recovery diskette to scan hard drive for errors.

“lllegal Operation has Occurred” error message is displayed.

Cause Solution

Software being used is not Microsoft-certified for your Verify that the software is certified by Microsoft for your

version of Windows. version of Windows (see program packaging for this
information).

Configuration files are corrupt. If possible, save all data, close all programs, and restart the
computer.
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Contacting Customer Support

For help and service, contact an authorized reseller or dealer. To locate a reseller or dealer near you,
visit http://www.hp.com.

B NOTE: If you take the computer to an authorized reseller, dealer, or service provider for service,
remember to provide the setup and power-on passwords if they are set.

Refer to the number listed in the warranty or in the Support Telephone Numbers guide for technical
assistance.
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Password Security and Resetting
CMOS

This computer supports security password features, which can be established through the Computer
Setup Utilities menu.

This computer supports two security password features that are established through the Computer
Setup Utilities menu: setup password and power-on password. When you establish only a setup
password, any user can access all the information on the computer except Computer Setup. When
you establish only a power-on password, the power-on password is required to access Computer
Setup and any other information on the computer. When you establish both passwords, only the
setup password will give you access to Computer Setup.

When both passwords are set, the setup password can also be used in place of the power-on

password as an override to log in to the computer. This is a useful feature for a network administrator.

If you forget the password for the computer, you can clear that password so you can gain access to
the information on the computer by resetting the password jumper.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to
back up the computer CMOS settings before resetting them in case they are needed later. Back up is
easily done through Computer Setup. See the Computer Setup (F10) Utility Guide for information on
backing up the CMOS settings.
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Resetting the Password Jumper

To disable the power-on or setup password features, or to clear the power-on or setup passwords,
complete the following steps:

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2.  With the power cord disconnected, press the power button again to drain the system of any
residual power.

A WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

/A CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3. Remove the computer cover or access panel.

4. Locate the header and jumper.

B NOTE: The password jumper is green so that it can be easily identified. For assistance
locating the password jumper and other system board components, see the lllustrated Parts &
Service Map (IPSM) for that particular system. The IPSM can be downloaded from
http://www.hp.com/support.

5. Remove the jumper from pins 1 and 2. Place the jumper on either pin 1 or 2, but not both, so
that it does not get lost.

6. Replace the computer cover or access panel.
7. Reconnect the external equipment.

8. Plug in the computer and turn on power. Allow the operating system to start. This clears the
current passwords and disables the password features.

9. To establish new passwords, repeat steps 1 through 4, replace the password jumper on pins 1
and 2, then repeat steps 6 through 8. Establish the new passwords in Computer Setup. Refer to
the Computer Setup (F10) Utility Guide for Computer Setup instructions.
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Clearing and Resetting the CMOS

The computer’s configuration memory (CMOS) stores information about the computer’s configuration.
The CMOS button resets CMOS but does not clear the power-on and setup passwords.

Clearing CMOS will clear the Active Management Technology (AMT) settings in the Management
Engine BIOS Extension (MEBX), including the password. The password will default to “admin” and will
need to be reset. The AMT settings will also need to be reset. To access the MEBX, press Ctrl+P
during POST.

1. Turn off the computer and any external devices, and disconnect the power cord from the power
outlet.

2. Disconnect the keyboard, monitor, and any other external equipment connected to the computer.

/A WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

/A CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3.  Remove the computer cover or access panel.

/A CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is
important to back up the computer CMOS settings before resetting them in case they are
needed later. Back up is easily done through Computer Setup. See the Computer Setup (F10)
Utility Guide for information on backing up the CMOS settings.
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4. Locate, press, and hold the CMOS button in for five seconds.

Br NOTE: Make sure you have disconnected the AC power cord from the wall outlet. The CMOS
button will not clear CMOS if the power cord is connected.

Figure E-1 CMOS button

Br NOTE: For assistance locating the CMOS button and other system board components, see the
lllustrated Parts & Service Map (IPSM) for that particular system.

5. Replace the computer cover or access panel.
6. Reconnect the external devices.

7. Plug in the computer and turn on power.

Br NOTE: You will receive POST error messages after clearing CMOS and rebooting advising
you that configuration changes have occurred. Use Computer Setup to reset any special system
setups along with the date and time.

For instructions on Computer Setup, see the Computer Setup (F10) Utility Guide.
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Drive Protection System (DPS)

The Drive Protection System (DPS) is a diagnostic tool built into the hard drives installed in some
computers. DPS is designed to help diagnose problems that might result in unwarranted hard drive
replacement.

When these systems are built, each installed hard drive is tested using DPS, and a permanent record
of key information is written onto the drive. Each time DPS is run, test results are written to the hard
drive. Your service provider can use this information to help diagnose conditions that caused you to
run the DPS software.

Running DPS will not affect any programs or data stored on the hard drive. The test resides in the
hard drive firmware and can be executed even if the computer will not boot to an operating system.
The time required to execute the test depends on the manufacturer and size of the hard drive; in most
cases, the test will take approximately two minutes per gigabyte.

Use DPS when you suspect a hard drive problem. If the computer reports a SMART Hard Drive
Detect Imminent Failure message, there is no need to run DPS; instead, back up the information on
the hard drive and contact a service provider for a replacement hard drive.
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Accessing DPS Through Computer Setup

When the computer does not power on properly you should use Computer Setup to access the DPS
program. To access DPS, perform the following steps:

1. Turn on or restart the computer.

2.  When the F10 Setup message appears in the lower-right corner of the screen, press the F10
key.

Br NOTE: If you do not press the F10 key while the message is displayed, you must turn the
computer off, then on again, to access the utility.

A choice of five headings appears in the Computer Setup Utilities menu: File, Storage,
Security, Power, and Advanced.

3. Select Storage > DPS Self-Test.

The screen will display the list of DPS-capable hard drives that are installed on the computer.

Br NOTE: If no DPS-capable hard drives are installed, the DPS Self-Test option will not appear
on the screen.

4. Select the hard drive to be tested and follow the screen prompts to complete the testing process.
When the test has been completed, one of three messages will be displayed:

e  Test Succeeded. Completion Code 0.

e Test Aborted. Completion Code 1 or 2.

e  Test Failed. Drive Replacement Recommended. Completion Code 3 through 14.

If the test failed, the completion code should be recorded and reported to your service provider for
help in diagnosing the computer problem.
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G Computer Diagnostic Features

Hewlett-Packard Vision Diagnostics

Br NOTE: HP Vision Diagnostics is included on CD with some computer models only.

The Hewlett-Packard Vision Diagnostics utility allows you to view information about the hardware
configuration of the computer and perform hardware diagnostic tests on the subsystems of the
computer. The utility simplifies the process of effectively identifying, diagnosing, and isolating
hardware issues.

The Survey tab is displayed when you invoke HP Vision Diagnostics. This tab shows the current
configuration of the computer. From the Survey tab, there is access to several categories of
information about the computer. Other tabs provide additional information, including diagnostic test
options and test results. The information in each screen of the utility can be saved as an html file and
stored on a USB flash drive.

Use HP Vision Diagnostics to determine if all the devices installed on the computer are recognized by
the system and functioning properly. Running tests is optional but recommended after installing or
connecting a new device.

You should run tests, save the test results, and print them so that you have printed reports available
before placing a call to the Customer Support Center.

Br NOTE: Third party devices may not be detected by HP Vision Diagnostics.

Accessing HP Vision Diagnostics

To access HP Vision Diagnostics, you must create a Recovery Disc Set then boot to the CD
containing the utility. It can also be downloaded from http://www.hp.com and either burned to CD or
installed to a USB flash drive. See Downloading the Latest Version of HP Vision Diagnostics

on page 253 for more information.

Br NOTE: HP Vision Diagnostics is included as part of the Recovery Disk Set with some computer
models only.

If you have already downloaded HP Vision Diagnostics to either CD or USB Flash drive, then begin
the following procedure at step 2.

1. In Windows Explorer, go to C:\SWSetup\ISOs and burn the file Vision Diagnostics.ISO to a
CD or copy it to a USB flash drive.

2.  While the computer is on, insert the CD in the Optical Drive or USB flash drive in a USB port on
the computer.

3. Shut down the operating system and turn off the computer.
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4. Turn on the computer. The system will boot into HP Vision Diagnostics.

B NOTE: If the system does not boot to the CD in the optical drive or to the USB flash drive, you
may need to change the boot order in the Computer Setup (F10) utility. Refer to the Computer
Setup (F10) Utility Guide for more information.

5. Atthe boot menu, select either the HP Vision Diagnostics utility to test the various hardware
components in the computer or the HP Memory Test utility to test memory only.

B NOTE: The HP Memory Test is a comprehensive memory diagnostic utility that is run as a
stand-alone application, outside of HP Vision Diagnostics.

6. Ifrunning HP Vision Diagnostics, select the appropriate language and click Continue.

7. Inthe End User License Agreement page, select Agree if you agree with the terms. The HP
Vision Diagnostics utility launches with the Survey tab displayed.

Survey Tab
The Survey tab displays important system configuration information.

In the View level field, you can select the Summary view to see limited configuration data or select
the Advanced view to see all the data in the selected category. By default, the View Level is set to
Overview which displays general information about all of the component categories.

In the Category field, you can select the following categories of information to display:
All—Gives a listing of all categories of information about the computer.
Architecture—Provides system BIOS and PCI device information.

Asset Control—Shows product name, system serial number, asset tag and universal unique 1D
information.

Audio—Displays information about the audio controllers present in the system, including PCI audio
cards.

Communication—Shows information about the computer parallel (LPT) and serial (COM) port
settings, plus USB and network controller information.

Graphics—Shows information about the graphics controller of the computer.

Input Devices—Shows information about the keyboard, mouse, and other input devices connected
to the computer.

Memory—Shows information about all memory in the computer. This includes memory slots on the
system board and any memory modules installed.

Processors—Shows information about the processor(s) installed in the computer, including clock
speeds and cache sizes.

Storage—Shows information about storage media connected to the computer. This list includes all
hard drives and optical drives.

System—Shows information about the computer model, internal fans, chassis, and BIOS.
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Test Tab

The Test tab allows you to choose various parts of the system to test. You can also choose the type
of test and testing mode.

There are three types of tests to choose from:

e Quick Test—Provides a predetermined script where a sample of each hardware component is
exercised. You may further modify which of the Quick tests are executed by selecting or
deselecting individual tests in the hardware component check list.

e Complete Test—Provides a predetermined script where each hardware component is fully
tested. You may further modify which of the Complete tests are executed by selecting or
deselecting individual tests in the hardware component check list.

e Custom Test—Provides the most flexibility in controlling the testing of a system. The Custom
Test mode allows you to specifically select which devices, tests, and test parameters are run.

By default, the three test modes do not display prompts and require no interaction. If errors are found,
they are displayed when testing is complete.

However, for each test type, you may also optionally add interactive tests by clicking the Include
interactive tests box under Test mode. Selecting interactive tests provides the maximum control
over the testing process. The diagnostic software will prompt you for input during tests.

NOTE: Memory can not be tested from within the HP Vision Diagnostics application. To test the
memory in your computer, you must exit HP Vision Diagnostics, boot to either the CD or USB flash
drive and select HP Memory Test from the boot menu.

To begin testing:

1. Select the Test tab.

2. Select the type of tests you want to run: Quick, Complete, or Custom.
3. Include optional interactive tests by selecting Include interactive tests.
4

Choose how you want the test to be executed, either Number of Loops or Total Test Time.

When choosing to run the test over a specified number of loops, enter the number of loops to
perform. If you want the diagnostic test for a specified time period, enter the amount of time in
minutes.

5. Click the Start Test button to start the testing. The Status tab, which allows you to monitor the
progress of the tests, is automatically displayed during the testing process. When the tests are
complete, the Status tab shows whether the devices passed or failed.

6. If errors are found, go to the Errors tab to display detailed information and recommended
actions.

Status Tab

The Status tab displays the status of the selected tests. The main progress bar displays the percent
complete of the current set of tests. While testing is in progress, a Cancel Testing button is displayed
for use if you want to cancel the test.
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The Status tab also shows:

e The devices being tested

e The test status (running, waiting, passed, or failed) of each device being tested
e The overall test progress of all devices being tested

e The test progress for each device being tested

e The elapsed test times for each device being tested

History Tab
The History tab contains information on past test executions.

The History Log displays all tests that have been executed, the number of times of execution, the
number of times failed, the date each test was executed, and the time it took to complete each test.
The Clear History button will clear the contents of the History Log.

The contents of the History Log may be saved as a HTML file to USB flash drive by clicking the Save
button.

Errors Tab

The Errors tab displays detailed information about any errors found, as well as any recommended
actions.

The Error Log displays the tests for devices that have failed during the diagnostic testing and includes
the following columns of information.

e The Device section displays the device tested.
e The Test section displays the type of test run.
e The Times Failed is the number of times the device has failed a test.

e The Defect Code provides a numerical code for the failure. The error codes are defined in the
Help tab.

e The Description section describes the error that the diagnostic test found.
e The Reason section describes the likely cause of the error.

e The Recommended Repair will give a recommended action that should be performed to
resolve the failed hardware.

e The Warranty ID is a unique error code associated with the specific error on your computer.
When contacting the HP Support Center for assistance with a hardware failure, please be
prepared to provide the Warranty ID.

The Clear Errors button will clear the contents of the Error Log.

The contents of the Error Log may be saved as a HTML file to USB flash drive by clicking the Save
button.
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Help Tab

The Help tab contains a Vision Help section, and a Test Components section. This tab includes
search and index features. You may also review the HP End User License Agreement (EULA), as
well as the HP Vision Diagnostic application version information on this tab.

The Vision Help section contains information on the major functions of Hewlett-Packard Vision
Diagnostics.

The Test Components section provides a description of each test, as well as the parameters that
may be adjusted when running in Custom test mode.

The Defect codes section contains information on the numerical error code that may appear in the
Errors tab.

The Memory test tab section provides information on the HP Memory Test application that may be
launched from the boot menu.

The HP Support section provides information on obtaining technical support from HP.

Saving and Printing Information in HP Vision Diagnostics

You can save the information displayed in the HP Vision Diagnostics Survey, History and Errors
tabs to a USB flash drive. You can not save to the hard drive. The system will automatically create an
html file that has the same appearance as the information displayed on the screen.

1. Insert a USB flash drive if running HP Vision Diagnostics from CD.

2. Click Save in the bottom on any of the Survey, History or Errors tabs. All three log files will be
saved regardless of from which tab the Save button was clicked.

3. Select the drive onto which you will save the log files and click the Save button. Three html files
will be saved to the inserted USB flash drive.

B NOTE: Do not remove the USB flash drive until you see a message indicating that the html
files have been written to the media.

4. Print the desired information from the storage device used to save it.

Br NOTE: To exit HP Vision Diagnostics, click the Exit Diagnostics button at the bottom of the screen.
Be sure to remove the USB flash drive or CD from the optical drive.

Downloading the Latest Version of HP Vision Diagnostics

1. Go to http://www.hp.com.

2. Click the Software & Drivers link.
3. Select Download drivers and software (and firmware).
4

Enter your product name in the text box and press the Enter key.

o

Select your specific computer model.
6. Select your OS.
7. Click the Diagnostic link.
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8. Click the Hewlett-Packard Vision Diagnostics link.

9. Click the Download button.

Br NOTE: The download includes instructions on how to create the bootable CD or the bootable USB
flash drive.

Protecting the Software

To protect software from loss or damage, you should keep a backup copy of all system software,
applications, and related files stored on the hard drive. See the operating system or backup utility
documentation for instructions on making backup copies of data files.
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H Backup and Recovery

Windows 7 — Backup and Recovery

To protect your information, use Windows® Backup and Restore to back up individual files and
folders, back up your entire hard drive (select models only), create system repair discs (select models
only), or create system restore points. In case of system failure, you can use the backup files to
restore the contents of your computer.

Windows Backup and Restore provides the following options:
e Creating a system repair disc (select models only)

e Backing up individual files and folders

e Creating a system image (select models only)

e  Scheduling automatic backups (select models only)

e  Creating system restore points

e  Recovering individual files

e Restoring the computer to a previous state

e Recovering information using recovery tools

Br NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create
system repair discs (select models only) and your initial backup immediately after software setup. As
you add new software and data files, you should continue to back up your system on a regular basis
to maintain a reasonably current backup. The system repair discs (select models only) are used to
start up (boot) the computer and repair the operating system in case of system instability or failure.
Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:
e  Store personal files in the Documents library, and back it up regularly.

e Back up templates that are stored in their associated programs.
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e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4. Save the document.

e When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend
on the type of optical drive installed in your computer.

Br NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

e  When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore, follow these steps:

B NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1.  Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

B NOTE: Windows® includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

e  Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

e 11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.
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Br NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
discs you previously created (select models only), you must purchase a Windows 7 operating system
DVD to reboot the computer and repair the operating system. For additional information, refer to the
“Using a Windows 7 operating system DVD (purchased separately)” section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

Br NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

To recover your information using Startup Repair, follow these steps:

/A CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.
2. If possible, check for the presence of the Windows partition and the HP Recovery partition.
To check for the Windows partition, select Start > Computer.

To check for the HP Recovery partition, select Start, right-click Computer, click Manage, and
then click Disk Management.

B NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 7 operating system DVD and the Driver
Recovery disc (both purchased separately). For additional information, refer to the “Using a
Windows 7 operating system DVD (purchased separately)” section in this guide.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press f8 before the Windows operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

Br NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.
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Using f11

/A CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The 11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using 11, follow these steps:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: select Start, right-click
Computer, click Manage, and then click Disk Management.

B NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows 7 operating
system DVD (purchased separately)” section in this guide.

3. Ifthe HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows 7 operating system DVD (purchased separately)

If you are unable to boot (start up) your computer and you cannot use the system repair discs you
previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. Make sure that your most recent backup
(stored on discs or on an external drive) is easily accessible.

/A CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD, follow these steps:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical
drive before the Windows operating system loads.

3.  When prompted, press any keyboard key.
4. Follow the on-screen instructions.
5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Windows Vista — Backup and Recovery

To protect your information, use the Backup and Restore Center to back up individual files and
folders, back up your entire hard drive (select models only), or create system restore points. In case
of system failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:
e  Backing up individual files and folders

e  Backing up the entire hard drive (select models only)

e  Scheduling automatic backups (select models only)

e  Creating system restore points

e Recovering individual files

e Restoring the computer to a previous state

e Recovering information using recovery tools

Br NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:

e  Store personal files in the Documents folder, and back it up regularly.

e Back up templates that are stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4. Save the document.
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e  When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend
on the type of optical drive installed in your computer.

B NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

e  When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore Center, follow these steps:

Bf NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your
files.

Br NOTE: Windows® includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

e  Windows recovery tools: You can use the Backup and Restore Center to recover information
you have previously backed up. You can also use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly.

e 11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

Ef NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista®
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)”
section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1. Click Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your
files.

B NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
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To recover your information using Startup Repair, follow these steps:

/A CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To
find the partitions, select Start > Computer.

B NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD
and the Driver Recovery disc (both purchased separately). For additional information, refer to
the “Using a Windows Vista operating system DVD (purchased separately)” section in this guide.

3. Restart the computer, and then press 8 before the Windows operating system loads.
4. Select Repair your computer.

5. Follow the on-screen instructions.

Br NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.
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Using f11

/A CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The 11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using 11, follow these steps:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.

Br NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc
(both purchased separately). For additional information, refer to the “Using a Windows Vista
operating system DVD (purchased separately)” section in this guide.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)

If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating
system DVD to reboot the computer and repair the operating system. Make sure that your most
recent backup (stored on discs or on an external drive) is easily accessible.

/A CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents
and reformats the hard drive. All files you have created and any software installed on the computer
are permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3.  When prompted, press any keyboard key.
4. Follow the on-screen instructions.
5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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| Specifications

CMT Specifications

Table I-1 Specifications

Desktop Dimensions

Height 7.0in 17.78 cm
Width 17.63 in 44.78 cm
Depth 17.51in 44.45 cm

Tower Dimensions

Height 17.63 in 44.78 cm
Width 7.0in 17.78 cm
Depth 17.51in 44.45 cm
Approximate Weight 24.54 Ib 11.15 kg
Weight Supported (maximum distributed load in desktop 77 b 35kg
position)

Temperature Range
Operating 50° to 95°F 10° to 35°C

Nonoperating -22° to 140°F -30° to 60°C

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no
direct sustained sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and
number of options installed.

Relative Humidity (noncondensing)
Operating 10-90% 10-90%

Nonoperating (38.7°C max wet bulb) 5-95% 5-95%

Maximum Altitude (unpressurized)
Operating 10,000 ft 3048 m

Nonoperating 30,000 ft 9144 m
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Table I-1 Specifications (continued)

Heat Dissipation
Max STD PS
Typical STD PS idle

Max EPA 87/89/85% @ 20/50/100% load PS

1410 BTU/hr

222 BTU/hr

1255 BTU/hr

356 kg-cal/hr
56 kg-cal/hr

316 kg-cal/hr

Typical EPA 87/89/85% @ 20/50/100% load PS idle 171 BTU/hr 43 kg-cal/hr
Power Supply 115V 230V
Operating Voltage Range (STD PS) 90-264 VAC 90-264 VAC
Operating Voltage Range (EPA 87/89/85% @ 20/50/100% 90-264 VAC 90-264 VAC
load PS)

100-240 VAC 100-240 VAC
Rated Voltage Range (STD PS)

100-240 VAC 100-240 VAC
Rated Voltage Range (EPA 87/89/85% @ 20/50/100% load
PS) 50-60 Hz 50-60 Hz
Rated Line Frequency
Power Output 320W 320W
Rated Input Current (maximum)’
STD PS 55A @ 115 VAC 2.75A @ 230 VAC
EPA 87/89/85% @ 20/50/100% load PS 55A @ 115 VAC 2.75A @ 230 VAC

— — e ———
T This system utilizes an active power factor corrected power supply. This allows the system to pass the CE mark
requirements for use in the countries of the European Union. The active power factor corrected power supply also has the

added benefit of not requiring an input voltage range select switch.
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SFF Specifications

Table I-2 Specifications

Desktop Dimensions (in the desktop position)

Height 3.95in 10.0 cm
Width 13.3in 33.8cm
Depth 14.9in 37.8cm
Approximate Weight 16.72 Ib 7.6 kg
Weight Supported (maximum distributed load in desktop position) 77 b 35 kg

Temperature Range
Operating 50° to 95°F 10° to 35°C

Nonoperating -22° to 140°F -30° to 60°C

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no direct
sustained sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and number of options
installed.

Relative Humidity (noncondensing)
Operating 10-90% 10-90%

Nonoperating (38.7°C max wet bulb) 5-95% 5-95%

Maximum Altitude (unpressurized)
Operating 10,000 ft 3048 m

Nonoperating 30,000 ft 9144 m

Heat Dissipation

Max STD PS 1063 BTU/hr 268 kg-cal/hr
Typical STD PS idle 198 BTU/hr 50 kg-cal/hr
Max EPA 87/89/85% @ 20/50/100% load PS 941 BTU/hr 237 kg-callhr
Typical EPA 87/89/85% @ 20/50/100% load PS idle 150 BTU/hr 38 kg-cal/hr
Power Supply 115V 230V
Operating Voltage Range (STD PS) 90-264 VAC 90-264 VAC
Operating Voltage Range (EPA 87/89/85% @ 20/50/100% load PS) 90-264 VAC 90-264 VAC
Rated Voltage Range (STD PS) 100-240 VAC 100-240 VAC
Rated Voltage Range (EPA 87/89/85% @ 20/50/100% load PS) 100-240 VAC 100-240 VAC
Rated Line Frequency 50-60 Hz 50-60 Hz
Power Output 240W 240W
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Table I-2 Specifications (continued)

Rated Input Current (maximum)’
STD PS

EPA 87/89/85% @ 20/50/100% load PS

4A @ 100 VAC

4A @ 100 VAC

2A @ 230 VAC

2A @ 230 VAC

— — —
1 This system utilizes an active power factor corrected power supply. This allows the system to pass the CE mark

requirements for use in the countries of the European Union. The active power factor corrected power supply also has the

added benefit of not requiring an input voltage range select switch.

USDT Specifications

Table I-3 Specifications

Desktop Dimensions (in the desktop position)

Height 2.60in 6.6 cm

Width 9.90 in 25.1 cm

Depth 10.00 in 254 cm

(depth will increase if the computer is equipped with a port security bracket)

Approximate Weight 6.751b 3.07 kg

Weight Supported (maximum distributed load in desktop position) 77 b 35 kg

Temperature Range (values subject to change with increasing altitude above sea

level)

Operating 50° to 95° F 10°to 35° C
-22°t0 140° F -30°t0 60° C

Nonoperating

NOTE: Operating temperature is derated 1.0° C per 300 m (1,000 ft) to 3,000 m (10,000 ft) above sea level, no direct
sustained sunlight. Maximum rate of change is 10° C (50° F)/Hr. The upper limit may be limited by the type and number of

options installed.

Relative Humidity (noncondensing)

Operating (28° C (82.4° F) max wet bulb) 10-90% 10-90%
Nonoperating (38.7° C (101.66° F) max wet bulb) 5-95% 5-95%
Maximum Altitude (unpressurized)

Operating 10,000 ft 3,048 m
Nonoperating 30,000 ft 9,144 m
Heat Dissipation

Maximum 549 BTU/hr 132 kg-cal/hr
Typical (idle) 133 BTU/hr 33.5 kg-cal/hr
Power Supply

Operating Voltage Range 90-264 VAC

Rated Voltage Range’ 100-240 VAC

Rated Line Frequency 50-60 Hz
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Table I-3 Specifications (continued)

Power Output 135 W

Rated Input Current (maximum)' 2.4A @ 100VAC 1.2A @ 200VAC

1 This system utilizes an active power factor corrected external power supply. This allows the system to pass the CE mark
requirements for use in the countries of the European Union. The active power factor corrected power supply also has the
added benefit of not requiring an input voltage range select switch.
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Customer Support 200, 242

D
desktop conversion 82
diagnostics utility 249
DIMMs. See memory
disassembly preparation
CMT 31
SFF 87
USDT 143
diskette drive
removing 50
diskette problems 209
DisplayPort
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drive
installing optical drive 160
removing optical drive 157
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SFF removal and
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E
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F
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keyboard
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media card reader
installing 54, 118
removing 50, 116
Media Card Reader
problems 215
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installing 39, 41
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specifications 39, 98
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memory problems 232
microphone pin assignments
minitower conversion 84
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pin assignments 183
monitor problems 217
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cleaning 28
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mouse problems 225

N
network problems 229
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o
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optical drive

attaching release latch 159
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optical drive problems 235
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P
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CMT removal and
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CMT speaker 66

CMT system board 72

SFF baffle 128

SFF battery 139

SFF drives 108

SFF frontfan 129

SFF front I/O, power switch
assembly 131
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